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Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross
Technology.

Our mission is to:
1. Provide a Superior Customer Experience

+ offer the best product quality and support
2. Make Cool Practical Technology

+ develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and
empowers our employees. | hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach
out to us at solutions@rossvideo.com.

—D.‘Q 2\35

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a
special group. Our employees truly care about doing a great job and delivering a high quality
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to
guide our behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in

times of company or customer crisis - do what you know in your heart is right. (You may rent
helicopters if necessary.)
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Copyright

©2025 Ross Video Limited, Ross®, and any related marks are trademarks or registered trademarks
of Ross Video Limited. All other trademarks are the property of their respective companies.
PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced,
stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying,
recording or otherwise, without the prior written permission of Ross Video. While every precaution
has been taken in the preparation of this document, Ross Video assumes no responsibility for
errors or omissions. Neither is any liability assumed for damages resulting from the use of the
information contained herein.

Patents

Patent numbers US 7,034,886; US 7,508,455; US 7,602,446; US 7,802,802 B2; US 7,834,886; US
7,914,332; US 8,307,284; US 8,407,374 B2; US 8,499,019 B2; US 8,519,949 B2; US 8,743,292 B2; GB
2,419,119 B; GB 2,447,380 B; and other patents pending.

Notices

The material in this manual is furnished for informational use only. It is subject to change without
notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited
assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

Note: As required by the GNU General Public License, and the Lesser GNU Public License (LGPL),
source code can be obtained from Ross Video for at least 3 years. Contact Ross Video Technical
Support for more information. If you have any questions or comments regarding this License
Agreement, please contact:

Ross Video Limited

8 John Street

P.O. Box 220

Iroquois, ON

Canada KOE 1KO
techsupport@rossvideo.com

Trademarks

+ Dolby® is a registered trademark of Dolby Laboratories.

Safety Notices

Refer to the “Important Regulatory and Safety Notices” document that accompanied your
product.




Statement of Compliance

This product has been determined to be compliant with the applicable standards, regulations, and
directives for the countries where the product is marketed.

Compliance documentation, such as certification or Declaration of Compliance for the product is
available upon request by contacting techsupport@rossvideo.com. Please include the product;
model number identifiers and serial number and country that compliance information is needed in
request.

EMC Notices

US FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device,
pursuant to part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a Commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this equipment in
a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could
void the user’s authority to operate this equipment.

Canada

This Class “A” digital apparatus complies with Canadian ICES-003 and part 15 of the FCC Rules.
Cet appareil numerique de la classe “A”" est conforme a la norme NMB-003 du Canada.
European Union

This equipment is in compliance with the essential requirements and other relevant provisions
established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the
“New Legislative Framework”.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this
equipment may cause radio interference.

Australia/New Zealand

This equipment is in compliance with the provisions established under the Radiocommunications
Act 1992 and Radiocommunications Labeling (Electromagnetic Compatibility) Notice 2008.

Korea
This equipment is in compliance with the provisions established under the Radio Waves Act.
Class A equipment (Broadcasting and communications service for business use)

This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be
aware of this fact. This device is intended for use in areas outside home.
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Class A Equipment This equipment is Industrial (Class A)

(Industrial Broadcasting & electromagnetic wave suitability equipment and

Communication Equipment) | seller or user should take notice of it, and this
equipment is to be used in the places except for home.

International

This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and
found to comply with the limits for a Class A Digital device.

Notice — This is a Class A product. In domestic environments, this product may cause radio
interference, in which case the user may have to take adequate measures.

Maintenance/User Serviceable Parts

Routine maintenance to this openGear product is not required. This product contains no user
serviceable parts. If the module does not appear to be working properly, please contact Technical
Support using the numbers listed under the “Contact Us” section of this manual. All openGear
products are covered by a generous 5-year warranty and will be repaired without charge for
materials or labor within this period. See the “Warranty and Repair Policy” section in this manual
for details.

Environmental Information

The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need
for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your
local or regional waste administration. You can also contact Ross Video for more information on the
environmental performances of our products.

Security and Privacy

If you would like more information on how Ross Video security and privacy practices have been
applied to the MC1-UHD, what you should know about maintaining security of this product, and
how we can partner with you to ensure security throughout this product's life-cycle, contact
techsupport@rossvideo.com.




Ross Video has implemented reasonable administrative, technical, and physical safeguards to help
protect against security incidents and privacy breaches involving a Ross Video product provided
those products are used in accordance with Ross Video instructions for use. However, as systems
and threats evolve, no system can be protected against all vulnerabilities and we consider our
customers the most important partner in maintaining security and privacy safeguards. If you have
any concerns, we ask that you bring them to our attention, and we will investigate. Where
appropriate, we will address the issue with product changes, technical bulletins and/or responsible
disclosures to customers and regulators. Ross Video continuously strives to improve security and
privacy throughout the product life-cycle using practices such as:

+ Privacy and Security by Design

* Product and Supplier Risk Assessment

* Vulnerability and Patch Management

+ Secure Coding Practices and Analysis

+ Vulnerability Scanning

+ Access Controls appropriate to Customer Data

*+ Incident Response

+ Clear paths for two-way communication between customers and Ross Video

If you would like to report a potential product related privacy or security issue (incident, breach, or
vulnerability), contact techsupport@rossvideo.com.

Company Address

Ross Video Limited Ross Video Incorporated
Rass 8 John Street P.O. Box 880
I[roquois, Ontario Ogdensburg, New York

Canada, KOE 1KO USA 13669-0880

General Business Office: (+1) 613 e 652 o 4886
Fax: (+1) 613 ® 652 © 4425

Technical Support: (+1) 613 e 652 e 4886
After Hours Emergency: (+1) 613 e 349 ¢ 0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com
Website: http://www.rossvideo.com
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Introduction

This guide covers the installation, configuration, and use of the MC1-UHD. The following chapters
are included:

“Introduction” summarizes the guide and provides important terms, and conventions.

“Before You Begin" provides general information to keep in mind before installing and
configuring your MC1-UHD.

“Integration Example” provides one possible work-flow that includes an MC1-UHD.

“Hardware Overview" provides a basic introduction to the MC1-UHD hardware features
including the cabling and monitoring features of the rear module.

“Physical Installation” provides instructions for the physical installation of the MC1-UHD and its
rear module into an openGear frame.

“Cabling” provides an overview of connecting input and output devices to the rear module of the
MC1-UHD.

“Getting Started” outlines how to display the MC1-UHD interfaces in DashBoard.

“Licensed Features” outlines the available software licensed features, and how to install a
software key for a licensed feature.

“Reference and Timing Setup” provides instructions for specifying the reference source for the
MC1-UHD.

“Configuring the SDI Outputs” provides instructions for setting the card output video format
and assigning the SDI signals to the outputs.

“Program Failover Setup” outlines how to configure the Program Failover feature, monitor the
failover status, and if required, force an automatic failover.

“Router Setup” provides instructions for the basic physical installation and communications
setup of your MC1-UHD to the Ultrix router.

“Crosspoint Mapping” outlines how to specify the number of available crosspoints, and assign
sources to each crosspoint.

“Using RossTalk" outlines how to establish a connection point between the MC1-UHD and an
external device using the RossTalk protocol.

“Comtrol® DeviceMaster® Setup” describes how to set up communications between the
MC1-UHD and a Comtrol DeviceMaster.

“Using the TSL UMD v3.1 Protocol” outlines how to configure the MC1-UHD to communicate
with a device via the TSL UMD 3.1 protocol.

“Using the Presmaster Protocol” outlines how to configure the MC1-UHD to support a subset of
Miranda™ Presmaster Control System automation commands.

“Using the APC Protocol” outlines how to configure the MC1-UHD to communicate with a device
via the APC protocol

“Setting up an EAS with MC1-UHD" outlines how to set up communications between the Sage
Digital ENDEC 3644 and the MC1-UHD.

“On Air Control Overview" provides a basic introduction to the MC1-UHD, including an overview
of the different areas of the On Air Control interface, using the menu system, as well as a brief
summary of how video is controlled by the MC1-UHD.

“Audio” provides instructions for configuring the audio features of the MC1-UHD using the
options available in DashBoard.

“Media File Management” outlines how to select and configure the two Logo channels for the
MC1-UHD.

“Keying” summarizes the MC1-UHD keying features.
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+ “Mattes” outlines how to set up a matte color and assign a matte generator to an external key.

+ “Transitions” outlines how to specify the post transition behavior, configure the TAKE button, set
a transition rate, and perform basic transitions.

+ “SqueezeBack Effects” outlines the SqueezeBack feature of the MC1-UHD.
+ “Ancillary Data" provides an overview of ANC processing for the MC1-UHD.

+ “Configuring the GPI/Tallies” outlines how to configure each GPI/Tally independently on the
MC1-UHD.

+ “Upgrading the Software” outlines how to upgrade the MC1-UHD via DashBoard.

+ “DashBoard Interface Overview” summarizes the menus and parameters of the MC1-UHD tabs
in DashBoard.

+ “Technical Specifications” provides the specifications for the MC1-UHD.

+ “Service Information” provides information on the warranty and repair policy for your
MC1-UHD.

+ “Software Licenses” provides third-party software license information for your MC1-UHD.
+ “Glossary” provides a list of terms used throughout this guide.

Related Publications

It is recommended to consult the following Ross documentation before installing and configuring
your MC1-UHD:

+ DashBoard User Guide, Ross Part Number: 8351DR-004

¢ MC1-PANEL-16 User Guide, Ross Part Number: 8800DR-004

* MFC-0G3-N and MFC-8322-S User Guide, Ross Part Number: 8322DR-004
* OGX-FR Series Quick Start Guide, Ross Part Number: 8322DR-202

* OGX-FR Series User Guide, Ross Part Number: 8322DR-204

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular
command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For
example:

In the Network tab, click Apply.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides

Text set in bold and italic represent the titles of referenced guides, manuals, or documents. For
example:

For more information, refer to the MC1-PANEL-16 User Guide.
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Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow.
For example, if a step reads “File > Save As,” you would select the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

X Contact your IT department before connecting to your facility network to ensure that there are
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and
Gateway for your device.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock.
After-sales service and technical support is provided directly by Ross Video personnel. During
business hours (Eastern Time), technical support personnel are available by telephone. After hours
and on weekends, a direct emergency technical support phone line is available. If the technical
support person who is on call does not answer this line immediately, a voice message can be left
and the call will be returned shortly. This team of highly trained staff is available to react to any
problem and to do whatever is necessary to ensure customer satisfaction.

+ Technical Support: (+1) 613-652-4886
+ After Hours Emergency: (+1) 613-349-0006
+ E-mail: techsupport@rossvideo.com

+ Website: http://www.rossvideo.com
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Before You Begin

If you have questions pertaining to the operation of MC1-UHD, contact us at the numbers listed in
“Contacting Technical Support”. Our technical staff is always available for consultation, training,
or service.

Overview

MC1-UHD is a software-defined UHD Master Control solution for the GATOR platform, which allows
mixing, keying, and logo insertion up to UHD rates. With native 12G-SDI interfaces, you won't get
bogged down with multi-link interfaces in your UHD workflow. This allows easy insertion of external
key sources, like the Ross XPression 4K. MC1-UHD also features an internal animated logo store.
Use RossLing to transfer logos directly from Ross XPression™ to the MC1-UHD on-air frame buffer
seamlessly. The MC1-UHD also includes a suite of protocol support for automation control, and
router control.

% The MC1-UHD must be installed in an OGX-FR frame with an MFC-OG3-N or MFC-OGX-N Network
Controller card.

Features

Some features of the MC1-UHD include:

+ 6x 12G SDI Inputs (Background, Preset, 2 x Key/Fill)

+ 6 assignable 12G SDI Outputs (Program, Preview, Clean Feeds)

+ Support for SD, HD, and UHD video formats

+ 2 External Key + Alpha can come from any SDI input or any of the 2 logo channels
+ Keys can be transitioned independently

+ Support for cross fade, cut, v fade, fade/cut, and cut/fade transitions

+ 2 internal logo/animation play-out channels

+ Logo animations up to full screen

* Non-volatile logo storage via the Micro SD Card

+ Rossling interface to XPression LiveCG

+ Ultrix Router Support

+ Automation Support via the Presmaster protocol

+ RossTalk support

* APC support

* GPI control

+ Clean/quiet transitions

+ An optional AES daughter card provides 8 Balanced AES or 8 unbalanced AES inputs per channel
+ Support for on-air 2D DVE (SqueezeBack) transitions

+ Stand-alone SqueezeBack

+ Stand-alone audio/voice over mixing

+ Audio processing for 16 embedded audio channels

+ Audio shuffling from any embedded input (or mute or tone) for each embedded output
+ Clean audio switching for embedded audio at 48kHz

+ Configure up to 4 audio profiles that can be recalled on any crosspoint
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+ Fully compliant with openGear specifications
+ Syear transferable warranty

Functional Block Diagram

Figure 1 provides a general overview of the MC1-UHD workflow.
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* The type of AES connections (balanced or unbalanced) depends on the rear module installed with the card.

Figure 1 Functional Block Diagram — Workflow

18 « Before You Begin MC1-UHD User Guide (v8-rev3)



User Interfaces

Control is available via the DashBoard client software, through third-party protocols, and the
optional MC1-PANEL-16 control panel.

DashBoard Interfaces

The DashBoard client software enables you to monitor and control openGear frames and cards
from a computer. DashBoard communicates with cards in the openGear frames through an
MFC-OG3-N or MFC-OGX-N installed in the frame. This controller card is required in order to use
DashBoard to control and monitor the MC1-UHD.

The MC1-UHD includes DashBoard interfaces for configuration and operation. The interfaces are
accessed by expanding the MC1-UHD node in the DashBoard Tree View and selecting the
appropriate sub-node.

For More Information on...
+ displaying the DashBoard interfaces, refer to “Getting Started".
+ the interfaces available in DashBoard, refer to “DashBoard Interface Overview”.

Third-Party Protocols

The MC1-UHD uses the RossTalk, TSL UMD v3.1, Presmaster, or APC protocols to establish a
communication link to a computer based editing or automation system.

For More Information on...

+ setting up an automation system with the MC1-UHD, refer to “Using RossTalk”, or “Using the
Presmaster Protocol”.

« communication via the TSL UMD v3.1 protocol, refer to “Using the TSL UMD v3.1 Protocol".

MC1-PANEL-16

The MC1-PANEL-16 is a stand-alone control panel that provides all the basic user input of the
MC1-UHD card (channel) it is controlling. Up to 10 channels can be configured independently,
allowing a single MC1-PANEL-16 to communicate and control 10 cards.

For More Information on...

+ configuring an MC1-PANEL-16, refer to the MC1-PANEL-16 User Guide.
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Integration Example

MC1-UHD offers 6 configurable outputs with selections for PGM / PREVIEW and CLEAN. The
look-ahead PREVIEW is ideal for live productions providing confidence in quality and accuracy of the
next scene to go to air.

System Integration Example

The setup seen in Figure 2 includes the following:

+ An ULTRIX-NS-FR5 with one Multiviewer Head output and 6 SDI outputs to the MC1-UHD

+ One MC1-UHD with a PREVIEW output, a PROGRAM output, and 4 SDI outputs to a ULTRIX-NS-FR5
+ One XPression with a Rossling data connection to the OGX-FR frame

+ A Master Control Automation System

+ A DashBoard client computer with a network connection

ULTRIX-NS-FR5
128x128 3G/HD/SD SDI Router

9|9u|« ix-ucel [nl % |

OGX-FR Series Frame
with one MC1-UHD

H Master Control
Automation System

XPression

Internet / LAN / VPN

Network Switch

PC running DashBoard

Figure 2 Example of Integrating the MC1-UHD with an Existing System
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Physical Setup Overview

Ensure the following tasks are performed:

1.

4,

Install and configure the openGear frame that houses the MC1-UHD. Refer to the OGX-FR Series
User Guide.

Install the required rear module into the rear panel of the frame. Refer to “Installing the Rear
Module into the OGX-FR Frame".

Install the MC1-UHD into its rear module. Refer to “Installing the MC1-UHD into an OGX-FR
Frame”.

Connect the SDI signals to the MC1-UHD rear module. Refer to “Cabling".

Network Settings Overview

Now you connect the MC1-UHD to the network and ensure it can communicate with a computer
running the latest DashBoard client software. The DashBoard client software enables you to
monitor, configure, and operate your MC1-UHD.

Perform the following tasks to access and configure the MC1-UHD:

1.

Verify that a computer running the latest DashBoard client software is installed and available on
the same subnet as the MC1-UHD. The DashBoard client software and user guide are available
from our website.

Verify that the openGear frame displays in the Tree View of DashBoard. Refer to the OGX-FR
Series User Guide for details.

Set up network communications for the MC1-UHD as outlined in “Configuring the Initial
Network Settings".

Display the MC1-UHD in DashBoard as outlined in “Accessing the MC1-UHD Interfaces in
DashBoard".

Configure the MC1-UHD

The MC1-UHD is now ready for configuration. To complete the setup:

1.

2
3
4,
5

Select a valid reference source. Refer to “Specifying a Global Reference Source”.

Specify the video signal for each of the six SDI outputs. Refer to “Configuring the Outputs”.
Configure the MC1-UHD to communicate with the Ultrix router. Refer to “Router Setup”.
Map the crosspoints buses on the MC1-UHD. Refer to “Crosspoint Mapping".

Configure the MC1-UHD as a client to the Master Control Automation device. For a Miranda™
Presmaster Control System, refer to “Using the Presmaster Protocol”.

XPression Setup Requirements

To set up communications between XPression and the MC1-UHD:

1.

2.

Ensure the RossLing channel in XPression is set as a passive FTP connection. Refer to the

XPression user documentation for details.

Establish an FTP connection between the MC1-UHD and XPression. Refer to “Connection using
RossLinqg".
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Hardware Overview

This chapter presents information on the MC1-UHD card and rear module.

Overview

The MC1-UHD is an openGear modular system composed of two sub-systems.
* a main board which connects to a rear module and the openGear frame midplane
+ arear module that provides physical connectors

Table 1 outlines which rear module mates with specific MC1-UHD PCB version and openGear
frames.

| Notice — Installing the MC1-UHD in a frame other than the OG3-FR or OGX-FR could damage the
card, the rear module, or both.

Table 1 Rear Modules — Supported openGear Frames

Code Main PCB Rear Module Number
Displayed in = Marketing PCB Part Marketing Rear Module of Frame Supported
DashBoard Code Number Code Part Number Slots openGear Frame
MC1-UHD GATOR-2 8929AR-251 R4-GATOR  8323AR-325 2 OGX-FR
MC1-UHD-A GATOR-4A  8929AR-253 R3A-GATOR 8322AR-319C 4 OG3-FR, OGX-FR

MC1-UHD-B GATOR-4B  8929AR-254 R3B-GATOR 8322AR-318D 4 OG3-FR, OGX-FR

Main PCB Overview

The main PCB is a typical openGear card. On the front edge is an ejector to secure the card to the
slot inside the openGear frame. Slide the card into the frame until it inserts into a connector on the
back of the rear module. (Figure 3)

| Rear
Module

Reset button Reference Jumper (JP3) .

Figure 3 MC1-UHD — Base Card Components

Reset Button

Pressing this button performs a hard reset of the microprocessor and re-initializes the card. This
should only be performed if advised by Ross Video Technical Support.

Reference Termination Jumper (J3)

JP3 is a 3-position jumper block used to configure the 750hm termination on the local reference
input on the rear module.
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* Pin 1 (bottom) + Pin 2 (center) — In this position, the reference is terminated with a 750hm
resistor. This configuration is to be used for point-to-point cabling, or on the last card of a daisy
chain topology. This is the default position. Refer to Figure 4 for pin positions.

Pin Position
1+2

Figure 4 |3 — Default Position

* Pin 2 (center) + Pin 3 (top) — In this position, the 750hm termination is removed and the
reference is not terminated. This configuration is used in a daisy chain cabling topology where
only the last card is terminated.

Audio Daughter Card

The MC1-UHD-A and MC1-UHD-B include a daughter card installed on the main PCB. This daughter
card is required for the audio features of the MC1-UHD-A and MC1-UHD-B.

Back Components (Not Shown)
The Micro SD card slot is located on the backside of the main PCB and just above the ejector.

X Ensure the SD card is properly seated in its slot before installing the MC1-UHD.

MC1-UHD Cabling Overview

This section provides an overview of the connections and cabling designations when the MC1-UHD
is installed with the R4-GATOR rear module. (Figure 5) The following connections are available:

* 6 SDI inputs on HD-BNCs

* 6 SDI outputs on HD-BNCs

+ 1 local reference input signal
* 4 GPIO connections

REF INA

il
openbear
P MC1-UHD

o |
Ol g0
© I |

[ [-=pio
Clhlly; NCa

1T

Figure 5 Cabling Designations — R4-GATOR (8323AR-325) Rear Module
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MC1-UHD-A Cabling Overview
The MC1-UHD-A requires the R3A-GATOR rear module. (Figure 6) The following connections are

available:
* 6 SDI inputs on HD-BNCs

* 6 SDI outputs on HD-BNCs
* 8 AES unbalanced connections on HD-BNCs

+ 1 local reference input signal

* 1 SERIAL port
6 GPIO connections
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GPIO5Y

4GPIO3
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GPIO 4%
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Figure 6 Cabling Designations — R3A-GATOR (8322AR-319C) Rear Module

MC1-UHD-B Cabling Overview
The MC1-UHD-B requires the R3B-GATOR rear module. (Figure 7) The following connections are

available:
* 6 SDI inputs on HD-BNCs

* 6 SDI outputs on HD-BNCs
+ 8 AES balanced connections on 3-pin connectors

+ 1 independent reference input signal (bi-level or tri-level sync)

* 1 SERIAL port
6 GPIO connections
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Figure 7 Cabling Designations — R3B-GATOR (8322AR-318D) Rear Module
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Physical Installation

Installing an MC1-UHD card into the OGX-FR frame requires you to remove the blank plates in the
required frame slots, install the required rear module into the frame rear panel, and then install the
MC1-UHD card into the required frame slot. This chapter provides instructions for the physical
installation of the MC1-UHD and its rear module into an openGear frame.

If you have questions pertaining to the installation of the MC1-UHD, contact us at the numbers
listed in “Contacting Technical Support”. Our technical staff is always available for consultation,
training, or service.

For More Information on...
+ the technical specifications for the MC1-UHD, refer to “Technical Specifications".

Before You Begin

These installation guidelines assume the following;:

+ Ensure the OGX-FR frame is properly installed. Refer to the User Guide for your frame.
* An MFC-OG3-N or MFC-OGX-N Network Controller Card installed in your OGX-FR frame.
+ Avalid IP address is available for the MC1-UHD.

+ If the rear module is already installed in the OGX-FR frame, proceed to “Installing the MC1-UHD
into an OGX-FR Frame”

Static Discharge
Throughout this chapter, please heed the following cautionary note:

§ ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor

devices. Avoid handling circuit boards in high static environments such as carpeted areas and when
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit
boards and related equipment.

Removing the Blank Plates from the Rear Panel

When a frame slot is not populated with an openGear card, a blank plate must be installed to
ensure proper frame cooling and ventilation.

| 7 Notice — Installing the R4-GATOR (8323AR-325) rear module in a frame other than the OGX-FR
could damage the card, the rear module, or both.
To remove a blank plate from the OGX-FR frame
1. Locate the slots in the OGX-FR frame you wish to install the MC1-UHD into.

2. Ifyou are using an R3B-GATOR (8322AR-318D) or R3A-GATOR (8322AR-319C) rear module, it is
recommended to use the following slot combinations:

*Slots 1, 2,3, 4 * Slots 13, 14, 15, 16
* Slots 5,6, 7,8 * Slots 17, 18, 19, 20
* Slots 9,10, 11, 12
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3. Ifyou are using an R4-GATOR (8323AR-325) rear module, it is recommended to use the
following slot combinations:

* Slots 1, 2 * Slots 7, 8 * Slots 13, 14 * Slots 19, 20
* Slots 3, 4 * Slots 9, 10, * Slots 15, 16
* Slots 5, 6 * Slots 11, 12 * Slots 17, 18

4. Use a Phillips screwdriver to unfasten each blank plate from the OGX-FR frame backplane.
5. Remove each blank plate from the chassis and set aside.

* You must remove two Blank Plates (covering four slots) in the OGX-FR frame when installing an
8322AR-319C rear module.

Installing the Rear Module into the OGX-FR Frame

If the rear module is already installed in the OGX-FR frame, proceed to “Installing the MC1-UHD
into an OGX-FR Frame”.

To install a rear module into the OGX-FR frame

1. For each retaining screw on the rear module, push the o-ring to the end of the screw (but not
off the screw). This will help to align the rear module to the frame backplane in step 3.

Figure 8 Location of the O-ring on the R3B-GATOR or R3A-GATOR Rear Module

2. Seat the bottom of the rear module in the seating slots at the base of the frame’s backplane.

Align the top holes of the rear module with the screw holes on the top-edge of the frame
backplane.

4. Using a Phillips screwdriver and the provided screw, fasten the rear module to the backplane.

* Do not fully tighten the screws until after installing the card and you have verified that the main
PCB aligns with the rear module.

28 * Physical Installation MC1-UHD User Guide (v8-rev3)



Installing the MC1-UHD into an OGX-FR Frame

The slot the MC1-UHD installs into depends on the slot combination you installed the rear module

in. This allows adequate spacing to avoid damaging the card, the cards installed in the neighboring
slots, or both.

Refer to Table 2 for valid slot combinations when using an R3B-GATOR (8322AR-318D) or
R3A-GATOR (8322AR-319C) rear module.

Table 2 Card Slot Combinations — R3B-GATOR (8322AR-318D), R3A-GATOR (8322AR-319C)

Rear Module is Installed in Main PCB Installs into Slot

Slots 1, 2, 3, 4 2
Slots 5, 6, 7, 8 6
Slots 9, 10, 11, 12 10
Slots 13, 14,15, 16 14
Slots 17,18, 19, 20 18

Refer to Table 3 for valid slot combinations when using the R4-GATOR (8323AR-325) rear module.

Table 3 Card Slot Combinations — R4-GATOR (8323AR-325)
Rear Module is Installed in Main PCB Installs into Slot

Slots 1, 2 1
Slots 3, 4 3
Slots 5, 6 5
Slots 7, 8 7
Slots 9, 10 9
Slots 11, 12 11
Slots 13, 14 13
Slots 15, 16 15
Slots 17,18 17
Slots 19, 20 19

To install the card into the OGX-FR frame

1. Locate the frame slot the card will slide into.

2. Using a Phillips screwdriver fasten the rear module to the backplane using the provided screws.

* Do not over tighten the screws.

3. Hold the card by the edges and carefully align the card edges with the slot rails in the frame.

4. Fully insert the card into the frame until the card is properly seated in the rear module.
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Cabling

This chapter provides an overview of connecting input and output devices to the rear module of the
MC1-UHD.

If you have questions pertaining to the installation of MC1-UHD, contact us at the numbers listed in
“Contacting Technical Support”. Our technical staff is always available for consultation, training,
or service.

X The examples in this chapter depict each rear module installed in a single OGX-FR frame. Your
setup may differ than what is presented here.

X Ross Video does not supply the required cables.

Cabling the Ethernet Port on the OGX-FR Frame

The MC1-UHD is connected to your network via the MFC-OG3-N or MFC-OGX-N in the OGX-FR
frame. This enables the MC1-UHD to interface with other cards in the frame, and the computer
running the DashBoard client. After a physical connection is established, DashBoard is used to
configure the network settings for the MC1-UHD.

* You must provide an Ethernet connection to the frame as outlined in the OGX-FR Series User
Guide.

Contact your IT department before connecting to your facility network to ensure that there are no
conflicts. They will provide you with an appropriate value for the IP address, Subnet Mask, and
Gateway for your MC1-UHD.

X If difficulties or problems are experienced when connecting to a network hub, contact your
network administrator.

Cabling for the MC1-UHD Local Reference Input

The OGX-FR frame provides two reference input connections that the MC1-UHD can use as a
reference source. Refer to the OGX-FR Series User Guide to learn more about cabling these ports.

Each MC1-UHD rear module also includes a REF IN HD-BNC that can assigned as a local reference
input. This section outlines how to connect to this reference input port. There is also the option to
specify the signal on the SDI IN 1 port as the reference source.

For More Information on...
+ specifying the reference source for your card, refer to “Reference and Timing Setup”.

To connect a reference source to the MC1-UHD rear module

+ Connect the reference signal to the REF IN HD-BNC on the MC1-UHD rear module.

X The reference input on th MC1-UHD is terminated by default. You may disable the termination by
moving J3 on the rear module. Refer to “Reference Termination Jumper (J3)" for details.
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Figure 9 Rear Module Cabling — Reference Source (REF IN)

Video Signal Cabling
Each rear module provides connections for up to six SDI inputs and six SDI outputs.

SDI Inputs

Connect your input video signals to the SDI IN HD-BNCs on the rear module as required. (Figure 10)
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Figure 10 Rear Module Cabling — SDI Inputs

* SDIIN 1 can be used as a reference source. Refer to “Specifying a Global Reference Source”.
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SDI Outputs

Connect your destination devices to the SDI OUT HD-BNCs on the rear module as required. There
are six HD-BNC SDI outputs available on each rear module. (Figure 11)
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Figure 11 Rear Module Cabling — SDI Outputs

Serial Cabling

If the MC1-UHD will communicate with an external device via a Serial communications protocol, you
will also need to connect this device to the SERIAL port on the MC1-UHD rear module. (Figure 12)

X This section applies only to the R3B-GATOR (8322AR-318D) or R3A-GATOR (8322AR-391C) rear
modules. The R4-GATOR (8323AR-325) rear module does not include a SERIAL port.

8322AR-319C 8323AR-318D OGX-FR Series Frame

5§g
<
[ Jememeer  CE

Serial Serial

Figure 12 Rear Module Cabling — Serial Connection
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Refer to Table 4 for pin-outs for the SERIAL port on the rear modules.

Table 4 Serial Pinouts on the MC1-UHD

RJ45 Pin

1

o N oo Ul A WN

GPI/Tally Cabling

n/c
RXx
Tx
n/c
n/c
n/c
GND
GND

RS-232

RS-422

Tx+
TX-
Rx+
n/c
n/c
Rx-

GND

GND

The GPIO ports are user programmable to be either an input (GPI) or an output (Tally) using the
GPI/Tally Setup tab in DashBoard. Electrically, the ports are setup for contact closure to ground,
with 4.75kohm pull-up resistor to +5V, so they default to a logical high state.

The ports are available on two 3-pin connectors located on each rear module. The 3-pin mating
connectors are provided with the rear module. The default state for the GPIO contacts is active low
signaling. This way, if the card is removed from the openGear frame, no external events will be
inadvertently asserted by the card. This also means that if a cable is absent from the rear module,
no GPI or Tally will be triggered and executed inadvertently by the card.

The number of available ports depends on the rear module (Table 5).

Table 5 Rear Modules — GPIO Ports

Rear Module

R3A-GATOR
R3B-GATOR
R4-GATOR

R3A-GATOR Cabling

6
6
4

Number of GPIO Ports

Figure 13 shows the GPIO designations for the R3A-GATOR rear module (P/N 8322AR-319C).
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Figure 13 R3A-GATOR Designations — GPIOs
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R3B-GATOR Cabling
Figure 14 shows the GPIO designations for the R3B-GATOR rear module (P/N 8322AR-318D).
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Figure 14 R3B-GATOR Designations — GPIOs

R4-GATOR Cabling
Figure 15 shows the GPIO designations for the R4-GATOR rear module (P/N 8323AR-325).
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Figure 15 R4-GATOR Designations — GPIOs

For More Information on...
+ the GPIO specifications, refer to Table 71.
+ configuring a GPIO port via DashBoard, refer to “Configuring the GPI/Tallies".

Audio Cabling

The R3B-GATOR rear module provides eight balanced audio connections on 3-pin connectors. This
rear module is required for the MC1-UHD-B. Cable your rear module using the following procedure.

To wire the audio for the R3B-GATOR rear module
1. Insert an audio wire to the designated polarity slot on the connector of the rear module.
Connector Connector Connector

Side View Top Views End View
+ L+ —

Connector

(without cable)
Audio Cable

2. Use a tweaker screwdriver to tighten the corresponding capture screw.
Repeat steps 1 and 2 for each wire on each connector.

4, Once the cables are wired to the connectors, install the connectors on the terminal blocks for
the rear module.
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Getting Started

This chapter provides instructions for launching DashBoard, assigning an initial IP address to the
MC1-UHD, and accessing the MC1-UHD interfaces in DashBoard.

If you have questions pertaining to the operation of MC1-UHD, contact us at the numbers listed in
“Contacting Technical Support”. Our technical staff is always available for consultation, training,
or service.

Before You Begin

Ensure that:

+ The openGear frame that houses the MC1-UHD displays in the Basic Tree View of DashBoard.
« The MC1-UHD displays as a sub-node in the openGear frame tree.

* Your facility IT Department provided the required network settings to be assigned to the
MC1-UHD.

Launching DashBoard

DashBoard must run on a computer that has a physical wired ethernet connection. Wireless
connections do not allow device discovery.

For More Information on...
+ downloading and installing the DashBoard client software, refer to our website.
+ the MC1-UHD interfaces in DashBoard, refer to “DashBoard Interface Overview".

To launch DashBoard
1. Ensure that you are running DashBoard software version 9.14 or higher.

2. Launch DashBoard by double-clicking its icon on your computer desktop.

Configuring the Initial Network Settings

Once the MC1-UHD is physically installed and cabled to your facility network, you will need to assign
it an initial IP address in order to gain full access to the card menus, options, and status fields in
DashBoard. Establishing an initial IP address enables DashBoard to communicate with the
MC1-UHD and update the Basic Tree View with the MC1-UHD sub-node.

X This IP address must be different that the IP address assigned to the Network Controller Card.

X This procedure requires a reboot of the card.

To assign the initial network settings for the MC1-UHD

1. Launch DashBoard.

2. Expand the openGear frame node to display a list of cards installed in that frame.
In the example below, the MC1-UHD card is installed in Slot 11 of Frame_10.

~ @ Frame_10
@ Slot 0: MFC-OG3-N
@ Slot 2: SPG-8260
@ Slot 6: SRA-8802
@ Slot 8: MDK-111B-K
@ Slot 11: MC1-UHD
@ Slot 18: VRC-100
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3. Double-click the MC1-UHD node under the frame node.

The Network interface displays in DashBoard.

Select the Network tab.

Use the Mode menu to select Static.

Use the Static IP Address field to assign a unique IP Address to the MC1-UHD card.

Use the Subnet Mask field to assign the subnet mask for the card.

© N o un A

Use the Gateway field to specify the gateway for communications outside of the local area
network (LAN) the card will use.

9. Click Apply.

The card is temporarily taken off-line during the reboot of the card to apply the new settings.
10. Verify the new network settings as follows:

a. Close the Network interface.

b. Refresh the Basic Tree View.

c. Expand the openGear frame node to display a list of sub-nodes.

d. Verify that the MC1-UHD sub-nodes display as seen in Slot 11 of the example below.

~ &8 Frame_10

@ Slot 0: MFC-OG3-N

@ Slot 2: SPG-8260

@ Slot 6: SRA-8802

@ Slot 8: MDK-111B-K

v @ Slot 11: MC1-UHD

R Global
R Configuration
R On Air Control

@ Slot 18: VRC-100

Accessing the MC1-UHD Interfaces in DashBoard

Once you establish the initial network settings for the MC1-UHD, you can access the Global,
Configuration, and On Air Control interfaces. These interfaces provide options for configuring,
monitoring, and operating your MC1-UHD in DashBoard.

For More Information on...

+ the Global interface tabs, refer to “Global Interface”.

+ the Configuration interface tabs, refer to “Configuration Interface”.
« the On Air Control interface, refer to “On Air Control Interfaces”.

To display the Global interface in DashBoard
1. Launch DashBoard.
2. In the Basic Tree View of DashBoard, locate the openGear frame the MC1-UHD is installed in.
3. Expand the openGear frame node to display a list of sub-nodes.
Each sub-node represents a specific card installed in a frame slot.
4. Locate the MC1-UHD sub-node.
X Look for the slot number that corresponds to the physical frame slot the MC1-UHD is installed in.
5. Expand the MC1-UHD node to display a list of sub-nodes for the card.
6. Double-click the Global sub-node.
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The Global interface opens in the right pane of the DashBoard window. The tabs in the Global
interface enable you to monitor the overall status of the MC1-UHD software and hardware,
configure the network settings for Ethernet communications, and enable alarms.

DA 4 Setup Network  Global Alarm Enables  Security  Configure Licenses  Logging
>

® 0K
n: ® ONLINE

Signal  Product Hardware Licensing State

Frame 1

Download MiBs

Upload

To display the Configuration interface in DashBoard
1. Launch DashBoard.
2. Inthe Basic Tree View of DashBoard, locate the openGear frame the MC1-UHD is installed in.
3. Expand the openGear frame node to display a list of sub-nodes.
Each sub-node represents a specific card installed in a frame slot.
4. Locate the MC1-UHD node in the frame tree.
X Look for the slot number that corresponds to the physical frame slot the MC1-UHD is installed in.
5. Expand the MC1-UHD node to display a list of sub-nodes for the card.
6. Double-click the Configuration sub-node.

The Configuration interface opens in the right pane of the DashBoard window. The tabs in the
Configuration interface enable you to configure the outputs, transitions, the matte generators,
the box masks, and GPI/Tally communications.

Video Format  Program Fail.over  Audio Status  Alarm Enables ~ ANC  Transitions  Output Selection  Matte  GPUTally ~ Remote Control  Router Control  CrosspointMap  Audio Profile Names  DVE  Audio Over
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To display the On Air Control interface in DashBoard
1. Launch DashBoard.
2. Inthe Basic Tree View of DashBoard, locate the openGear frame the MC1-UHD is installed in.
3. Expand the openGear frame node to display a list of sub-nodes.
Each sub-node represents a specific card installed in a frame slot.
4. Locate the MC1-UHD node in the frame tree.
X Look for the slot number that corresponds to the physical frame slot the MC1-UHD is installed in.
5. Expand the MC1-UHD node to display a list of sub-nodes for the card.
6. Double-click the On Air Control sub-node.

The On Air Control interface opens in the right pane of the DashBoard window. This interface
enables you to set up and perform transitions, configure keyers, monitor and control audio
levels.

GPIO Control ol
»

Logo

MC1 b+

Effect 1

Keyers

To lock the MC1-UHD interface
1. To lock the interface, select ﬂ

X This button is located in the upper right corner of the On Air Control interface.

2. To unlock the interface, use the provided Unlock spinner.

Configuring the Remote Logging Feature

The MC1-UHD enables you to implement a streaming log that captures status information of the
system via Port 514. This feature is useful for troubleshooting.

X A centralized Syslog server must be installed in your system. Refer to the documentation that
accompanied your centralized Syslog server for installation and setup information.

To configure the remote logging feature
1. Display the Global interface as outlined in “To display the Global interface in DashBoard".
2. Select the Logging tab.

3. Use the Remote Logging field to specify the IP Address of the device that will capture and store
the status information of the MC1-UHD.

* You must press Enter after typing the IP Address into the Remote Logging field.
4. Reboot the MC1-UHD card as follows:
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a. Click Reboot. This button is located on the bottom of the tab.

b. Monitor the reboot progress.

Secure Shell Login

Secure Shell (SSH) Login is a client-server protocol used by system administrators to securely log
onto remote systems and execute commands over an unsecured network. SSH may also be used by
Ross Technical Support for advanced troubleshooting. This service is disabled by default on the
MC1-UHD.

Enabling FTP(S)

The MC1-UHD uses an SSL certificate to facilitate encrypted data communications over an FTP
connection. The SSL certificate on your MC1-UHD verifies that the FTP connection to it is secure (the
SSL certificate is digitally signed by a trusted certificate authority).

Enabling FTP services on the MC1-UHD requires you to validate the SSL certificate in DashBoard,
and enable the FTP services on the card. If the SSL certificate is found to be invalid, you will need to
upload a new SSL certificate to the MC1-UHD.

* The MC1-UHD requires TLS/SSL Explicit encryption.

Validating the SSL Certificate on the MC1-UHD

This section outlines how to validate an existing SSL certificate (an *.pem file) on the MC1-UHD to
see if it is expired. This can be thought of as a manual refresh button to check if the current SSL
certificate on the MC1-UHD is still valid to use FTPS. If it is not, it will disable FTPS and a new *.pem
file must be provided to continue using FTPS.

* The MC1-UHD automatically validates the *.pem file and updates the SSL Status field after a
reboot.

To validate the SSL certificate on the MC1-UHD
1. Display the Global interface as outlined in “To display the Global interface in DashBoard".
2. Select the Security tab.
3. Locate the File Transfer Protocol Configuration area.
4. Click Scan SSL Certificate & Key.
The SSL Status read-only field updates.

The *.pem file will be validated and then be placed at the appropriate location in the MC1-UHD
for it to be used to have the ability to use FTPS. The *.pem file will no longer be present in the
SSL_CK folder.

X |f there is an error with the file or if the wrong file type is provided, the file will not be used. You
will then need to upload a new SSL certificate as outlined in the next section and repeat the
validation procedure.

Uploading a new SSL Certificate to the MC1-UHD

An SSL certificate is a *.pem file that contains the SSL certificate and key. You add this file to the
MC1-UHD directory, then repeat the validation procedure.

X This section is optional if the file was validated in the previous section and no changes are
required.
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To upload a new SSL certificate to the MC1-UHD
1. FTPinto the MC1-UHD as user.
2. Navigate to the SSL_CK folder.

+ The SSL_CK folder contains a README file and provides an SSL certificate and key to enable
FTPS.

+ Only one *.pem file containing an SSL certificate and key may be placed in this directory.
3. Add the *.pem file to the SSL_CK folder.
X Ensure that there is only one *.pem file in the folder.
4. Exitthe FTP session.
5. Repeat the procedure “To validate the SSL certificate on the MC1-UHD".

Enabling FTP(S) Services on the MC1-UHD

Once the MC1-UHD has a valid SSL certificate in DashBoard, you can proceed to enable the type of
FTP service you require. Once the FTP service is enabled on the card, you can access media files as
described in “Connection using FTP".

X Before proceeding, ensure that an FTP or FTPS session is not open while you are editing the
FTP(S) services.

To enable FTP(S) services on the MC1-UHD

1. In DashBoard, navigate to the Global > Security tab.
2. Locate the File Transfer Protocol Configuration area.
3. Choose one of the following:

+ Disable FTP Server — The MC1-UHD does not have access to any FTP server in your network.

* Enable FTP & FTPS — The MC1-UHD uses the File Transfer Protocol (FTP) and/or FTP with
Transport Layer Security (FTPS) for connection to your network. If using FTPS, first ensure the
SSL certificate is loaded and validated on the MC1-UHD. This mode also enables you to renew
the certificate if the current SSL certificate is still valid.

+ Enable FTPS Only — The MC1-UHD uses FTP with Transport Layer Security (FTPS) for
connections. Ensure the SSL certificate is loaded and validated on the MC1-UHD. This mode
also enables you to renew the certificate if the current SSL certificate is still valid.

+ Enable FTP Only — The MC1-UHD uses the File Transfer Protocol (FTP) for connection to your
network.

4. Click Apply.
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Licensed Features

The MC1-UHD has software licenses for enabling functions and features of the card. This chapter
outlines the available software licensed features, and how to install a software key for a licensed
feature.

License Keys Overview

Table 6 provides a brief summary on the types of licensed features available for the MC1-UHD.
Table 6 List of MC1-UHD Licensed Features

License Description
MC1-UHD-12G-LICENSE Enables the use of UHD 12Gbps SDI signaling on the card
MC1-UHD-DVE-1CH-LICENSE Enables the use of a single channel of 2D DVE?

MC1-UHD-MASTERCTRL-LICENSE  Enables a single channel of Master Control

a. The MC1-UHD has 1.5GB of DDR playout memory when the MC1-UHD-DVE-1CH-LICENSE license is enabled.

Installing a License Key

Ross Video uses license keys to control user access to specific MC1-UHD features. You can obtain a
key for a MC1-UHD licensed feature from Ross Video Technical Support.

To install a license key
1. Display the Global interface as outlined in “To display the Global interface in DashBoard".
2. Select the Configure Licenses tab.

3. Make a note of the character string in the Request Code field for the feature you wish to
enable.

4. Contact Ross Video using the information found in “Contacting Technical Support”.

a. When you speak to your Technical Support representative, tell them your name, your facility
name, and the Request Code from the Configure Licenses tab.

b. You will be given a License Key that must be entered in the applicable field in the Licenses
table.

5. Enter the provided License Key in the applicable Key field in the Configure Licenses tab.

6. Click Apply in the row for the License Key you entered in step 5.

Removing a License Key

Disabling a License Key removes user access to the MC1-UHD features associated with that License
Key.

X To re-enable the features, contact Ross Technical Support and request a new License Key.

To remove a license key

1. Display the Global interface as outlined in “To display the Global interface in DashBoard".
2. Select the Configure Licenses tab.

3. Click in the Key field for the licensed feature you want to remove.
4. Type remove.
5

Click Apply to remove the license.
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Reference and Timing Setup

This chapter provides instructions for specifying the reference source for the MC1-UHD.

Specifying a Global Reference Source

The OGX-FR frame supports a distributed frame reference, allowing incoming reference signals to
feed timing information to all openGear cards in that frame. Thus, a single signal can be used for
multiple cards.

* When using a progressive format reference signal to lock an interlaced format video signal, the
lock will be Frame Locked but Field indeterminate.

Frame Rate Compatibility

The card allows you to use any interlaced video format to operate the card in any format of the
same frequency; however, the use of 480i or 576i (Composite Sync) reference signals for High
Definition (720p, 1080i, 1080p) or UHD (2160p) video formats is not recommended for optimal
performance.

The use of composite sync reference formats is recommended for Standard Definition video modes
only, and provides stable outputs with jitter performance in compliance with SMPTE-259M
specifications.

Table 7 outlines the MC1-UHD frame rate compatibility.
Table 7 Output/Reference Compatibility

Reference Format

veplemms S;giol_ilz 5o 32':'2 576i 50Hz 1080i 50Hz 720p 50Hz 122?:8":: 1°2i°'_';’ZSF

480i 59.94Hz v v v

720p 59.94Hz v v v

1080i 59.94Hz 4 v 0]

1080p 59.94Hz v v v

576i 50Hz v v v

720p 50Hz v v v

1080i 50Hz 4 v 0]

1080p 50Hz v v v

1080pSF 23.98Hz v 4
1080pSF 24Hz v v
2160p? 50Hz v v v

2160p? 59.94Hz v v v

a.Requires the MC1-UHD-12G-LICENSE.
O = field indeterminate

For More Information on...
+ the options in the Analog Reference Status menu, refer to Table 25.
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To specify a global analog reference source for the MC1-UHD
1. Display the Global interface as outlined in “To display the Global interface in DashBoard".
2. Select the Setup tab.

4 Setp Network  Global Alarm Enables  Security  Configure Licenses  Logging
> SR

Frame 2

Load Factory Defaults

3. Use the Analog Reference Source options to specify the source for the reference input signal.
Choose from the following:

+ Frame 1 — assigns the source connected to the REF 1 port on the openGear frame.
+ Frame 2 — assigns the source connected to the REF 2 port on the openGear frame.
+ Local — assigns the external reference source connected to REF IN port on the rear module.

+ Input SDI 1 — assigns the signal connected to the SDI IN 1 port on the rear module.

X Ensure the input video frame rate matches the reference frame rate.

Monitoring the Reference Signal via DashBoard

The section outlines how to enable the Card state status field, located in the top left corner of the
Global interface, to report when the MC1-UHD does not detect an analog reference signal.

To configure the reference alarm for the MC1-UHD
1. Display the Global interface as outlined in “To display the Global interface in DashBoard".
2. Select the Global Alarm Enables tab.

3. Select the Alarm Enable box in the Reference Format row of the tab.

Configuring the Time Source

The Frame Network Controller card in the openGear frame can use an NTP server as a time source.
The time data is then made available to any openGear card installed in the same frame. You must
manually enable the MC1-UHD to access this time data by selecting an option on its Global >
Network tab.

For More Information on...
« communicating with an NTP server, refer to the MFC-0G3-N and MFC-8322-S User Manual.

To enable the MC1-UHD to access the time data from the Frame Network Controller card
1. Display the Global interface as outlined in “To display the Global interface in DashBoard".
2. Select the Network tab.
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3. Locate the Network Time area of the tab.

4. Select the Use time from Frame Controller box.

5. Click Apply.

To enable monitoring of the time data

1. From the Global interface, select the Global Alarm Enables tab.
2. Locate the Network Alarm area of the tab.

3. Select the Alarm Enable check box.

The Network time field will report the status of the time data.
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Configuring the SDI Outputs

This chapter provides instructions for configuring the card output video.

For More Information on...

+ enabling voice over on an SDI output, refer to “Enabling Voice Over on an Output”.
+ configuring EAS voice over, refer to “Enabling EAS Voice Over on an Output”.

Before You Begin

Keep the following in mind when configuring your SDI signals:

+ The SDI output timing is fixed on the MC1-UHD and is set to approximately 0.5 lines after the
reference.

+ Each video input has a line sync that can support a full line of HD video including horizontal
blanking.

+ All video inputs must be timed with the reference. The input tolerance is approximately +/- 0.5
line. Exceeding this tolerance will result in the output shifting of 1 line. The status fields in the
Configuration > Video Format tab displays a Yellow indicator when operating outside the range of
the line sync. In such cases, a vertical shift of 1 line or more may occur.

+ All of the video inputs must be the same video format as specified in the Configuration > Video
Format tab in DashBoard. If the formats do not match, the card reports an error in the
DashBoard Signal Status area and on the card-edge LEDs.

Specifying the Output Video Format

When setting the card output video format, ensure to that all SDI inputs match the specified format.

For More Information on...
+ the options in the Output Format menu, refer to Table 31.

To specify the output video format

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Video Format tab.

Video Format  Program Fail-over ~ Audio Status ~ Alarm Enables ~ ANC  Transitions  Output Selection ~ Matte  GPUTally ~ Remote Control  Router Control  CrosspointMap  Audio Profile Names  DVE  Audio Over
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3. Locate the Output Format area of the tab.

4. Use the Format menu to specify the card output video format.

X Ensure that the specified output format matches the input video format.

5. Select the Clip at Black to enable the MC1-UHD to clip at 0x40 on all outputs.

6. Select the Clip at White box to enable the MC1-UHD to clip at 0x3AC on all outputs.

Configuring the Outputs

Each of the six SDI outputs (on the rear module) can be configured as Program, Preview, one of four
Clean Feeds, or a Logo channel.

To configure your video outputs

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Output Selection tab.

Use the Output (1-6) options to specify the signal to assign to a specific SDI output. Choose
from the following:

« Black — the specified output displays black.

+ Program — the specified output displays the Program output.

+ Preview — the specified output displays the Preview output.

+ Clean # — the specified output displays the selected clean feed output.

+ Logo # — the specified logo channel to the output.
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Program Failover Setup

The Program Failover feature enables the MC1-UHD to monitor the Program input and should an
error occur, perform a specified action. You specify what types of event triggers the failover, how
long to wait until going into failover mode, and what action to take when the failover is triggered. If
the Auto Return option is also enabled, and the MC1-UHD determines that the Program input is
stable again (valid and locked), the output is switched back to the signal assigned to the Program
input. You also have the option to force an automatic failover, or to reset the failover by toggling the
Override button.

This chapter outlines how to configure the Program Failover feature, monitor the failover status,
and if required, force an automatic failover.

For More Information on...

+ assigning the Program and Preset outputs to physical BNCs on the rear module, refer to
“Configuring the Outputs”.

+ configuring a Logo channel, refer to “To load a media file into a Logo channel”.

Configuring the Frozen Video Threshold

During a loss of input, the MC1-UHD can report an alarm after a specified time has passed since the
last valid video frame. Once this threshold is met, the Program Failover feature is triggered.

To configure the frozen video threshold

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Video Format tab.

Locate the Frozen Video Threshold options.

Frozen Video Threshold (Frames)

4. Select the Frozen Video Threshold box to enable the feature.

Use the slider to specify the number of frames the video signal must be frozen before an alarm
is raised.

Defining the Program Failover Feature

This section outlines how to enable the Program Failover feature, define its trigger, determine how
long to wait until the failover mode is triggered, and specify the action to take during the failover.

To define the Program Failover feature

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Program Fail-over tab.
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Video Format  Program Fail-over  Audio Status ~ Alarm Enables. ransitions  Output Selection ~ Matte  GPUTally  Remote Control  Router Control  Crosspoint Map  Audio Profile Names ~ DVE  Audio Over

Audio Metadata SCTE-104 OP-47 Other

3. Use the Auto return options to specify whether the MC1-UHD automatically returns to the
original Program input signal once it is valid again. Choose from the following:

Disabled — disables this feature. The Program input continues to be the Fail-over Mode
setting (step 4) even if a valid signal is detected on the original Program input signal.

Enabled — the MC1-UHD automatically switches back to the original signal when a valid
signal is detected.

4. From the Fail-over mode row, select the MC1-UHD behavior when the Program Failover is
triggered (as defined in the following steps). Choose from the following:

X When assigning a failover source, ensure to select an SDI input that has not been assigned as a
router source.

Disabled — the MC1-UHD ignores the video, audio, and ANC trigger(s). The Program Failover
feature is disabled.

Switch to preset — the MC1-UHD switches the Program output to the Preset output.
Mute output — the MC1-UHD mutes the signal on the Program output.

SDI # — the MC1-UHD assigns the specified SDI input to the Program output.

Logo # — the MC1-UHD assigns the specified logo channel to the Program output.

To trigger the failover on a detected video error

1. From the Video Failover area, select the video error(s) that will trigger a Program Failover.
Choose from the following:

Incompatible Video — a failover is triggered when the Program input is a video format that
is not compatible with the value selected in “Specifying the Output Video Format".

Not Timed to Reference — a failover is triggered when the Program input format does not
match the reference source for the MC1-UHD. Refer to “Specifying a Global Reference
Source”.

No Signal — a failover is triggered when the MC1-UHD detects a loss of the video signal for
the Program input.

Frozen Video — if the Frozen Video Threshold feature is enabled, a failover is triggered after
the Program input is frozen for the specified number of frames. Refer to “Configuring the
Frozen Video Threshold” for details on this feature.

Unlicensed — a failover is triggered when the Program input is not supported and requires a
license key. Refer to “Licensed Features".
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2. Use the Video > Holdoff slider to specify the number of frames of consistent video signal error
that must occur before a failover is triggered.

3. Usethe Video > Auto Return slider to specify the number of frames that the MC1-UHD will wait
once a valid video signal is detected before automatically switching the Program input to it.

To trigger the failover on a detected audio error

1. From the Audio Failover area, select the audio error(s) that will trigger a Program Failover for
each audio group. Choose from the following:

+ Missing — a failover is triggered an audio signal is not detected on the Program input.

+ Async — a failover is triggered when the audio signal is mistimed with the video on the
Program input.

2. Use the Audio > Holdoff slider to specify the number of frames of consistent audio signal error
that must occur before a failover is triggered.

3. Use the Audio > Auto Return slider to specify the number of frames that the MC1-UHD will
wait once a valid audio signal is detected before automatically switching the Program input back
to it.

To trigger the failover on a detected ANC error

1. From the Ancillary Failover area, select the ancillary service error(s) that will trigger a Program
Failover. Choose from the following:

+ ST.352 Upstream — a failover is triggered when the incoming SMPTE ST-352 packets are not
detected on the Program input.

+ AFD — a failover is triggered when Active Format Description (AFD) data is not embedded in
the ancillary area of the Program input.

+ Closed Captioning (CC-708) — a failover is triggered when the CEA-708 data is not detected
on the Program input.

+ Closed Captioning (CC-608) — a failover is triggered when the CEA-608 data is not detected
on the Program input.

« LTC — a failover is triggered when the Linear Timecode packet is missing from the Program
input.

+ VITC — a failover is triggered when the Vertical Interval Timecode packet is missing from
Program input.

+ Compressed Audio Metadata — a failover is triggered when the audio metadata of the
input is not synchronous to the Program input.

+ SCTE-104 — a failover is triggered when the SCTE-104 packet is not detected in the baseband
SDI video signal of the Program input.

+ OP-47 — afailover is triggered when the embedded OP-47 VANC packets are not detected on
the Program input.

+ Other — afailover is triggered when other data types (not listed above) are absent in the
VANC of the Program input.

2. Use the ANC > Holdoff slider to specify the number of frames the MC1-UHD encounters video
errors before a failover is triggered. The default is 1.

3. Use the ANC > Auto Return slider to specify the number of frames that the MC1-UHD will wait
once the valid ANC data is detected in the signal before automatically switching the Program
input to it.
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Forcing the Failover

The Override button enables you to automatically trigger a Program Failover or stop the current
failover switch.

X The failover mode is determined using the procedures in “Defining the Program Failover

Feature”.

To manually trigger a failover

1.

Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Program Fail-over tab.
Ensure the Program Failover is configured. Refer to “Defining the Program Failover Feature".

Locate the Override button.

FORCE FAILOVER

Click FORCE FAILOVER.

+ The Program Failover feature is triggered and switches to the signal as defined by the
Fail-over Mode setting.

+ The button label now displays RESET FAILOVER.

To manually stop the failover switch

1.

vk WwN

Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Ensure the Program Failover is configured. Refer to “Defining the Program Failover Feature".
Verify that the Status field reports "Manual Reset Required'.

Locate the Override button.

Click RESET FAILOVER.

+ The Program Failover is canceled.

+ If the Auto Return setting is selected, the Program input returns to the signal used previous to
the failover switch.

+ The button label now displays FORCE FAILOVER.
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Router Setup

The Ross Ultrix router and third-party routers communicate with the MC1-UHD using the GVG
Series 7000 ethernet protocol. This chapter provides instructions for the basic physical installation
and communications setup of your Ultrix router to the MC1-UHD. Note that your facility
requirements may differ from what is presented.

* Router control requires the MC1-UHD-MASTERCTRL-LICENSE. Refer to “Licensed Features”.
For More Information on...
+ setting up your Ultrix router, refer to its Ultrix User Guide.

Ultrix Setup Overview

Before proceeding, ensure the Ultrix router:

+ is set up for third-party communications by referring to the Ultrix User Guide
+ is connected to your facility network and displays in the Tree View of your DashBoard client
+ is running the following software versions (Table 8)

Table 8 Recommended Software Versions

Product Min. Software Version
Ultrix router v4.0
Ultricore Central Controller (optional) v4.0

Figure 16 illustrates the physical connections in a simple routing system that includes an Ultrix and
an MC1-UHD. Ross Video does not supply these cables.
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Figure 16 Simple Routing System with a Ross Ultrix Router and an MC1-UHD
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Communications Setup

This section outlines how to configure the MC1-UHD to communicate with the Ultrix router via the
GVG Series 7000 Ethernet protocol.

Before proceeding, ensure that:

+ the router is set up for ethernet communications by referring to its user guide.

+ the license key for router control is installed on the MC1-UHD. Refer to “Licensed Features".

For More Information on...

* the Remote Control tab, refer to “Remote Control Tab".

* the Router Control tab, refer to “Router Control Tab".

+ specifying a delay or a retry value, refer to “Specifying the Router Switch Retries”.
To specify the GVG Series 7000 protocol for the MC1-UHD

1.

o vk~ Wb

7.
8.

Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Remote Control tab.

Locate the Ultrix Router (GVG Series 7000) area of the tab.
Select the box in the Ultrix Router (GVG Series 7000) area.
From the Connection menu, select Network Client.

Click Network Setup.

The Configure the Network Connection dialog opens.

Rosstalk @ Listering
Listening Port: 7788 Configure the network connection X

' Conn ve Packet Type TCP

Port

Ultrix Router (GVG Serie feme®

IP/Port: 0.0.0.0:12345 5 ddress” es only when Role is "Client.”

v

Connection Netw Client v Network Setup Device Setup

From the Packet Type menu, select TCP.

From the Port menu, specify the port number of the router.

X The default port number is 12345 for the Ultrix router.

9.

From the Remote IP menu, specify the IP address of the router.

10. Close the Configure the Network Connection dialog.

The new settings are automatically applied.

To define the communication options to the router

1.

In the Ultrix Router (GVG Series 7000) area, click Device Setup.

The GVG Series 7000 Native Setup dialog opens.
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GVG Series 7000 Native Setup X

Level Index 1 =
Personality Settings

Take All Levels &

Warning

2. Use the Level Index field to specify the level that the router will perform crosspoint switches
on.

3. Select the Take All Levels box to enable all transitions to take effect on all router levels.
X When using an Ultrix router, leave the Send Optional Tabs box unselected (no check-mark).
4. Use the Log Level options to specify what type of messages are in the log report.

5. Ifthe SEND and RECV Enable Log Messages boxes were selected in step 4, select the Log in
Hexadecimal box to display these log messages in hexadecimal.

6. If you are connecting to an NV9000, select the Disable Queries box.
Close the GVG Series 7000 Native Setup dialog.
The new settings are automatically applied.
To verify a connection on the Ultrix router
1. Display the Connections tab for the Ultrix router as follows:
a. Locate the Ultrix in the Tree View of DashBoard.
b. Expand the Ultrix node to display a list of sub-nodes in the Tree View.
c. Expand the Database sub-node.
d. Select the Connections sub-node.
e. Double-click the Connections node to display the Connections tab.
2. Locate the MC1-UHD in the Connections table.

X After reboot, the MC1-UHD will check the router status and report the current router connection
status on the On Air Control interface.

Third-Party Router Setup

When setting up communication between the MC1-UHD and a third-party router, optional licenses
and/or protocol translator hardware may be required to enable GVG Series 7000 Native protocol on
your router. Refer to your third-party router documentation to configure a remote interface.

Specifying the Router Switch Retries

The MC1-UHD provides options for delaying transitions to wait for the router switch to complete.
You can also specify a re-try value when the router switch has not completed within a specified
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length of time. Once the maximum number of re-tries is reached, the MC1-UHD pushes back the
crosspoints to the previous state.

To configure the router switch command retries

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Router Control tab.

* The measured min / max response time is displayed on this tab. It can be used as a good starting
point in specifying the Minimum Delay value.

3. Use the Minimum Delay slider to specify the number of frames the MC1-UHD waits between
sending the next switch command to the router.

4. Use the Retry Interval slider to specify the number of frames the MC1-UHD waits before
re-sending the same switch command to the router.

5. Use the Max Retries slider to specify the maximum number of times the MC1-UHD will send
the same switch command to the router before the switch is abandoned and an error condition
is raised.

For More Information on...
+ the read-only fields in the Router Control tab, refer to “Router Control Tab".

Assigning a Router Output to an SDI Input on the MC1-UHD

You can choose to manually assign a router destination to an SDI input.
To assign a router output to an SDI input on the MC1-UHD

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Router Control tab.
Locate the row for the SDI input you want to assign to the router output.

4. Use the menu in the Destination column to select the router destination.

Using Parked Sources

If your routing system is using resource management, assigning a Parked Source will allow the user
to disconnect the current destination (switch the same source number to the destination). The
specified output is parked when the crosspoint selected was not a router source.

To assign a parked source

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Router Control tab.
Locate the row for the SDI input you want to specify the parked source.

4. Use the menu in the Parked Source column to specify the source to use when the router
destination is parked.

X |t is recommended to select a Parked Source with the same video format as the program video.
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Crosspoint Mapping

This chapter outlines how to specify the number of available crosspoints, and assign sources to
each crosspoint.

For More Information on...
+ the menu items in the Crosspoint Map tab, refer to Table 50.

Default Crosspoint Mapping

The MC1-UHD is shipped with a factory default mapping for the available inputs to the crosspoint
buttons on the DashBoard control panel. However, you can also change the sources assigned to the
router destinations that are associated with the MC1-UHD using the options in the Crosspoint Map
tab.

Table 9 outlines the default crosspoint mapping for the MC1-UHD.

Table 9 Default Crosspoint Mapping

Crosspoint Unshifted Shifted
Button Source Type Selection Source Type Selection

1 Black Matte White

2 Matte Matte 1 Router

3 Matte Matte 2 Router

4 SDI Input SDI 1 Router

5 SDI Input SDI 2 Router

6 SDI Input SDI 3 Router

7 SDI Input SDI 4 Router

8 SDI Input SDI 5 Router

9 SDI Input SDI 6 Router

10 Logo Logo 1 Router

11 Logo Logo 2 Router

12 Router Source 1 Router RTR Extra 1
13 Router Source 2 Router RTR Extra 2
14 Router Source 3 Logo Logo 3
15 Router Source 4 Logo Logo 4
16 SHIFT SHIFT SHIFT SHIFT

Specifying the Number of Available Crosspoints

By default, the Program and Preset buses include 16 buttons each. You can change the number of
buttons per bus as required.

X This number is in addition to the Shift button.

MC1-UHD User Guide (v8-rev3) Crosspoint Mapping * 59



To specify the number of available crosspoints

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Crosspoint Map tab.

Audio Status  Alarm Enables ~ ANC  Transitions  Output Selection  Matte  GPTally  Remote Control Control  CrosspointMap  Audio Profile Names  Audio Over

3. Usethe Number of Buttons slider to specify the number of crosspoint buttons to display in the
Active Channel On Air Control interface.

Mapping the Program and Preset Crosspoints

Each crosspoint button can have two inputs assigned: the video source and an optional alpha
source. The alpha source is used only when selecting an external key.

X |If you change the Alpha assigned to a crosspoint already selected on an external key, you will also
need to send another router request (navigate to the On Air Control > External Keys tab, select
another crosspoint on the External Key bus and then select the re-configured crosspoint).

For More Information on...

+ assigning the Router Extra function for automation control, refer to “Reserving Crosspoints for
Automation Use".

To map a matte generator to a crosspoint

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Crosspoint Map tab.

Locate the row for the router button you wish to map.

Use the Source Type menu to select Matte.

Use the Selection menu to assign a specific matte generator.

Use the Label field to specify the text that will display on the button.

N o v s~ w N

Proceed to the chapter “Mattes” to set up the matte generators for the MC1-UHD.
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To map an SDI input to a crosspoint

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Crosspoint Map tab.
Use the Source Type menu to select SDI Input.
Use the Selection menu to assign one of the SDI inputs available on the MC1-UHD rear module.

Use the Alpha menu to assign a source for the alpha channel of the crosspoint.

A

Use the Label field to specify the text that will display on the button.
To map a router source to a crosspoint

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Crosspoint Map tab.
Locate the row for the router source you wish to map.
Use the Source Type menu to select Router.

Use the Selection menu to assign a router source to the button.

AN

Use the Alpha menu to assign a source for the alpha channel of the crosspoint.

7. Use the Label field to specify the text that will display on the button.

X Leave the Label field to its default value to use the auto-populated labels supplied by the router.
To map a logo channel to a crosspoint

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Crosspoint Map tab.

Locate the row for the button you wish to map.

Use the Source Type menu to Logo.

Use the Selection menu to assign a specific logo channel.

Use the Label field to specify the text that will display on the button.

N o v oA~ W DN

Proceed to “Media File Management"” to set up the logo channels for the MC1-UHD.

Reserving Crosspoints for Automation Use

Under Automation control with the Remote Control > Device Setup > Switch Request set to
Router Crosspoint, the MC1-UHD will use the first crosspoint with its Type set to Router that
matches the desired crosspoint source. When the desired crosspoint source is not permanently
mapped to a crosspoint button, the first available RTR Extra button will be temporarily mapped to
the desired crosspoint source. If all RTR Extra buttons are in use, or there are none assigned, the
automated switch request will fail.

By default, there are two RTR Extra buttons, with one mapped to each row. If you are not using an
Automation system, or have a small number of router sources to switch, you may wish to re-map
these buttons to other functions. Otherwise it is recommended to keep the default mapping of one
RTR Extra button per crosspoint row.

For More Information on...
+ configuring the Switch Request feature, refer to “Automation Switch Request”.
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Applying Labels to the Crosspoint Buttons

This section outlines how to apply the button labels from the router, use the MC1-UHD default text,
or overwrite the user labels with the router labels.

To apply the labels from the connected router

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Crosspoint Map tab.
Locate the Load Labels from Router area.

4. Click Load.
The Label fields on the tab update to report the labels imported from the connected router.
The Load button is now disabled.

* Click Overwrite Label with Default Router Label to overwrite user-defined labels with the label
imported from the connected router.

To return all crosspoint button labels to the default text

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Crosspoint Map tab.

Locate the Load Labels from Router area.
4. Click Unload.

The Label fields on the tab update to report the default text set by the MC1-UHD.
To update the RTR Extra labels

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Crosspoint Map tab.
3. Select the Update Router Extra labels box.

* When the Source Type is set to Router Extra, the button label on the On Air Control interface
reports the last used router source.

+ When automation requests a router source not listed in the crosspoints, and instead uses a
Router Extra crosspoint, the label is updated to show the router source that was requested.
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Using RossTalk

The MC1-UHD can be controlled from a remote editor or computer via RossTalk commands. These
commands can be sent to the MC1-UHD over an ethernet or serial connection. This chapter outlines
how to establish a connection point between the MC1-UHD and an external device using the
RossTalk protocol.

Using an Ethernet Connection

Contact your IT Department before connecting to your facility network to ensure that there are no
conflicts. They will provide you with an appropriate value for the IP address, subnet mask, and
gateway for the external device communicating with the MC1-UHD.

Cabling Requirements

You will require a standard network CAT-5 cable to connect the MC1-UHD to your facility network.
Refer to “Cabling the Ethernet Port on the OGX-FR Frame” for more information.

Configuring the MC1-UHD for RossTalk Communications

This section outlines how to configure the MC1-UHD to communicate with a device via RossTalk
over an ethernet connection.

For More Information on...
+ the RossTalk settings on the Remote Control tab, refer to Table 43.

To enable the RossTalk protocol for ethernet communications

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Remote Control tab.
Locate the RossTalk area in the tab.

Select the box in the RossTalk area.

vk WwN

From the Connection menu, select one of the following:

* Network Client — The MC1-UHD functions as a service requester that initiates
communications with a server on the network.

* Network Server — The MC1-UHD functions as a host, or socket listener, on the network. This
is the default.

6. Click Network Setup.
The Network Setup dialog opens.

7. Use the Packet Type menu to specify the ethernet protocol your external device will use to
communicate with the MC1-UHD.

8. Ensure the Port field is set to 7788.

If you selected Network Client in step 5, use the Remote IP field to specify the IP address of
the MC1-UHD on the network to be used for RossTalk communications.

10. Close the Network Setup dialog.

The new settings are automatically applied.
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Using a Serial Connection

RossTalk commands can be sent to the MC1-UHD via the SERIAL port (RS-232/RS-422) on the card's
rear module.

Cabling Requirements

Refer to “Serial Cabling” for details on connecting a serial device to the MC1-UHD rear module.
Refer to the documentation for your external device for specific cabling requirements.

Configuring the MC1-UHD for Serial RossTalk Communications

This section outlines how to configure the MC1-UHD to communicate with a device via RossTalk
over a serial connection.

To enable the RossTalk protocol for serial communications

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Remote Control tab.
Locate the RossTalk row in the tab.
Select the box in the RossTalk area.

From the Connection menu, select Serial Port.
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Click Serial Port Setup.
The Configure the serial connection dialog opens.

7. Use the Port Type menu to specify transmission standard the external device uses. The default
is RS 422.

8. Use the Bit rate menu to select the bit rate for the external device connected to the Serial port
of the MC1-UHD. The default is 115200.

9. Use the Data Bits menu to set the number of data bits transmission (character length). The
default is 8.

10. Use the Parity menu to set the parity type for the external device. The default is None.
11. Use the Stop Bits menu to set the number of stop bits transmission. The default is 1.

12. Use the Flow Control menu to enable the MC1-UHD notify the serial device when it is
experiencing a data overflow and stop sending data (SW) or to allow continuous data flow
between the MC1-UHD and the device (None). The default is None.

13. Close the Configure the serial connection dialog.

The new settings are automatically applied.

Using the RossTalk Protocol

RossTalk is a plain text based protocol that allows control of Ross Video equipment. This section
briefly outlines how to send RossTalk commands, and lists the supported commands.

Sending RossTalk Commands

RossTalk commands are generally case-sensitive, and must be terminated with carriage return and
linefeed (CR+LF). When using with the MC1-UHD, the command can be uppercase or lowercase, and
the terminator can by simply linefeed.
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For example,

MSPATH 1:0:ColorRamp.tga

MSPATH 1:0:directory/filename.png

To send RossTalk Commands

1. Verify that you have created a network connection to the MC1-UHD.

2. Enter the commands you want to send to the MC1-UHD.

Supported RossTalk Commands
Table 10 lists the RossTalk commands that the MC1-UHD supports.

Command

FTB
FTB level

GPI xx
GPI xx:level
KEYAUTO 1:keyer

KEYAUTO 1:keyer:level

KEYCUT 1:keyer
KEYCUT 1:keyer:level

MSPATH CHAN:O:FILENAME

REVEAL dve:reveal

TAKE
TAKE ALL
VGPIARM vgpi:arm

Table 10 Supported RossTalk Commands

Description

Performs a fade-to-black transition

* Level 0 = always clears FTB. No impact if already FTB.
* Level 1 = always sets FTB state.

Triggers action associated with the specified GPl number (xx)

Triggers GPI number xx where:
* Level O = logically OFF
* Level 1 = logically ON

Fades a key on/off air. The keyer value is 1 to 6.

+ Level 0 = always take key off air; no change if key is already off air
* Level 1 = always take key on air; no change if key is already on air

Cuts a key on/off air. The keyer value is 1 to 4.

+ Level 0 = always take key off air; no change if key is already off air
* Level 1 = always take key on air; no change if key is already on air

Load a still or animation from the Micro SD card where:
* CHAN is logo channel (1 to 2)

* FILENAME is the directory/filename to be loaded. There is a
maximum filename length of 256bytes.

X While the FILENAME does not need to be complete, it still requires
enough characters to uniquely identify the file in the directory.

* dve is the effect number 0 through 3
* reveal is the reveal source where:
- EXTERNALis 1 or 2
- LOGO is logo channel (1 through 4)
Takes all armed except for background video
Takes all including background video (if BKGD INCL is set)
Arms the specified effect defined for the vgpi number on preset
where:
* vgpi is between 0-17
« arm = 0; disarm the effect

* arm = 1; arm the effect on the Preset bus
* arm = 2; disarms the effect
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Table 10 Supported RossTalk Commands (Continued)
Command Description

VGPISTATE vgpi:state Activates the specified effect defined for the vgpi number on air
where:

* vgpi is between 0-17
+ state = 0; takes the effect off air
+ state = 1; takes the effect on air

VOARM vo:state Arms the EAS voice over state on the Preset bus for the next Take All
command where:
e vo =1 is Audio Over
* vo = 2 is EAS voice over
* state = 0; off air
* state =1; 0onair

VOCUT vo:state Cuts the EAS voice over on Program where:
* vo =1 is Audio Over
* vo = 2 is EAS voice over
+ state = 0; off air
* state =1; onair

VODUCK vo:gain Sets the voice over duck level where:
* vo =1 is the Audio Over duck level
* vo = 2 is the EAS duck level
* gainis expressed in 1/10 dB steps; allowable range is -30 to 0

VOGAIN vo:gain Sets the voice over gain level where:
* vo =1 is the Audio Over gain level
* vo = 2 is the EAS gain level
* gainis expressed in 1/10 dB steps; allowable range is -30 to 10

XPT bus:shift:xpt Hot punches on a specified bus where:
* bus = 0; Program
* bus = 1; Preset
* bus = 2; External 1
* bus = 3; External 2
*shift=0or1
* xpt = is the crosspoint number (zero based)
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Comtrol® DeviceMaster®
Setup

The Comtrol® DeviceMaster® connects to the MC1-UHD over ethernet and provides a number of
RS-232/422/485 serial ports. This chapter describes how to set up the MC1-UHD and the
DeviceMaster to work together.

Cabling Requirements

You will need a Comtrol® DeviceMaster® Port Expander, and Ethernet interface cables. Refer to
Table 11 for pin-outs on the Port Expander.

Table 11 Pinouts on the Port Expander

Pin RS-232 RS-422
1 Ccb n/c
2 Rx RxA (Rx-)
3 TX TXA (Tx-)
4 DTR n/c
5 Ground n/c
6 DSR n/c
7 RTS TxB (Tx+)
8 CTS RxB (Rx+)
9 RI n/c

DeviceMaster Setup

This procedure assumes that a DeviceMaster is already installed in your facility. If not, or if you are
encountering difficulties configuring your DeviceMaster via a web browser, it is recommended to
use the Comtrol® PortVision® software to set up your DeviceMaster. Refer to your DeviceMaster
documentation for details on using this software or for troubleshooting your installation.

To set up a DeviceMaster
1. Onyour computer:
a. Open your web browser

b. In the address bar, enter the IP address of your DeviceMaster. The default address is
192.168.250.250.

c. Press Enter.
2. Click Configure Network.

Click Use static configuration below: and enter the IP Address, Netmask, and Gateway you
want to use.

X A static IP Address is recommended for the DeviceMaster to communicate with the MC1-UHD

4. Click Save.
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Changes do not take effect until the DeviceMaster is rebooted.
5. Click Port x, where x is the port on the DeviceMaster you are connecting a device to.
6. Enter the Serial Configuration information for your device.
7. Enter the TCP Connection Configuration information for your device:

+ Enable — selected

+ Listen — selected

+ Port — Ross Video suggests that you start numbering the ports at 8701.
+ Leave all other settings at their default values.

8. C(lick Save.
Changes do not take effect until the DeviceMaster is rebooted.

9. Reboot the DeviceMaster.

MC1-UHD Setup

This section outlines how to configure the MC1-UHD to communicate with the Comtrol®
DeviceMaster® via an ethernet protocol. In this section, we use the Presmaster protocol as an
example.

To set up communications

1. Display the Configuration interface for the MC1-UHD as outlined in “To display the
Configuration interface in DashBoard".

Select the Remote Control tab.
Locate the Presmaster Control area of the tab.

Select the box in the Presmaster Control area.
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From the Connection menu, select Network Client.

The MC1-UHD will function as a service requester that initiates communications with a server
on the network

6. Click Network Setup.
The Network Setup dialog opens.
From the Packet Type menu, select TCP.
Use the Port field to specify the port number for the DeviceMaster.

Use the Remote IP field to specify the IP Address of the DeviceMaster on the network to be
used for communications.

10. Close the Network Setup dialog.

The new settings are automatically applied.
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Using the TSL UMD v3.1 Protocol

A third-party router, Multiviewer, or Ultrix router can communicate with the MC1-UHD via the Tally
Systems Ltd. Under Monitor Display (TSL UMD) v3.1 protocol over a serial or ethernet connection.

X TSL UMD control requires the MC1-UHD-MASTERCTRL-LICENSE. Refer to “Licensed Features”.

Using a Serial Connection

The external device connects to the MC1-UHD via the SERIAL port on the MC1-UHD rear module.
Ross Video does not supply this cable.

For More Information on...
+ the pinouts for the SERIAL port, refer to “Serial Port Specifications".
+ the specific cabling requirements of your external device, refer to the device user guide.

Configuring the MC1-UHD for Serial TSL UMD Communications

This section outlines how to configure the MC1-UHD to communicate with a device via a serial
connection and the TSL UMD v3.1 protocol.

To configure the MC1-UHD for serial TSL UMD v3.1 communications

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Remote Control tab.

3. Locate the Tally Protocol Control area in the tab.

Tally Protocol Control (

Listening Port: 5727

Connection Network Server ¥ Network Setup Device Setup

4. Select the box in the Tally Protocol Control area.
From the Connection menu, select Serial Port.

6. Click Serial Port Setup.
The Configure the serial connection dialog opens.

7. Use the Port Type menu to specify transmission standard the external device uses. The default
is RS 422.

8. Use the Bit rate menu to select the bit rate for the external device connected to the Serial port
of the MC1-UHD. The default is 115200.

9. Use the Data Bits menu to set the number of data bits transmission (character length). The
default is 8.

10. Use the Parity menu to set the parity type for the external device. The default is None.
11. Use the Stop Bits menu to set the number of stop bits transmission. The default is 1.

12. Use the Flow Control menu to enable the MC1-UHD notify the serial device when it is
experiencing a data overflow and stop sending data (SW) or to allow continuous data flow
between the MC1-UHD and the device (None). The default is None.

13. Close the Configure the serial connection dialog.

The new settings are automatically applied.
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Using an Ethernet Connection

Contact your IT Department before connecting to your facility network to ensure that there are no
conflicts. They will provide you with an appropriate value for the IP address, subnet mask, and
gateway for the MC1-UHD and your external device.

Cabling Requirements

Use a standard network CAT-5 cable to connect the MC1-UHD to your facility network. Refer to
“Cabling the Ethernet Port on the OGX-FR Frame” for more information. Ross Video does not
supply this cable.

Configuring the MC1-UHD for Ethernet TSL UMD Communications

This section outlines how to configure the MC1-UHD to communicate with an external device via an
ethernet connection and the TSL UMD v3.1 protocol.

To enable the TSL UMD v3.1 protocol for ethernet communications

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Remote Control tab.
Locate the Tally Protocol Control area in the tab.

Select the box in the Tally Protocol Control area.
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From the Connection menu, select Network Client.

The MC1-UHD functions as a service requester that initiates communications with a server on
the network.

6. Click Network Setup.
The Network Setup dialog opens.

7. Use the Packet Type menu to specify the ethernet protocol your external device will use to
communicate with the MC1-UHD.

Ensure the Port field is set to 7788.

9. Ifyou selected Network Client in step 5, use the Remote IP field to specify the IP Address of
the MC1-UHD on the network to be used for RossTalk communications.

10. Close the Network Setup dialog.

The new settings are automatically applied.

Tally Label Settings

Tally label text is determined by the external device (the source of the tally). Refer to “Crosspoint
Mapping" for information on router crosspoint mapping and label definition.
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Protocol Implementation

MC1-UHD implements the protocol with the following structure: pisplayID|Control |DisplayData.
Table 12 lists the TSL UMD Protocol v3.1 commands the MC1-UHD supports.

Table 12 TSL UMD Protocol v3.1 Commands

Command Description
Display Address 0 - 126 display identification enumeration
Control Byte
Bit O Tally 1 status (1=on, 0=off)
Bit 1 Tally 2 status
Bit 2 Tally 3 status
Bit 3 Tally 4 status
Bits 4-5 Brightness value
Bit 6 Reserved
Bit 7 0
Display Data 16 ASCII display characters (20h-3Eh)
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Using the Presmaster Protocol

The MC1-UHD supports a subset of Miranda™ Presmaster Control System automation commands
and automation tallies. This chapter outlines how to set up communications with a third-party
device using the Presmaster protocol.

For More Information on...

+ the Miranda™ Presmaster protocol, refer to the Miranda Presmaster Automation Protocol
Manual.

+ configuring a Comtrol DeviceMaster, refer to “Comtrol® DeviceMaster® Setup”.

+ the location of the ATMN button on the On Air Control interface, refer to “Menu System
Basics".

Configuring an Ethernet Connection for Presmaster

Before you proceed, ensure that the MC1-UHD is connected to your facility network and assigned a
valid IP address.

For More Information on...
+ network cabling requirements, refer to “Cabling the Ethernet Port on the OGX-FR Frame”.
+ assigning an IP address, refer to “Configuring the Initial Network Settings".

Configuring the MC1-UHD for Ethernet Presmaster Communications

This section outlines how to configure the MC1-UHD to communicate with the Presmaster ethernet
protocol.

To enable the Presmaster protocol for ethernet communications

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Remote Control tab.
Select the box in the Presmaster Control area.
4. From the Connection menu, select one of the following:

* Network Client — The MC1-UHD functions as a service requester that initiates
communications with a server on the network.

* Network Server — The MC1-UHD functions as a host, or socket listener, on the network. This
is the default.

5. Click Network Setup.
The Network Setup dialog opens.

6. Use the Packet Type menu to specify the ethernet protocol your external device will use to
communicate with the MC1-UHD. The default is TCP.

7. Use the Port field to specify the port that the MC1-UHD will listen on. The default is 9001.

8. If you selected Network Client in step 4, use the Remote IP field to specify the IP Address of
the MC1-UHD on the network to be used for Presmaster communications.

* The Remote IP field value is ignored when the Connection is set to Network Server.

9. Close the Network Setup dialog.

The new settings are automatically applied.
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Configuring a Serial Connection for Presmaster

Presmaster commands can be sent to the MC1-UHD via the SERIAL port (RS-232/RS-422) on the
card’s rear module.

* Refer to the documentation for your external device for specific cabling requirements.

Cabling Requirements

Refer to “Serial Cabling” for details on connecting a serial device to the MC1-UHD rear module.

Configuring the MC1-UHD for Serial Presmaster Communications

This section outlines how to configure the MC1-UHD to communicate with the Presmaster serial
protocol.

To enable the Presmaster protocol for serial communications

From the Tree View in DashBoard, expand the node for the MC1-UHD you want to access.
Select the Configuration node to display the interface in the right-half of DashBoard.
Select the Remote Control tab.

Select the box in the Presmaster Control area.

From the Connection menu, select Serial Port.
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Click Serial Port Setup.
The Configure the serial connection dialog opens.

7. Select the electrical standard from the Port Type menu. This must match the serial cable type
that connects the MC1-UHD to the external serial device.

X The Bit Rate, Data Bits, Parity, and Stop Bits values are reset to their default values when a
different type is selected.

8. Use Table 13 to set the required parameters for the Presmaster.

Table 13 Setup Parameters

Parameter Setting
Bit Rate 38400
Data Bit 8
Parity Even
Stop Bit 1

9. Use the Flow Control menu to enable the MC1-UHD notify the serial device when it is
experiencing a data overflow and stop sending data (SW) or to allow continuous data flow
between the MC1-UHD and the device (None). The default is None.

10. Close the Configure the serial connection dialog.

The new settings are automatically applied.

Reserving Crosspoints for Automation Use

Under Automation control with the MC1-UHD Switch Request feature set to Router Crosspoint,
the MC1-UHD will use the first crosspoint with its Type set to Router that matches the desired
crosspoint source. When the desired crosspoint source is not permanently mapped to a crosspoint
button, the first available Router Extra button will be temporarily mapped to the desired
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crosspoint source. If all Router Extra buttons are in use, or there are none assigned, the
automated switch request will fail.

To reserve crosspoints for Automation Use
1. Inthe Presmaster Control area of the Remote Control tab, click Device Setup.
The Device Setup dialog opens.
2. From the Automation Switch Request area, select how a crosspoint switch is defined:

* Router Crosspoint — The received value refers to a physical or virtual router crosspoint. This
is the default setting.

+ Button Number — The received value refers to a specific MC1-UHD crosspoint button on the
DashBoard control panel. Note that these crosspoint buttons are defined in the Crosspoint
Map tab.

3. Close the Presmaster Control dialog.
The new settings are automatically applied.
To assign a crosspoint as an Router Extra source

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Crosspoint Map tab.

Locate the row for the router source you wish to map.
Use the Source Type menu to select Router.

Use the Selection menu to select Router Extra.

Use the Alpha menu to select None.

N o v oA~ wN

Select the Update Router Extra Labels box to enable the crosspoint button label (on the On Air
Control interface) to update with the currently selected router source.

Supported Commands
Table 14 summarizes the automation commands supported by the MC1-UHD.
Table 14 Supported Commands

Command Code Supported Notes
Simple Commands

SET_TRANS_TYPE 0x01 + Transition type 00 is a protocol extension used to
deactivate BKGD INCL. It does not affect the transition
v type.

* Transition types 01-05 are supported

+ Transition types 06-19 are used to select the SqueezeBack
transition type

ENQ_STAT 0x02 Results in the return of the following tallies: current
crosspoint state on the Program and Preset buses, voice
v over states, and the current transition type.
The following tallies are not returned: DSK states, transition
rate, auxiliary bus source.

SET_TRANS_RATE 0x03  Sets the transition rate in frames.

* Range is between 1 and 99 inclusive.
+ Default rate is set to 60 frames.

+ Upon setting a rate a tally is also sent.
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Command
SET_DSK1_STATE

SET_DSK2_STATE
SET_PRG_VID_SRC
SET_PRG_AUD_SRC
SET_PRESET_VID_SRC

SET_PRESET_AUD_SRC
SET_AUX_VID_SRC
SET_AUX_AUD_SRC
TAKE_ALL
TAKE_AUDIO
AO_STATE

AO_SRC
SRC_TABLE_SET
MIXER_POLL
AQO_LEVEL
PRG_LEVEL
SRC_CHN_LEVEL
DSK_CLIP_LEVEL
DSK_GAIN_LEVEL
SRC_GAIN
SET_AUTO_STATE
START_AUDIO_LEAD
ABORT_AUDIO_LEAD
START_AUDIO_LAG
ABORT_AUDIO_LAG
DSK1_SETTING
DSK2_SETTING

Table 14 Supported Commands (Continued)

Code Supported
0x06

0x07
0x09 v
0x0A
0x0B

0x0C
0x0D v
OxOE
OxOF v
0x10
0x13
0x14
0x1A
Ox1E 4
0x24
0x25
0x26
0x27
0x28
0x29
0x2B
0x2C
Ox2E
Ox2F
0x31
0x32
0x33

Notes

7

Refer to “Automation Switch Request”.
Audio follows video

Activates BKGD INCL.
Refer to “Automation Switch Request”.

Audio follows video
Refer to “Automation Switch Request".

Audio follows video

Always returns OxFF Ox1E

Audio leading fixed at 1 frame
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Command
SET_AUDIO_MODE

SET_AO_RATE

SET_U_FADE_TIMES

Extended Commands

IS2_TUNNEL
TAKE_VIDEO
DSK_ARM
DSK_STATE

LOAD_PREV_IMG
LOAD_IMG

VO_ARM
VO_STATE
VO_PRESET
VO_DUCK
ENQ_DSK_IMG

VO_RATE

Table 14 Supported Commands (Continued)

Code Supported
0x34

0x38
0x3C

0x0001
0x0010
0x0006 v
0x0007

0x0032
0x0033

0x0013
0x0014
0x0024
0x0025
0x0034

0x0038

Notes
Supports 4 pairs, plus mute and phase inversion

Select from any of the 8 possible input pairs (and of the 16

embedded channels)

Mute bits apply to both channels of an audio pair

Phase Reverse bits apply to the second channel of the

pair only

Crosspoint selection applies to either a crosspoint

number or to a router input, as defined by the

Automation Switch Request. Refer to “Automation

Switch Request”.

> When using a router input, the Audio Mode applies to all
crosspoints mapped to the specified router input.

> When the specified router input is not mapped to any
crosspoint, the command is ignored.

Takes effect the next time the specified crosspoint is

selected on a TAKE or hot-punch transition.

Video and audio are switched together.

+ Enables you to activate/deactivate a specified key using a
fade or a cut transition on the Program bus.

+ The transition rate used will always be determined by the
automation rate, as specified by the Simple Command
0x03.

Load file into specified DSK. DSK 0 to 1 load specified file
into DDR for Logo 1 to 2 respectively. DSK 127 (7Fh)
pre-loads file into the DDR only for fast recall into usable
Logo 1 to 2, when needed.

X Ensure the FILENAME contains the directory name and
the file name. While the FILENAME does not need to be
complete, it still requires enough characters to uniquely
identify the file in the directory.

Atally is sent regardless of the outcome. The expected tally
is now returned if the file is already loaded. On a failure to
load a file, a tally is returned with a zero-length filename.

Inquire DSK image exists; causes return of four tallies (one
for each logo).
Includes a tally for DSK 127.
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Command
VO_SHUFFLE

VGPI_ARM

VGPI_STATE

SET_PCS_CHN
GET_PCS_CHN
AUTO_TALLY_ENA

SET_PAN_SHOTBOX
GET_PAN_SHOTBOX
CHECK_MEDIA
DISCONN_PAN

Supported Presmaster Tallies

Table 14 Supported Commands (Continued)

Code Supported

0x0026
0x0130

0x0140

0x0040
0x0041
0x0042

0x0043
0x0044
0x0047
0x0048

Notes

+ Supports a maximum of sixteen VGPIs (VGPI 0 to VGPI 17)

+ This command will be ignored when the specified
SqueezeBack Preset is on Program

When in Arm Up state, the command includes the
specified SqueezeBack Preset in the transition (the
SQUEEZE button is lit on the On Air Control interface)
When in Arm down/Disarm state, the command excludes
the specified SqueezeBack Preset in the transition (the
SQUEEZE button is unlit on the On Air Control interface)

When no SqueezeBack Preset is on Program and this
command is in the Up state, selects the effect type of VGPI
and transitions the selected effect on Program.

When a SqueezeBack Preset is on Program and this
command is in the Down state, the VGPI which has the
same effect as the current one will be handled and the
current effect will be off air or on Preview.

In other cases, the command will be ignored.

Enables the periodic sending of the automation status
tally (0842) every # seconds (the rate is set by command).
* Reports to the automation system the current state of the
ATMN button

Table 15 summarizes the automation tallies supported by the MC1-UHD.

Name

Program Video Source

Program Audio Source

Preset Video Source

Preset Audio Source

Aux Video Source

Aux Audio Source
Take Complete
Take Audio

Table 15 Supported Presmaster Tallies

Tally ID

49

4A
4B

4C
4D

4E
4F
50

Included in
EUPESTY plalss ENQ_STAT (0x02)

v Refer to “Automation Switch v
Request”

v Audio follows video v

v Refer to “Automation Switch v
Request”

v Audio follows video v

v Refer to “Automation Switch v
Request”

Audio follows video
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Name

V/O State
U-Fade Rate
Transition Type
Transition Rate
Mixer Poll
Source Audio Parameters
DSK Clip Value
DSK Gain

DSK State

VO Arm State
VO Parameters

Image Load State

DSK Image Existence

Current VGPI State

Set Panel to Channel on
PCS

Get Which Channel a
Panel is connected to

Automation Control Status

Current Shot Box Selected
on Panel

Tally Sent when a Panel
Acquires a Channel

Tally Sent when a Panel
Drops a Channel

Tally Sent Back from
Intuition to Show which
Files, if any, are Missing in
a Template

Automation Assist
Command

Table 15 Supported Presmaster Tallies (Continued)

Included in
ENQ_STAT (0x02)

53 4 Sent on change in voice over state v
7C
41 v v

Tally ID  Supported Notes

\
\

43
SE v Always returns OxFF, Ox5E
6E

67

68

Ext 0x0806

Ext 0x0813

Ext 0x0826

Ext 0x0833 Sent whenever a new image file has
loaded, via automation or otherwise.
Reports DSK 0 to 1 when loaded file
v into DDR for Logo 1 to 2, respectively.
Reports DSK 127 (7Fh) when file is
pre-loaded into DDR only (this can
only originate via automation).

Ext 0x0834 Response to the “ENQ_DSK_IMG"
command. Includes DSK0to 1, Logo 1
v to 2 respectively, a flag byte set if
specified file is loaded on the
corresponding logo and the filename.

Ext 0x0940
Ext 0x0840

Ext 0x0841

Ext 0x0842 v
Ext 0x0843

Ext 0x0845
Ext 0x0846

Ext 0x0847

Ext 0x0928
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Automation Switch Request

The Automation Switch Request feature uses Simple Commands 0x09, 0x0B, and 0x0D and is
applicable when operating with an Automation system. This feature defines the crosspoint switch
as a router crosspoint number or as an MC1-UHD button map number.

In order to access button 20, an extended message must be provided as specified in the Presmaster
protocol specification. For example, FF 09 7F 00 14 would be sent for the Program bus.
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Using the APC Protocol

This chapter outlines how to setup MC1-UHD communications with a third-party device via the APC
protocol.

For More Information on...
+ the APC protocol, refer to the documentation that came with your device.

Configuring an Ethernet Connection for APC

Before you proceed, ensure that the MC1-UHD is connected to your facility network and assigned a
valid IP Address.

For More Information on...
+ network cabling requirements, refer to “Cabling the Ethernet Port on the OGX-FR Frame”.
+ assigning an IP Address, refer to “Configuring the Initial Network Settings".

Configuring the MC1-UHD for Ethernet APC Communications

This section outlines how to configure the MC1-UHD to communicate with the APC Ethernet
protocol.

To enable the APC protocol for ethernet communications

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Remote Control tab.
Select the box in the APC Control area.
4. From the Connection menu, select one of the following:

* Network Client — The MC1-UHD functions as a service requester that initiates
communications with a server on the network.

* Network Server — The MC1-UHD functions as a host, or socket listener, on the network. This
is the default.

5. Click Network Setup.
The Network Setup dialog opens.

Configure the network connection X

Packet Type TCP -
APC Control
o

Network Setup

6. Use the Packet Type menu to specify the Ethernet protocol your external device will use to
communicate with the MC1-UHD. The default is TCP.

Use the Port field to specify the port that the MC1-UHD will listen on. The default is 9003.

8. If you selected Network Client in step 4, use the Remote IP field to specify the IP Address of
the MC1-UHD on the network to be used for APC communications.

* The Remote IP field value is ignored when the Connection is set to Network Server.
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9. Close the Network Setup dialog.

The new settings are automatically applied.

Configuring a Serial Connection for APC

APC commands can be sent to the MC1-UHD via the SERIAL port (RS-422) on the card’s rear
module.

X Refer to the documentation for your external device for specific cabling requirements.

Cabling Requirements

Refer to “Serial Cabling” for details on connecting an RS-422 serial device to the MC1-UHD rear
module.

Configuring the MC1-UHD for Serial APC Communications
This section outlines how to configure the MC1-UHD to communicate with the APC Serial protocol.
To enable the APC protocol for Serial communications

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Remote Control tab.
Select the box in the APC Control area.

From the Connection menu, select Serial Port.

vk WwN

Click Serial Port Setup.
The Configure the serial connection dialog opens.

6. Setthe Port Type to RS-422. This must match the serial cable type that connects the MC1-UHD
to the external serial device.

X The Bit Rate, Data Bits, Parity, and Stop Bits values are reset to their default values when a
different type is selected.

7. Use Table 16 to set the required parameters for the APC.
Table 16 Setup Parameters

Parameter Setting
Bit Rate 38400
Data Bit 8
Parity Odd
Stop Bit 1

8. Use the Flow Control menu to enable the MC1-UHD notify the serial device when it is
experiencing a data overflow and stop sending data (SW) or to allow continuous data flow
between the MC1-UHD and the device (None). The default is None.

9. Close the Configure the serial connection dialog.

The new settings are automatically applied.

Reserving Crosspoints for Automation Use

Under Automation control with the MC1-UHD Switch Request feature set to Router Crosspoint,
the MC1-UHD will use the first crosspoint with its Type set to Router that matches the desired
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crosspoint source. When the desired crosspoint source is not permanently mapped to a crosspoint
button, the first available Router Extra button will be temporarily mapped to the desired
crosspoint source. If all Router Extra buttons are in use, or there are none assigned, the
automated switch request will fail.

To reserve crosspoints for Automation Use

1.

In the APC Control area of the Remote Control tab, click Device Setup.
The APC Control dialog opens.
From the Switch Request area, select how a crosspoint switch is defined:

* Router Crosspoint — The received value refers to a physical or virtual router crosspoint. This
is the default setting.

+ Button Number — The received value refers to a specific MC1-UHD crosspoint button on the
DashBoard control panel. Note that these crosspoint buttons are defined in the Crosspoint
Map tab.

Close the APC Control dialog.

The new settings are automatically applied.

To assign a crosspoint as an Router Extra source

1.

N o v oA~ W N

Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Crosspoint Map tab.

Locate the row for the router source you wish to map.
Use the Source Type menu to select Router.

Use the Selection menu to select Router Extra.

Use the Alpha menu to select None.

Select the Update Router Extra Labels box to enable the crosspoint button label (on the On Air
Control interface) to update with the currently selected router source.

Supported Commands
Table 17 lists the APC commands the MC1-UHD supports.

Table 17 APC Commands

Command Description
CHANGE Reports when a status change occurs in the device
DSK Loads the Key via the specified transition type at a specified transition rate
ERROR Reports when a communication error occurs on the device
OVER Controls the audio over on either program or preset bus.

+ The first channel is audio over as on the on-air display.
* The second channel controls the EAS audio over channel.

PGM Loads the Program source to the indicated channel

PST Loads the Preset audio/video channel via the specified transition type at a
specified transition rate

STATUS Requests the On Air status of the keys, PST, and PGM

TAKE Performs a transition/Take via preset
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Setting up an EAS with MC1-UHD

This chapter outlines how to set up communications between an EAS decoder and the MC1-UHD via
the SAGE EAS protocol.

X EAS communication requires an MC1-UHD-MASTERCTRL-LICENSE. Refer to “Licensed Features”.

Cabling Requirements

Before you begin, confirm how your EAS device will communicate with the MC1-UHD:
* via the Comtrol® DeviceMaster® over ethernet, or
* via a serial connection

X Set up with an EAS requires an R3B-GATOR (8322AR-318D) or R3A-GATOR (8322AR-319C) rear
module.

For More Information on...
+ configuring a Comtrol DeviceMaster, refer to “Comtrol® DeviceMaster® Setup”.
+ the MC1-UHD rear modules, refer to “MC1-UHD Cabling Overview".

MC1-UHD Setup

This section outlines how to configure the MC1-UHD to communicate via the SAGE EAS ethernet
protocol.

To set up ethernet communications via the SAGE EAS protocol

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Remote Control tab.
Select the box in the SAGE EAS Char Gen area.

SAGE EAS Char Gen

Listening Port: 9002
4

Connection Network Client ¥

Network Setup Text Crawl Setup

Audio Setup

Source Setup

4. From the Connection menu, select Network Client.

The MC1-UHD functions as a service requester that initiates communications with a server on
the network.

5. Click Network Setup.

The Network Setup dialog opens.

Use the Packet Type menu to specify TCP.

Ensure the Port field is set to 7788.

Use the Remote IP field to specify the IP Address of the EAS device.

v e N oo

Close the Network Setup dialog.

The new settings are automatically applied.
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10. From the Port menu, specify the port number that is connected to the EAS device.
11. Select the Enabled box.

The Text Crawl sub-tab now displays in the On Air Control > Logos tab of DashBoard. This tab
will be used to configure the text overlay as described in “Customizing the EAS Text Overlay".

12. Confirm that the EAS device reports a valid connection.

Customizing the EAS Text Overlay

The MC1-UHD provides an overlay engine that is capable of displaying an EAS horizontal text crawl
in real time. EAS messages are grouped into categories as determined by the EAS device you are
using. The MC1-UHD provides options for customizing the appearance of each message category
such as font size and color, background color, and pan speed.

X The overlay is automatically loaded into a dedicated Logo channel.
To customize the EAS text overlay

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Remote Control tab.

Locate the SAGE EAS Char Gen area of the tab.
4, C(lick Text Crawl Setup.

The SAGE EAS dialog opens.

Sage EAS

OFF | High Prorty  Madum Priorty  Low Priorty

5. Use the % From Top slider to adjust the vertical position of the EAS text overlay. Note that this
setting is not applicable to the Emergency Alert (High Priority) categories as these messages are
fixed to the top of the screen.

6. Use the Text Size slider to adjust the font size of the text overlay from smallest (1) to largest
(10). Note that actual text size is dependent on the video format.

7. Select a text color and/or background color for the text overlay using the provided fields. The
EAS Text Attributes field reports an error when the text color and the background color match.

* When using very long EAS messages, the MC1-UHD may use a smaller font size and/or may
disable transparency. The exact length depends on the characters used in the message (widths of
each font character).

To apply a drop shadow to the text overlay, select the Drop Shadow box.
Use the Pan Speed slider to specify the speed of the EAS text crawl across the screen.

10. Use the Play Count field to specify the number of times to display the entire text crawl before
taking it off air.

11. Use the Duration field to specify the number of seconds the EAS text crawl will display before it
is taken off air.

12. Repeat 5 to 11 for each message category you want to configure.
13. Close the SAGE EAS dialog.
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To specify the On Air behavior of the EAS text crawl
1. Display the SAGE EAS dialog as outlined in steps 1 to 4 in the above procedure.

2. Locate the On Air Behavior area of the dialog. You may need to scroll down to locate this area.

Sage EAS

3. Select the Until Plays Completed box to enable the EAS text crawl to continue to play until the
number of plays equals the value specified in the Play Count menu of the SAGE EAS dialog.

4. Select the Until Duration Completed box to enable the EAS text crawl to continue to play until
the value in the Duration menu is reached.

5. Select the While Voice Over Active box to enable the EAS text crawl to continue to play only
while the EAS Voice Over source is playing.

6. Close the SAGE EAS dialog.

EAS Voice Over

The MC1-UHD enables flexible audio/voice over mixing with a variable program audio level, audio
over gain control, and preset mixing with transition control.When EAS is active, all channels are
mixed. If the source may contain more audio channels that you want mixed, ensure to use the Mute
setting for those channels.

When setting up the gain and duck levels, note that audio sources are layered with the EAS
positioned downstream from the Voice Over channel. For example, applying a duck level when EAS
is active, also applies that value to the Voice Over channel (if active) and the other incoming audio
sources. That means when both Voice Over and EAS audio are in effect, it is possible to duck the
incoming audio twice.

o
o
>

O
m

Q
o

=

Figure 17 Simplified Audio Layering

Configuring the Audio Source for EAS
This section outlines how to configure the embedded audio sources for the EAS audio transitions.
To set up an EAS source

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Remote Control tab.
Locate the SAGE EAS Char Gen area of the tab.
4. Click Source Setup.

The Voice Over dialog opens.
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Voice Over 2

Embedded SDI Source

Use the Embedded SDI Source options to specify the SDI source for the EAS.

6. From the Voice Over area, select the audio source to include in the output. Choose from the
following:

X Silence is embedded if the selected source is not present on the input video.

None — no channels are assigned for the EAS voice over.

Clear All — assigns all channels (1-16) to None.

Clear Group — assigns the four sources in the same group to None.

Clear Pair — assigns the two sources in the same pair to None.

AES — assigns all 16 sources to consecutive AES sources.

AES # > Ch # — assigns the specified AES channel in the selected EAS channel.
Embedded — assigns all 16 sources to the corresponding SDI inputs.

Embedded > SDI G#C# — assigns the specified embedded audio group and channel pair in
the selected EAS channel.

Test Tone — sets the group (4 sources) to all consecutive test tones.
Test Tone > # — sets the selected test tone to the specified EAS channel.

7. Close the Voice Over dialog.

Setting the EAS Duck and Gain Levels

When EAS is active, all audio channels on the Program shall be adjusted by a value specified on the
Remote Control > SAGE EAS Char Gen > Voice Over Audio Setup dialog. The default is to reduce the
gain by 10dB.

When using a Sage Digital ENDEC EAS, the MC1-UHD reacts to the Sage Push To Talk (PTT) relay
closure to activate audio voice over. While the PTT relay is closed, the MC1-UHD applies the EAS
Duck Level specified via the Audio Setup dialog to the incoming Program audio and performs a cut
transition by mixing the incoming audio from the channel at a specified level.

X If both Voice Over and EAS audio are in effect, the incoming audio is ducked twice.

To set the EAS duck level

1. Ensure that you have configured a port on the MC1-UHD rear module for the EAS protocol you
are using.

2. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

Select the Remote Control tab.

4. Locate the SAGE EAS Char Gen area of the tab.
Click Audio Setup.
The Voice Over Audio Setup dialog opens.
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Voice Over Audio Setup X

Duck Level (dB)

72 48 M

Gain (dB)

Audio Setup

Source Setup

6. Use Duck Level slider to specify the amount (dB) to reduce the audio level on the Program bus
during an EAS alert.

7. Use the Gain slider to apply a gain (in dB) to the Voice Over (EAS) channel.

Enabling EAS Voice Over on an Output

This section outlines how to enable EAS voice over on any MC1-UHD output. You can also have
multiple instances of the same output with and without EAS voice over.

To enable EAS voice over on an output

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Output Selection tab.
Locate the Voice Over Enable area.
4. Inthe EAS column, select the box for each SDI output you wish to enable EAS voice over for.
In the following example, the user enabled EAS for Qutputs 1 and 3.
Cwver Enable
Status
Output 1 program

Output 2 pyg gram

Output 3 praview

Output 4 rlagn 1

Cutput 5

Cutput &
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EAS Status

The On Air Control > Home > EAS Status field reports if the connected EAS device is providing
content to the text overlay of the MC1-UHD. This field is located at the bottom of the Home tab.

(Figure 18)

Audio Processing Audio Shuffle Save Audio Profile Voice Over

Home Keyers SqueezeBack Effects Logo External Keys

Transition Rates (frames)

Slow Rate 60 ¥ Med Rate 30 5 FastRate 15 5 FTB Rate

EAS Status:
Figure 18 Example of a Home Tab with EAS Status Field

When the EAS Status field reports OFF, the MC1-UHD text overlay does not include EAS content.

When the EAS Status field reports ON, followed by color-coded text, an installed EAS is provides
content to the MC1-UHD text overlay. This text also displays in this area when the EAS is active.
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On Air Control Overview

This chapter provides a basic introduction to the MC1-UHD, including an overview of the different
areas of the On Air Control interface, using the menu system, as well as a brief summary of how
video is controlled by the MC1-UHD.

Menu System Basics

The On Air Control interface enables you to set up and perform transitions, configure keyers,
monitor and control audio levels. (Figure 19) This section provides a brief overview of this interface.

GPIO Control i)

Logo

Effect 1 - e e ATMN
ON
0
teeyers

Figure 19 MC1-UHD — On Air Control Interface

1) Setup Tabs 3) Transition Area 5) Fade to Black Button 7) Program Audio Area

2) Crosspoint Buses 4) Keyer Area 6) Automation Button

1. Setup Tabs
The tabs located near the top left of the interface provide options for configuring the keyers,

on-air controls, and selecting logo channel sources. Refer to “DashBoard Interface Overview”
for a list of the available tabs and parameters.

2. Crosspoint Buses

This area is used to select the video sources for each bus. Each crosspoint button will display the
name of its source on the button face. The default bus mapping is outlined in “Default
Crosspoint Mapping". The following buses are available:

> Program Bus — The Program Bus is used to select the video source that will show as the
Background on the Program output. After performing a factory default reset, the BLACK
button is selected on this bus.

> Preset Bus — The Preset Bus is used to select the video source that is visible on the Preview
output. After performing a factory default reset, the BLACK button is selected on this bus.

3. Transition Area

This area provides the options for selecting transition rates (slow, medium, fast), and type (take,
fade-fade, take-fade, mix, fade-take). Refer to “Transitions” for details.
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4. Keyer Area

This area includes the four keyers of the MC1-UHD and allows you to perform the key transitions.
Refer to “Keying" for details.

5. Fade to Black Button

Use this button to fade the Program bus to black. The Fade to Black (FTB) rate is specified in the
Home tab. After performing a factory default reset, this button is toggled off (unlit).

6. Automation Button

Toggling this button on (button will be lit) allows an Automation System to control the MC1-UHD.
After performing a factory default reset, this button is toggled on (lit).

7. Program Audio Area

This area includes an audio fader that enables you to control the Program audio gain. The slider
is set by default to 0 and has a range of -72 to +20dB. Use the Default button to reset the audio
gain.

Switcher Basics

This section gives an overview of how video is controlled by the MC1-UHD. This includes video
sources, video layering, and preview. For information on setting up crosspoints, refer to “Mapping
the Program and Preset Crosspoints”.

Video Sources

The MC1-UHD has access to two basic types of video sources: external and internal. All video
sources can be assigned to video source (crosspoint) buttons. By pressing a crosspoint button on a
bus, the video source assigned to that button is selected.

+ External — video sources that come from SDI inputs on the rear module.

+ Internal — video sources that come from internally generated video, such as any of the two
internally generated Logo channels, or an internally generated black, or one of the matte
generators.

To select a video source on a bus, you must identify the bus you want to assign a video source to
and then press the crosspoint button you want to select on that bus.

Video Layering

Key layering is fixed for the MC1-UHD and starts with Background and proceeds to Keyer 4.

Background

Keyer 1
Keyer 2
Keyer 3|
Keyer 4

Figure 20 Simplified Video Layering

Video Preview

Video preview allows you to use an additional monitor to preview what the next shot is going to be.
The Preset bus of MC1-UHD shows what is selected for the next transition. This includes the keys
and background video sources that will be on-air after the next transition.
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DVE Transitions

The MC1-UHD can be used to perform on-air 2D DVE (SqueezeBack) transitions to reveal another
video source or graphic. You can also transition to pre-squeezed effects with standard transitions,
squeeze in any direction on either X or Y axis, or both. Refer to “SqueezeBack Effects” for more
information.

X DVE transitions require the MC1-UHD-DVE-1CH-LICENSE. Refer to “Licensed Features”.

Displaying the On Air Control Interface

You can choose whether to display the entire On Air Control interface at full-screen mode on a
DashBoard client computer.

To set the MC1-UHD On Air Control interface to full-screen

*+ Press Shift+F11 to display the interface in full-screen mode; or
+ Select Window > Full Screen from the DashBoard toolbar.

X To exit out of full-screen mode, press Shift+F11 again.
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Channel Select Buttons

This chapter outlines how to assign a MC1-UHD card to a Channel Select button, and update the
icons for an MC1-UHD button for ease of identification.

Overview

When using multiple MC1-UHD cards, it may be desirable to control any MC1-UHD from a
DashBoard console. To facilitate switching between multiple MC1-UHD cards, a row of dedicated
Channel Select buttons is provided in the upper left corner of the On Air Control interface (Figure
21). You can change the icons displayed in the Channel Select Buttons, the Basic Tree View node,
and the Home tab by updating the corresponding graphic files stored on the MC1-UHD card.

EAS Status:

ATMN

Figure 21 Example of the Channel Select Row of the On Air Control Interface

Before You Begin

Keep the following in mind when using multiple MC1-UHD' cards:

+ The Channel Select buttons must be setup on each MC1-UHD card.

+ When setting up the Channel Select buttons, it is important that the sequence of devices be
consistent. Otherwise the buttons will appear to “move around” when toggling between
interfaces. This cannot be enforced automatically, the user must be careful when setting up the
buttons.

+ If the IP address of any MC1-UHD cards changes, then the Channel Select buttons will not work
correctly. Specifically, the red background color that indicates the currently active device will not
be correct. It is highly recommended to use static IP addresses to avoid this problem.

X |f either of these problems occur, they can be fixed by repeating the procedure “Configuring the
Channel Select Buttons”.

1. This also applies when a setup includes MC1-MK cards.
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Updating the Icons

It is intended for users to update the icon graphics for each MC1-UHD with their own versions,
particularly if they have more than one MC1-UHD. For example, you may wish to identify each
MC1-UHD by using a specific station logo. This section summaries the graphic files used by a card.

Prior to configuring the Channel Select buttons, each MC1-UHD should be given a custom set of
icon (station logo) graphics as described in this section. Channel Select buttons will operate with the
default logos, but it may be confusing to the operator.

Graphic Files

The graphic files are stored on the Micro SD card of the MC1-UHD in the Media/Logos directory on
the card. Note that the underlying file system (ext3) is case-sensitive, and that both the directory
and the filenames are lower-case. Inside the media directory there are three files containing icons
(station logos) in various sizes. (Table 18)

* When replacing the content of these files, ensure that the image dimensions remain the same.
For best results, also ensure that these images have a transparent background.

Table 18 Image Files for Multi-Channel Setups

Filename Image Dimensions Used for...
station_logo_icon.png 16 x 16 pixels Basic Tree View node icon
station_logo_small.png 50 x 50 pixels Channel Select button icon
station_logo_large.png 450 x 250 pixels On Air Controls, Home tab icons

Managing the Graphic Files

Use an FTP client to connect to the MC1-UHD and replace the graphic files stored on the card. This
is exactly the same procedure as is used to load other graphics files to logo channels on the
MC1-UHD. Refer to “Connection using FTP" for details.

Once new files are transferred to the MC1-UHD via FTP, they will immediately be used. However,
DashBoard software caches the images and may not display the new icons right away. Refreshing
the card (click the Refresh button), or restarting DashBoard, generally fixes this problem.

Configuring the Channel Select Buttons

The Channel Select buttons are located in the upper left corner of each card’s On Air Control
interface. (Figure 22) Until these are configured by the user, they appear as empty buttons. Clicking
the empty buttons has no effect. You can specify the number of Channel Select buttons, to a
maximum of 10, that display in the interface.

These buttons allow you to toggle between the On Air Control interfaces of multiple MC1-UHD
Master Control Switchers. Selecting a button displays the corresponding MC1-UHD On Air Control
interface in DashBoard. A lit button indicates that the corresponding On Air Control interface is the
currently active card in DashBoard.
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Figure 22 Example of Mapping the Channel Select Buttons

X It is highly recommended to consistently assign MC1-UHD cards to the Channel Select buttons.
For example, assigning the same MC1-UHD to the first Channel Select button on all interfaces
ensures that clicking the first Channel Select button displays the same MC1-UHD.

To specify the number of Channel Select buttons

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Crosspoint Map tab.

Specify the number of buttons to display in the On Air Control interface of that MC1-UHD by
typing the number into the Number of Channel Select Buttons field.

X You may need to scroll down the tab to locate this field.
4. Repeat steps 1-4 for each MC1-UHD you wish to configure.
To configure the first MC1-UHD

1. Display the On Air Control interface of the first MC1-UHD as outlined in “To display the On Air
Control interface in DashBoard".

2. Returnto the Tree View.
Assign the first MC1-UHD to the first Channel Select button as follows:
a. Select the On Air Control node and keep the mouse button pressed.

b. Drag the node over the first Channel Select button. Notice the mouse pointer changes shape
when over the target button.

¢. Release the mouse button. The Channel Select button updates to show the appropriate logo
for the first MC1-UHD.

4, Repeat step 3 for the second MC1-UHD, but ensuring to assign the second MC1-UHD to the
second Channel Select button.

5. Assign each additional MC1-UHD to a button in On Air Control node of the first MC1-UHD.
To set up additional MC1-UHD

1. Display the On Air Control interface of the next MC1-UHD as outlined in “To display the On Air
Control interface in DashBoard".

2. Return to the Tree View.

3. Drag the On Air Control node of the first MC1-UHD to the first Channel Select button on the
next MC1-UHD On Air Control interface.
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4. Drag the On Air Control node of the second MC1-UHD to the second Channel Select button on
the next MC1-UHD.

5. Repeat for each additional MC1-UHD to add the buttons to the On Air Control interface for each
MC1-UHD.
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Audio

This chapter provides instructions for configuring the audio features of the MC1-UHD using the
options available in DashBoard. This includes how to map the audio channels, adjust the gain, and
specifying the Voice Over source.

Audio Overview

The MC1-UHD provides the ability to independently configure the audio channel map and gain of
each input (up to 16) that can be selected on the crosspoint bus, and to adjust the gain, or mute,
individually, each of the 16 embedded channels. The audio processing and shuffle settings are
retained on a per crosspoint basis. In addition, audio settings can be saved to one of four audio
profiles that can be applied to any crosspoint during a TAKE transition.

Workflow
Figure 23 provides a simplified workflow diagram of the audio processing.
: Gain, Sum
Optional ’ ’ ;
SR Invert, —| Voice Over,
AES Input Downmix EAS
Gain, S i
ain, Sum, . . Program/Preset
Invert Mix Voice | ) Master |y} Frhedded
Over Gain Output

Program/Preset : Audio Voice Over
Embedded Input P Input Gain |- Shuffle » Duck Level »

Figure 23 Audio Processing Workflow

For More Information on...

+ automation protocol support for audio, refer to the chapter in this guide for the protocol you are
using.

Identifying the Audio Groups

The MC1-UHD also provides the ability to change the color scheme of the audio group buttons in
the On Air Control interface. This allows you to assign a unique color to each group, allowing you to
quickly identify the groups on the interface.

To map the audio channels

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

2. Select the Audio Shuffle tab.

GPIO Control

Logo
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To change the audio profile, select the required button from the Load Profile area.
4. Locate the channel you wish to map.

Click the associated Source button.

The Select source dialog opens.
6. Select the source you wish to map to the selected channel.
7. Close the dialog.

8. Repeat steps 4 to 7 for each channel.

Setting the Master Audio Level

The master audio level can be adjusted manually using the Audio Gain slider. This slider applies a
gain (in dB), to the audio that is included with the output.

To set the Master Audio level

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

2. Specify the audio gain value using the Audio Gain slider.

* The numerical gain value may also be entered directly in the field above the Reset Audio Gain
button.

3. You can select the Reset Audio Gain button to set the audio gain to 0dB. This resets the gain
preset back to 1:1.

Audio Processing

The MC1-UHD provides the ability to adjust the gain, or mute, individually, each of the 16
embedded channels. The audio processing and shuffle settings are retained on a per crosspoint
basis. You can also sum every adjacent pair of audio groups with the first channel on the Odd
Channel numbers (e.g. Channels 1 and 2, 3 and 4, 5 and 6 etc.).

* Changes made to settings on the Audio Processing tab take effect immediately on the Preview
output. The changes will be applied to the Program output on the next Take transition.

To configure the audio processing

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

2. Select the Audio Processing tab.
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Select the sub-tab for the channels you wish to configure. The 1-8 tab is selected by default.

4. To apply a gain to a channel, use the associated Ch # slider to select a value between -20dB and
+20dB. Note that this does not affect the Audio Over gain levels.

5. To mute a channel, select the associated Mute button. When the button is red, the specified
output channel is muted.

6. To sum the outputs of channel pairs within a group, select the Sum button for the channel pair.
Note that both channels will carry the average of the two input channels ((A+B)/2).

7. Toreset the parameters for the specified channel to the default values, select the associated
Reset button.

8. Ifrequired, repeat steps 4 to 6 for each channel in the group.

Enabling Voice Over on an Output

This section outlines how to enable Voice Over on specific outputs. You can also have multiple
instances of the same output with and without voice over.

For More Information on...
+ configuring EAS voice over, refer to “Enabling EAS Voice Over on an Output”

To enable voice over audio on an output

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Output Selection tab.
Locate the Voice Over Enable area.
4. Inthe Audio Over column, select the box for each SDI output you wish to enable voice over for.

In the following example, the user enabled Audio Over for Outputs 1 and 3.
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Voice Over Setup

This section outlines how to configure the embedded audio sources for the Voice Over feature for
audio transitions.

To set up the voice over source

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Audio Over tab.

e  GPUTally  Remote Control  Router Control  CrosspointMap  Audio Profile Names  DVE  Audio Over

3. From the SDI Source options, select the SDI source for the voice over.

The selected SDI is now lit blue.

4. Locate the Channel you wish to configure for voice over.

5. Use the Source menu to configure the voice over channel. Choose from the following:

X Silence is embedded if the selected source is not present on the input video.

None — no source is assigned to the specified voice over channel.

Clear All — assigns all channels (1-16) to None.

Clear Group — assigns the four sources in the same group to None.

Clear Pair — assigns the two sources in the same pair to None.

AES — assigns all 16 sources to consecutive AES sources.

AES # > Ch # — assigns the specified AES channel in the specified voice over channel.
Embedded — assigns all 16 sources to the corresponding SDI inputs.

Embedded > SDI G#C# — embeds the specified audio group/channel.

Test Tone — sets the group (4 sources) to all consecutive test tones.

Test Tone > # — the voice over channel outputs the specified test tone.

In the following example, the user is assigning AES4 ChA as the source for Channel 9.
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6. Use the Duck Option menu to specify how the Duck Level is applied. Choose from the
following:

+ All channels — all audio channels on the Program shall be adjusted by the Duck Level value
specified on the On Air Control > Voice Over interface.

+ Assigned channels only — Only the audio channels specified in the Source menu (step 5) shall
be adjusted by the Duck Level value specified on the On Air Control > Voice Over interface.

Voice Overs

The MC1-UHD enables flexible audio/voice over mixing with a variable program audio duck level,
audio over gain control, and preset mixing with transition control.When Voice Over or EAS is active,
all channels are mixed. If the source contains more audio channels that you want mixed, ensure to
use the Mute setting for those channels. The Voice Over source is selected using the Audio Over
Sources tab in the Configuration interface. A Voice Over can also be triggered using GPIs.

For More Information on...
+ setting up GPIs, refer to “Configuring the GPI/Tallies".

Setting the Voice Over Duck/Gain Level
You can adjust the duck and gain levels of the Voice Over channel.

X If both Voice Over and EAS audio is in effect, the MC1-UHD ducks the incoming audio twice. The
Voice Over duck/gain is set in the Voice Over tab of the On Air Control interface.

To set the duck/gain level

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

2. Select the Voice Over tab.

rs  SqueezeBack Effects Logo  External Keys Processing  Audio Shuffle  Save Audio Profile  Voice Over

Gain (dB)

3. Use the Duck Level slider to apply a negative gain (in dB) to the Voice Over channel.

4. Use the Gain slider to apply a gain (in dB) to the Voice Over channel.
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Including a Voice Over

The Voice Over feature is triggered on/off by pressing the AUDIO OVER button located on the On
Air Interface. Once the button is selected (button is lit), the voice over will remain active until the
button is selected again (button is unlit).

Audio Profiles

You can define up to four audio profiles. Each profile records the audio processing and shuffling
settings for all 16 embedded channels including:

+ which audio sources are re-mapped

+ gain to the input(s)

+ embedded audio source

* pass mode

* mute (enabled or disabled)

* which channels are inverted (or not)

* which channels are summed (or not)

Creating an Audio Profile

A profile captures all the audio settings, except the Voice Over or EAS settings, currently in use. Each
profile displays as a selectable button on the Audio Processing tab and Audio Shuffle tab of the
On Air Control interface.

To create an audio profile

1. Specify which audio group is embedded for output as outlined in “Identifying the Audio
Groups”.

2. Ifrequired, adjust the gain for your audio channels as outlined in “Audio Processing".

3. Select the Audio Profile Names tab in the Configuration interface.

Video Format  Audio Status ~ Alarm Enables ~ ANC  Transitions ~ Output Selection  Matte ~ GPITally ~ Remote Control ~ Router Control  CrosspointMap Audio Profile Names  DVE  Audio Over

Set Profile Name

4. Inthe Set Profile Name field for the audio profile:
a. Type a unique identifier for your profile.

b. Press Enter to save.
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This becomes the button label on the Audio Processing and Audio Shuffle tabs of the On Air
Control interface.

5. Repeat step 4 for each profile you wish to update.

Recalling an Audio Profile

Each of the four audio profiles are defined using the Configuration interface and capture the
settings specified in the Audio tabs of that interface. These profiles that can be recalled from the On
Air Control interface via the top row of buttons on the Audio Processing tab and Audio Shuffle tab
of the On Air Control interface.

X Recalling an audio profile does not affect the Voice Over or EAS settings.
To recall an audio profile
1. Configure the audio profile as outlined in “Creating an Audio Profile".

2. Onthe Preset bus, select the crosspoint button for the source you wish to take to air. The
button is now lit blue.

3. Select the Audio Shuffle tab to display the available profiles.

Audio Processing Audio Shuffle Save Audio Profile

Keyers SqueezeBack Effects

FactoryDefault

4. Locate the Load Profile area of the tab.

5. Select the button for the audio profile that you want to use during the next transition.

X The profile settings are used until another profile is loaded, or the user changes any of the
settings.

6. Select the TAKE button.

The selected crosspoint is taken to air and the corresponding button is lit in the Program bus.
The settings in the audio profile are applied only to this crosspoint during the transition.

7. To apply a different audio profile to the next transition, repeat steps 2 to 6.
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Media File Management

DashBoard enables you to select and configure the two Logo channels that are loaded in the
MC1-UHD. Each Logo channel has a sub-tab that enables you to assign a media file to the specified
logo, view a thumbnail that represents the media file currently loaded, and adjust on-air properties.
This chapter outlines how to select and configure the two Logo channels for the MC1-UHD.

Before You Begin

The following tips and restrictions apply when managing your media files:

+ Media files, such as stills and animations, are transferred to and from the MC1-UHD using FTP
protocol. The media files are stored on the Micro SD card that is installed on the MC1-UHD.

« When using Mac OS X™ to transfer files to the Micro SD card via an FTP server, you may only have
read-only access. Refer to your Mac OS X™ documentation for details.

+ Four logo channels are available on video modes up to 3G.
+ When using UHD video, two logo channels are available.

Managing your Media Files

The MC1-UHD features two Logo channels (Logo 1, 2) into which you can load files from the Micro
SD card physically installed on the Micro SD card. Each MC1-UHD has up to 2GB of DDR playout

memory’.

Table 19 lists an estimation of how many uncompressed frames can fit into the playout memory of
the MC1-UHD.

X Very large animations may take several minutes to load.
Table 19 Full Frame Animation

Format Image Size No Alpha With Alpha
1080i 1920x1080 386 256
1080p 1920x1080 386 256
720p 1280x720 870 579

PAL 720x576 2882 1921
NTSC 720x486 3416 2277

Media files, such as animations and still images, can be transferred to and from the Micro SD card
using an FTP connection. Once transferred to the Micro SD card, you use the options in the Logo tab
to load the files and assign them to a Logo channel.

This section outlines the specifications for media files and provides general information on using
the Micro SD card and an FTP connection.

For More Information on...
+ assigning media files to Logo channels, refer to “Loading a Media File".

1. The MC1-UHD has 1.5GB of DDR playout memory when the MC1-UHD-DVE-1CH-LICENSE license is enabled.
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Image Specifications

Media files used on the MC1-UHD must meet the specifications outlined in Table 20. Note that if
larger images are used, the images will be clipped to the dimensions listed in Table 20.

Table 20 Image Specifications

Parameter Specification
Supported File Types BMP, GIF, JPEG, PNG, TGA
Compression Compressed and uncompressed
Max. Image Width (all formats) 65,536 pixels
Max. Image Height (all formats) Dependent on available memory
Animation Maximum Length 10,000 frames

File Naming Specifications
Keep the following in mind when naming your media files:

+ The name can contain letters, numbers, and spaces, but cannot contain symbols such as! @ # &
* ( ) ? / , 1 u'

+ If you are naming an animation, each file must be numbered in the sequence that it will play out.
The following restrictions apply to file names for animations:

» Each file can use a minimum 3-digit number, including all the leading zeros.

> The file name and number must be separated by an _ followed by 3 or more digits, then a
period (.).

» Each file in the sequence must have the same numbering scheme.
> The MC1-UHD loads files in numerical order.

The following is an example of a 10-frame animation using a typical numbering scheme:

DTVB_000. tga
DTVB_001.tga

DTVB_009. tga

Loading a Media File

When a media file is loaded, data, such as X/Y position, is also loaded, if it exists. Otherwise, the last
used values are retained. For animations, parameters are recalled after the last frame is loaded.

To load a media file into a Logo channel

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

2. Select the Logo tab.
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Select the sub-tab for the Logo channel you want to load the media file for.

4. |If files were added or re-named using an FTP connection, click Rescan to update the list of
directories and filenames in the tab menus.

5. From the Directory menu, select the directory you wish to load a file from. Choose from the
following:

+ [RAM CACHE] — A virtual directory that displays media files that are already loaded in the
play-out memory. Selecting this directory enables you to quickly access a pre-loaded file from
the memory.

+ [ROOT] — This is the default directory and represents the top-most directory on the Micro SD
card. You can manage files on the Micro SD card using an FTP connection.

6. From the Filename menu, select the file.

X You can clear space in the image cache by selecting None from the Filename menu of any Logo
channel. However, doing so immediately replaces the current media file with the file you are
attempting to load.

* Use the [RAM CACHE] > Clear button to remove all the items in the RAM cache directory that are
not currently used (on air) by any of the logo channels.

Adjusting On-Air Properties

The Logo tab in DashBoard allows you to adjust the position and play modes of media files.
Parameters that are adjusted are saved with the image/animation. When a logo/animation is
subsequently re-loaded, these parameters are also recalled. However, if there are no saved
parameters for a recalled logo/animation, then the last used values are retained.

To adjust the on-air properties of a media file
1. Load a media file as outlined in “To load a media file into a Logo channel”.

2. Adjust the position of a still image in the viewing area of the screen using the X and Y Position
sliders.

X Full images cannot have their position adjusted.

3. Usethe Auto Play box to set whether the animation automatically starts to play when it is taken
on-air.

When this feature is enabled, the animation will play from the first frame when it is brought to
air.
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4. Use the Looping box to set whether the animation will start over when it reaches the last frame
of the animation.

+ When this feature is enabled, the animation plays continuously (from the last frame back to
the first) in an endless loop.

« When this feature is disabled, the animation plays once, and freezes on the last frame. The
animation will stay fixed on the first frame.

* When both Auto Play and Looping are enabled, the animation begins to play on a transition, and
keeps playing in an endless loop. If another transition is triggered, the animation jumps to the
first frame and keeps playing in an endless loop.

5. Use the Hold Time menu to add a pause between loops of an animation.

* When this feature is enabled, the animation will play, but before looping back (if looping is
enabled), it pauses on the last frame, for the specified Hold Time (in number of frames).

6. Select how animage is displayed by selecting an option from the Play Mode menu.

X The Play Mode feature only applies to Interlaced video formats and has no effect when using
Progressive video formats.

Connection using FTP

You can use an FTP connection to transfer media files to and from the Micro SD card of the
MC1-UHD. You can also use an FTP client to delete images on the Micro SD card and re-name
images.

X Before proceeding, verify your FTP settings on the MC1-UHD. Refer to “Enabling FTP(S)" for
details.

Before accessing the MC1-UHD via FTP:

1. Ensure the MC1-UHD link status is valid. This information is reported in the Global > Network >
Link Status field in DashBoard.

2. The default login credentials are:

* User Name — user
+ Password — password

Connection using RossLinq

RossLing enables you to transfer still images directly from the XPression to a MC1-UHD Logo
channel. You can transfer files into any of the directories for any of the Logo channels on the card.
There are two directories, each corresponding to a specific Logo channel on the card. The file can be
a format as listed in Table 20. Note that the transfer of animations is not supported at this time.

X Before proceeding, verify your FTP settings on the MC1-UHD. Refer to “Enabling FTP(S)" for
details.

To connect to the XPression via RossLing, establish an FTP connection using the following
information:
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X The RossLing channel in XPression must be set as a passive FTP connection in order to set up
communications between XPression and the MC1-UHD. Refer to the XPression documentation
for details.

+ IP Address — This information is displayed in the Global > Network > Current IP Address field
in DashBoard.

* User Name — xpression
+ Password — password

X The images loaded via RossLing are not retained after reboot of the MC1-UHD.

For More Information on...
+ using XPression, refer to the XPression User Guide.

Using the Micro SD Card

The following tips and restrictions apply when using the Micro SD card:

+ the MC1-UHD must be powered down to install or remove the Micro SD card

+ if you must remove the Micro SD card for programming, re-boot the MC1-UHD when you
re-install the Micro SD card. This allows the MC1-UHD to recognize that a new card is available.

+ the Micro SD card Status field in the On Air Control > Logo > Logo # tab reports how much space
is available on the Micro SD card.
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Keying

Keying is the term used to described the inserting (or electronically cutting) portions of one video

source on to another (for example placing titles over background images). Keys are made up of two
components: an alpha (that cuts the hole in the background video), and a fill (that fills the hole with
different video). This chapter summarizes the MC1-UHD keying features and configuration options.

Overview

The MC1-UHD includes four high quality video keyers. In addition to the external Key Video and Key
Alpha source, there are also two internal static/animation play-out channels. This enables the
keying of external devices such as character generators or graphic systems into a program feed
and/or keying with two internal logo channels.

The MC1-UHD offers full key control with shaped and unshaped keying, self key or auto key, with
clip and gain control.
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Figure 24 MC1-UHD — Keyer Controls
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1) Keyers Tab 3) Program Keyer Select Buttons
2) Logos Tab 4) Preset Keyer Select Buttons

1. Keyers Tab

Each keyer has a sub-tab that enables you to select video sources, key types, and adjust
transparency, clip, and gain. The MC1-UHD supports Auto Select and Self keys. The External
sub-tab enables you to specify the router source that feeds input on the KEY VIDEO Input or KEY
ALPHA Input used as the External source when configuring keyers.

2. Logos Tab

Each logo channel has a sub-tab in the Logos tab that enables you to specify the media files the
channel uses.

3. Program Keyer Select Buttons

When lit red, a button indicates that specific keyer is currently on-air on the Program bus.
Selecting a button will immediately perform cuts on that keyer.
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4. Preset Keyer Select Buttons

These buttons are used to choose which keyer is included in the next transition. Note that
depending on a Personality tab setting, once a transition is performed, the buttons are no longer
lit.

Key Types
The MC1-UHD supports the following key types.

Auto Select

An Auto Select Key uses two video signals: the Key Alpha is used to cut the hole in the video, and the
Key Video is used to fill the hole. For external keying, use the Configuration > External Key options
to configure the two external keys. For internal sources, the Key Video and Alpha are generated
internally. Note that the Key Alpha Type is automatically set to Shaped.

Self

A Self Key uses only one video signal: the luminance (or brightness) of the Key Video is used as the
Key Alpha. For external keying, use the On Air Control > External Keys options to configure the two
external keys. For internal sources, the Key Video is internally supplied. Note that the Key Alpha
Type is automatically set to Unshaped.

Key Alpha Types
You can specify a key alpha as one of the following types. The default key type is Shaped.

Unshaped (multiplicative keying)

With an Unshaped Key, the Key Alpha luminance value mixes linearly the Key Video with the
Background. Shades of gray, in the Key Alpha, are translated into transparency levels, giving the key
a soft edge. Self Keys are set to Unshaped by default.

Shaped (additive keying)

With a Shaped Key, the Key Alpha cuts a hole in the Background based on the luminance value of
the Key Alpha and adds the Key Video to the Background hole. Shaped Key alphas are sometimes
used with Character Generators to cut very precise holes for the Key Video fill. Auto Select keys are
set to Shaped by default.

Mapping the External Keys

Each of the two external keys can have an independent input source assigned. The External Key can
then be used over top of the PGM input for each Keyer.

To map an external key

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

2. Select the External Keys tab.
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Home Keyers SqueezeBack Effects Logo External Keys  Audio Processing Audio Shuffle Save Audio Profile  Voice Over

External Key 1

External Key 2

Locate the row for the External Key you wish to map.
4. Select an input crosspoint (the key video and, optionally, the key alpha source) from the row.

Repeat steps 3 and 4 for the second External Key.

Configuring a Key

You can assign any of the logo channels as the source for a keyer. The MC1-UHD offers full key
control with shaped and unshaped keying, self key or auto key, with clip and gain control.

To configure a key

1. Ensure that you set up the logo channel(s) as outlined in “Media File Management"”.

2. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

Select the Keyers tab.
4. Select the sub-tab for the Key you wish to configure.
To assign a source to a key:
a. Locate the Keyer Source area of the tab.
b. Select a button from the Keyer Source area to assign that source to the Key.

In the following example, the user assigned Logo 2 as the source for Key 3.

Home Keyers SqueezeBack Effects Logo External Keys  Audio Processing Audio Shuffle Save Audio Profile  Voice Over

Key1 Key2 Key3 Key4

Transpare 0.0% Clip: 960 Gain: 50 0%
Default

Make Linear

Keyer Source
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6. Setthe Key Type by toggling the Key Type button.

+ Auto Select— A Key which uses two video signals (Alpha and Fill); the Key Alpha Type is
automatically set to Shaped. If you configure an internal Logo channel as Auto Select, the
associated alpha signal is used.

+ Self — A Key that uses the luminance values of the KEY VIDEO source for the alpha; the Key
Alpha Type is automatically set to Unshaped. If you configure an internal Logo channel as
Self, the luminance value of the associated alpha is used.

7. Use the Transparency slider to adjust the transparency level of the key.

+ 0 — The key is completely opaque; there is no difference between the original key and the
key with the transparency effect applied to it.

+ 100 — The key is completely transparent; the key is not visible on the screen.
8. Use the Clip slider to set the threshold level between what is keyed (visible) and what is not.

9. Use the Gain slider to set the range of softness around the Clip threshold, which defines the
transparency of the key. For shaped keys, the clip and gain should be left at their default values.

X To reset the Clip and Gain values, click Make Linear.

10. Use the Key Alpha Type menu to specify the Key Alpha type. Refer to “Key Types” for more
information on each type.

11. Click Key Invert to On to reverse the polarity of the key alpha so that the holes in the
background are cut by dark areas of the key alpha instead of bright areas.
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Mattes

This chapter outlines how to set up a matte color and assign a matte generator to an external key.

Overview

Mattes are solid color signals that can be applied to backgrounds and keys. A matte has only one
color but can be applied to a key or to the PGM/PST buses.

Setting up a Matte Color

Color selection is done by adjusting the luma, and two color difference signals (Cr and Cb) to create
a desired color. The matte is a full raster signal.

To set up a matte color

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Matte tab.

Video Format  Program Fail-over ~ Audio Status  Alarm Enables ~ ANC  Transitions  Output Selection  Matte  GPUTally ~ Remote Control  Router Control  CrosspointMap  Audio Profile Names ~ DVE  Audio Over

Matte1  Matte 2

Select the sub-tab for the matte generator you want to configure.
Use the Luma slider to adjust the luminance of your matte color.
Use the Cr slider to adjust the red difference signal of your matte color.

Use the Cb slider to adjust the blue difference signal of your matte color.

N o v oA~ W

Repeat steps 3 to 6 for the second matte generator if required.
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Transitions

This chapter outlines how to specify the post transition behavior, configure the TAKE button, set a
transition rate, and perform basic transitions.

Before You Begin

Keep the following in mind when performing transitions:

+ To allow for audio cross fading, a cut takes two frames. One frame is used for the audio fade
down, the video is then cut, followed by the one frame audio fade up.

+ The speed at which the transition is performed, in number of frames, is determined by the
setting (Slow, Medium, or Fast) in the Transition Rate area.

+ If a crosspoint or transition button is selected while a transition is in progress, the original
transition continues as subsequent button presses are ignored (except the FTB button).

+ When you are performing a transition, or keying, the embedded audio is carried in the ancillary
data of the background video signal. The ancillary data from the background source is replaced
with the ancillary data from the preset source, and the ancillary data for keyed sources is
stripped.

Overview

Transitions are used to change the background video and take keys on and off-air. A transition can
include any combination of Background video, keys, and audio. The BKGD A (Program) and BKGD B
(Preset) inputs allows for background dissolves and V-Fades behind the external key source.

GPIO Control

Logo

(=]
Control 5

Effect 1 - ATMN
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0

eyers
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Figure 25 MC1-UHD — Transition Buttons
1) Cut Button 4) Cross-Fade Button 7) Transition Speed Buttons
2) V-Fade Button 5) Fade-Cut Button 8) Transition Include Buttons
3) Cut-Fade Button 6) SqueezeBack Button 9) TAKE Button

1. Cut Button

Select this button to perform a cut transition from one source to the next.
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2. V-Fade Button

Select this button to perform a V-Fade transition from the Program source to Black to the next
source.

3. Cut-Fade Button
Select this button to perform a cut to black, then fade up to the next source.
4. Cross-Fade Button

Select this button to perform a gradual fade from one source to the next. Note that this button is
selected after performing a factory default reset.

5. Fade-Cut Button
Select this button to fade from one source to black and then cut to the next source.
6. SqueezeBack Button

Select this button to perform a SqueezeBack effect by reducing the size of the video over time to
the dimensions set in the Squeeze Effects tab. You may change your background or keys on-air
with this transition type. The MC1-UHD-DVE-1CH-LICENSE is required.

7. Transition Speed Buttons

These buttons apply the rate (slow, medium, fast) to the next transition. The transition rates are
specified in the Home tab. Note that the Slow button is selected after performing a factory
default reset.

If you are controlling the MC1-UHD via Automation, and these buttons are not lit, the transition
rate applied is set by the Automation command. If you wish to apply one of these rates,
remember to select the required transition speed button before performing a transition (e.g.
selecting TAKE).

8. Transition Include Buttons
This area displays the following buttons:

> The BKGD button is used to add, or remove, the BKGD from the next transition. Toggling this
button will immediately affect the Background video that is visible on the Preset output.

> The SQUEEZE button is used to add or remove, the selected squeeze effect preset from the
next transition. Toggling this button will immediately affect the video that is visible on the
Preset output. You may not de-select this button if a squeeze effect is on-air. This can be done
with a Squeeze transition to perform a SqueezeBack, or as part of another transition (Take,
Mix, Fade-Fade).

9. TAKE Button

Selecting the TAKE button performs the transition between the sources and effects selected in
the Program and Preset buses, using the specified Transition Type and Transition Speed. The
button is labeled TAKE NEXT when Automation is configured and enabled (the ATMN button is
toggled ON), and the Take Button on Panel setting is set to Take Next.

Configuring the Transition Buttons

The Configuration interface in DashBoard enables you to specify how the TAKE button, in the On Air
Control tab, behaves when toggled during a transition.

For More Information on...
+ the GPI Overrides TAKE feature, refer to “Enabling GPIs to Override Take Transitions".
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To configure the TAKE button

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Transitions tab.

3. Configure the TAKE button behavior by choosing an option from the Take During Transition
Action area. Choose from the following:

X The selected behavior also applies to GPIOs.

+ Ignore — Select this option to disregard any successive presses of the TAKE button until the
transition is complete. This is the default setting.

+ Pause — Select this option to pause the transition when the TAKE button is toggled, and
resume the transition when the button is pressed again.

+ Reverse — Select this option to reverse the transition back to the start.

4. Select the Cut on Clean Feed option to automatically perform a cut transition from one Clean
Feed source to the next.

Specifying a Transition Rate

You can independently define the Fade to Black, Slow, Medium, and Fast transition rates, in number
of frames.

To set a transition rate

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

Mc1 Master E
Control E

Effect 1 -

2. Specify the rate, in number of frames, as required in the Slow Rate, Medium Rate, and Fast
Rate fields.

3. Use the FTB Rate field to specify the Fade to Black transition rate.

Auto Swapping of Program and Preset Buses

You can choose to have the Program and Preset bus flip-flop after a transition (default setting), or
have the Preset bus unchanged after a transition.
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To swap the buses after a transition

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Transitions tab.
3. Choose one the following Post Transition Behavior options:

+ Leave Preset As Is — The Preset bus is unchanged after a transition. Preset keyers follow
Program keyers on hot-punches.

« Swap Program/Preset — The selections for the Program and Preset swap. This is the default.
+ Preset Off — The keyers on the Preset bus will be turned off automatically after a transition.

Resetting the Audio Gain Level After a TAKE Transition

The Reset Audio Gain option enables you to specify the audio gain level is reset, to the factory
default value of 0dB during TAKE transitions. When enabled, this option ramps the audio gain level
to the default level as the Preview bus is transitioned. When disabled, this option keeps the audio
gain level at the current level after the transition completes (the audio gain is not adjusted).

To reset the audio gain level after a TAKE transition

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Transitions tab.

3. Select the Reset Audio Gain box to reset the audio gain level after a transition.

Performing Transitions

You can perform transitions in one of the following manners:

+ hot-punching a crosspoint on the Program or Preset bus
+ selecting a Keyer button from the Keyer area to transition a keyer on/off air
+ using the options in the Transition area to add elements to the transition

The speed at which the transition is performed, in number of frames, is determined by the
Transition Rate (Slow, Medium or Fast) set in the Home > Transition Rate menus.

For More Information on...
+ the transition area and buttons of the On Air Control interface, refer to “Control Panel".

To perform a Cut transition on the Program bus

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

2. Select a button on the Program bus.
To perform a Cut transition for a Key

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

2. Select a source for the Program output from the desired Key Source menu.

3. click [T

4. Click TAKE.

The Key is transitioned on or off air.
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The Key Status field(s) indicates the on-air status of the key.
To perform a Take transition

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

Select the Key 1-4 buttons to add the required corresponding keyer(s).
Select a Transition Speed button (Slow, Medium, or Fast).

Select a Transition Type button.

Click TAKE.

LA

Performing a Fade to Black

The FTB button performs a fade to black where the:

« Program bus is faded to black at the FTB rate,
+ audio fades to silence, and
+ closed captioning information is not passed.

The Fade to Black rate is set in the Home tab as outlined above. When the FTB button is selected,
the MC1-UHD performs an Auto transition to black.

X If the FTB button is grayed out, the Configuration > Transitions> FTB Disabling > FTB Button
option is set to FTB Disabled.

To perform a fade to black

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

2. Toggle the FTB button as follows:

+ When the button is lit red, clicking it performs an Auto transition to black. The rate is
determined by the rate set in the Home > FTB Rate menu.

+ When the button is not lit red, clicking it performs an Auto transition from black. The rate is
determined by the rate set in the Home > FTB Rate menu.

Automation Switch Request

When the MC1-UHD interfaces with an Automation System via the Presmaster protocol, you can
choose how the MC1-UHD defines automation switch requests. This feature applies to the Program
bus, Preset bus, and external sources. Ensure the ATMN button is toggled to ON to enable your
automation device to control the MC1-UHD. This button is located on the On Air Control interface.

For More Information on...

+ setting up communications via the Presmaster protocol, refer to “Using the Presmaster
Protocol".

To define the automation switch requests

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Remote Control tab.
Locate the Presmaster area of the tab.
4. Click Device Setup.

The Presmaster control dialog opens.
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5. From the Automation Switch Request area, select how a crosspoint switch is defined:

* Router Crosspoint — The received value refers to a physical or virtual router crosspoint. This
is the default setting.

« Button Number — The received value refers to a specific MC1-UHD crosspoint button on the
DashBoard control panel. Note that these crosspoint buttons are defined in the Crosspoint
Map tab.
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SqueezeBack Effects

The MC1-UHD can be used to perform on-air 2D DVE (SqueezeBack) transitions to reveal another
video source or graphic. You can also transition to pre-squeezed effects with standard transitions,
squeeze in any direction on either X or Y axis, or both. Four DVE presets are provided for quick
effect recalls on the fly. This chapter outlines the DVE feature and SqueezeBack Effects options of
the MC1-UHD.

* The MC1-UHD-DVE-1CH-LICENSE is required.

SqueezeBack Effects Controls

This section briefly outlines the elements of the On Air Control interface for the SqueezeBack Effects
feature.

For More Information on...
+ the DVE tab in the Configuration interface, refer to “DVE Tab".

Audio Processing Audio Shuffle

Home. Keyers. Squeezet

Effect? Effect3 Effectd

Figure 26 MC1-UHD — SqueezeBack Effects Controls Buttons

1) SqueezeBack Effects Tab 3) SqueezeBack Effect Transition Type Button
2) Effect Select Area 4) SQUEEZE Button

1. SqueezeBack Effects Tab

The SqueezeBack Effects tab provides a sub-tab for each of the four SqueezeBack presets,
enabling you to customize each effect separately. From these sub-tabs you can specify the
horizontal and vertical positions of the image on the screen, and the reveal source from the four
logo channels or an external video source. Because the reveal source shares the same sources
available to the keyers, we encourage users to avoid sharing a source between keyer and reveal
operation.

2. Effect Select Area

This area includes the Effect # status field and an EFFECT SELECT button. The status field reports
the last applied effect and whether it is on or off air, or currently on the Preset Bus.

While the squeeze effect is on air:
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» the EFFECT SELECT button is locked. Even though you can still adjust the options in the
SqueezeBack Effects tabs, we suggest not doing so since all effect changes are immediately
applied.

» you are able to change the background with a transition and you can hot-punch a source or
key on the Program bus. However, hot-punching a source on the Program bus will take the
squeeze effect off air. Hot-punching keys on/off will not take the squeeze effect off air.

> you can perform any hot-punch or TAKE transition inside of the squeeze effect.
3. SqueezeBack Effect Transition Type Button

Selecting this button performs a SqueezeBack effect with the transition. You must pre-configure
your SqueezeBack presets, then select the preset you want to apply to the transition before
executing your transition. Refer to “Transitions” for details.

4. SQUEEZE Button

Selecting this button applies the squeeze effect (as specified using the EFFECT SELECT button) to
the next transition.

The SQUEEZE Include button is selected (lit) and locked out as long as the transition type is
Squeeze. The SQUEEZE Include button is not unlocked until you select another transition type, at
which time the previous state of SQUEEZE Include button is restored.

You can de-select the SQUEEZE Include button while an effect is on air to perform a transition
inside the squeeze effect.

Working in 2D Space

In order to maximize the features of the SqueezeBack feature, it helps to have a basic
understanding of two-dimensional (2D) space. Two axes (X and Y) are used to define 2D space. The
position of an image on each of the two axes determines its location in 2D space.

« X — Refers to the horizontal (left-right) position of the image on the screen.
+ Y — Refers to the vertical (up-down) position of the image on the screen.
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Figure 27 Basics of 2D Space

Image Position in 2D Space

The center point of the screen is the center (zero) point. Each axis has a positive and negative
region.

+ Moving an image to the left of the center (or zero) point locates it in -X space.
+ Moving an image to the right of the center locates it in +X space.

+ Moving an image below the center point locates it in +Y space.

+ Moving an image above the center point locates it in -Y space.
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When working with images, keep in mind that the 2D space extends beyond the visible area of the
screen. Images can be positioned and manipulated outside of the viewable area to create some
interesting effects. For example, and image can be positioned in such a way that it appears to roll
into view from a point outside the screen and roll out of view on the other side.

Configuring the DVE Transition Options

The MC1-UHD can be used to perform on-air SqueezeBack transitions to reveal another video
source or graphic. If

you wish to include a SqueezeBack with your transitions, you must first specify the key order using
the DVE located in the Configuration interface.

Specifying the Key Order

You can select the SqueezeBack point in the mixer tree. There are five possible options. This setting
is applied to all SqueezeBacks.

To specify the key order of the SqueezeBacks

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the DVE tab.
Locate the Included in SqueezeBack area.
4. Specify the key order by selecting one of the following:

+ Background Only — includes only the background in the SqueezeBack effect. This is the
default.

+ After Key 1 — Key 1 is included in the squeeze effect. Keys 2 to 4 are excluded.

+ After Key 2 — Keys 1 and 2 are included in the squeeze effect. Keys 3 to 4 are excluded.
+ After Key 3 — Keys 1 to 3 are included in the squeeze effect. Key 4 is excluded.

+ After Key 4 — All keys are included in the squeeze effect.

5. Use the Background in Fade options to specify the reveal source during a V-fade type
transition inside an already squeezed image on the PGM bus. Choose from the following:

+ Background —allows the reveal source background to pass through.
+ Black — allows the reveal source background to fade to complete black.

Configuring a SqueezeBack Preset

This section outlines how to configure Preset Effect 1 in preparation of including it in a transition.
The same procedure can be used to configure any of the effect presets for your MC1-UHD.

For More Information on...
+ the menu options when configuring your SqueezeBack presets, refer to Table 56.

To configure an effect

1. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

2. Select the SqueezeBack Effects tab.
Select the Effect 1 tab to configure the first effect.

4, To specify the position of the image in the viewing area of the screen:

MC1-UHD User Guide (v8-rev3) SqueezeBack Effects * 127



a. Use the X Position slider to adjust the horizontal position of the image on the screen.
b. Use the Y Position slider to adjust the vertical position of the image on the screen.
5. Tosqueeze the image appearance:
a. Use the X Size slider to squeeze horizontally.
b. Use the Y Size slider to squeeze vertically.
6. Select the Lock Aspect Ratio check box to squeeze in both directions at the same time.
X You can reset the image to the default image settings by clicking Reset to Defaults.

7. Inthe Reveal Source area, select the video source the squeeze effect will reveal.

Performing Transitions with SqueezeBack Presets

This section provides examples of performing transitions with SqueezeBack Presets. Your
requirements may differ from what is presented here.

Notes on Performing Transitions with SqueezeBack Presets
Keep the following in mind when performing transitions with SqueezeBack presets:

* You can pre-define up to four different SqueezeBack Presets (Effects 1-4)

+ Asqueeze effect does not consume any existing keyers and you can specify any of the logo
channels to use as a reveal source for that effect.

+ Hot-punches on the Program bus can be performed within an on air squeeze effect. The
hot-punch is carried out inside of the squeeze effect. The squeeze effect remains on air.

+ Squeeze effect transitions are also supported under the Presmaster automation protocol.
* You can also trigger a squeeze effect using a GPI trigger.

* You can configure a tally to raise when the reveal source is visible. This tally will be raised
regardless of the configured source. This can be used in cases when a graphics station is
providing the video and needs to know when to trigger the playing of an animation.

+ Selecting the Constrain to Screen box in the SqueezeBack Effects tab will enable "snap-back" on
the X, Y position controls to ensure the squeezed image remains entirely on screen.

Previewing a Squeeze Effect

You can preview your Effect preset on the Preview monitor without affecting the Program bus.
However, any time a squeeze effect is on air, the preview output is not scaled correctly.

To preview a squeeze effect
1. Set up your effect as outlined in “To configure an effect"”.

2. Display the On Air Control interface as outlined in “To display the On Air Control interface in
DashBoard".

Use the EFFECT SELECT button to specify the desired squeeze effect for the transition.
4., Select the SQUEEZE button.

Transitions with SqueezeBack

This section provides examples of executing transitions that include SqueezeBack Preset.
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Basic Transition with a Squeeze Effect

Operation: This is a SqueezeBack transition.

1. Set up your effect using the tabs in the SqueezeBack Effects tab as outlined in “Performing
Transitions with SqueezeBack Presets".

2. Use the EFFECT SELECT button to specify the desired squeeze effect for the transition. This is
the effect that you configured in step 1.

3. Click

EIS

in the Transition Type area.

The Effect # status field now indicates on psT. You can preview the squeeze dimensions on your
Preview monitor.

4. Select the SQUEEZE button.

Select TAKE.

Dissolve to a Static Squeeze Effect

Prerequisite: You have a pre-squeezed effect ready on Preview.

Description: When you select TAKE, the Program dissolves to the pre-squeezed effect. After you
have set up the transition, and during the transition, the Preview monitor is scaled correctly.

Operation:

1. Select the EFFECT SELECT button to specify the desired squeeze effect for the transition.

2. Select a dissolve transition type (Fade-Fade, Take-Fade).
Ensure the SQUEEZE button is selected.

The Preview monitor shows the squeeze effect.
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Ancillary Data

Ancillary Data (ANC) is the non-video data that can be embedded within the SDI signal, such as
audio, audio metadata, timecode, closed caption data, AFD, and payload identification. This chapter
provides an overview of ANC support on the MC1-UHD.

Supported Data Types

This section provides information on the data types that the MC1-UHD manages.

Compressed Audio Metadata
Compressed Audio Metadata can be passed or deleted as follows:

+ Ifthe input is not synchronous to the output, select Action > Delete in the ANC Settings sub-tab.

+ If converting between progressive and interlaced formats, select Action > Delete in the ANC
Settings sub-tab.

+ Ifthe inputis not synchronous to the output, data will be dropped (but not duplicated') as part of
the frame sync behavior.

Other Packets

All remaining packets can be passed or disabled. When pass is enabled, the packets will be inserted
in VANC on the specified line in the same order as they were received. If they do not fit on the
specified line, they will continue on the next line. Approximately up to 250 packets, or 1500 bytes of
data, can be passed this way.

Specific ANC Processing

Use the options in the ANC tab to define how ancillary data is inserted in the output when HANC
and/or VANC pass through is disabled. For each packet type the user can control the insertion
position.

X If the ANC Pass-through box is selected, the MC1-UHD passes all upstream ANC data with no
modifications. The ANC Delete/Pass, Insertion Line, and Insertion Order settings are ignored.
Refer to Table 35 for more information.

To configure the processing of specific ANC types

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the ANC tab.
The ANC sub-tab is automatically selected.

3. For each packet, specify how the card processes the ANC data by selecting an option from the
Action area.

4. Use the Insertion Line menu to select a line to insert the specified ANC packet on. The default
is 12 for each packet. Note that all packets are inserted in VANC, except for timecode in non-SD
formats which are inserted in the HANC.

X |f more than one packet is to be inserted in the same line, the packet with the lowest insertion
order number will be inserted first.

5. Use the Insertion Order menu to define the hierarchy of the packets insertion.
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X The lower the number, the higher priority the packet is given. For example, by default, the AFD
packet is set to be inserted first (5), and Compressed Audio Metadata is inserted fourth (4).

6. If the Output Format is set to 480i 59.94Hz, use the Line 21 Caption Pass-through option to
specify to pass closed-captioning or other data, through unaltered on Line 21.

X The Line 21 Caption Pass-through option should only be used when ancillary data is present on
Line 21.

Monitoring the Encoding and Decoding of ANC Data

The MC1-UHD provides the ability to monitor the encoding or decoding of ANC data on SDI signals.
To verify that the MC1-UHD is decoding ANC data

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select ANC > Decode.
Select the sub-tab for the SDI port you want to monitor.

4. Select the Alarm Enable box for an ANC Data type to enable an alarm condition to display
when an error is detected.

To verify the MC1-UHD is encoding ANC data

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select ANC > Encode.
Select the sub-tab for the SDI port you want to monitor.

4. Select the Alarm Enable box for an ANC Data type to enable an alarm condition to display
when an error is detected.
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Configuring the GPI/Tallies

This chapter outlines how to configure each GPI/Tally independently on the MC1-UHD.

GPI Communication Setup

When configured as a GPI, a port behaves as an input, and can be used to trigger actions such as
Cut/Dissolve the Key and/or Background. A push-button switch, or an ON-OFF switch, may be
directly connected between the port and the adjacent ground pin. Alternatively, an external device
may drive a low level. Minimum pulse duration is 1ms, anything shorter will be filtered out.

Typically, users will configure the GPI for Edge trigger. This means that the action is carried out
either on the falling edge (button is pushed), or rising edge (button is released), depending on which
Polarity is selected. Alternatively, users may configure the GPI for Level trigger. In this mode, the
action is carried out on both the rising and falling edges, so there are effectively two states. The
Polarity control can be used to invert the behavior. For all trigger types, GPI commands may be
overridden by other command inputs such as serial protocols.

* RossTalk GPI commands will trigger functions assigned in the GPI setup.

The Edge option enables the GPI to act as a latching trigger. Edge triggers are used when you want
to toggle between settings. This option enables the GPI to execute a specific function.

+ If configured for Falling Edge, the selected function is executed when the GPI input signal
transitions from High to Low.

+ If configured for Rising Edge, the selected function is executed when the GPI input signal
transitions from Low to High.

+ Edge triggered GPI signals are sampled once per frame and the associated function is executed
only once per frame. The minimum pulse width is 1 millisecond.

+ Typically, the edge triggered GPI is driven by external equipment that generates one pulse per
event.

Level triggers are used when you want to assert a particular state for a setting. You define the
on-air state of the function as being either Level High or Level Low. Therefore, if the on-air state of
the Key is defined as Level High for example, when the GPl is a Level High signal, the Key will stay on
air. If a Level Low is received, the Key will be taken off air.

+ If configured for Active Low, the selected function is executed when the GPI input signal is driven
Low.

+ If configured for Active High, the selected function is executed when the GPI input signal is driven
High.

Configuring a Port as a GPI

Each GPI can be configured independently from the others, allowing you to customize the function
of each connection.

X The number of available GPIO ports depends on the rear module you are using. The R3B-GATOR
(8322AR-318D) and R3A-GATOR (8322AR-319C) each provide 6 GPIO ports. The R4-GATOR
(8323AR-325) provides 4 GPIO ports.

To configure a port as a GPI

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the GPI/Tally tab.
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Video Format  Program Fail-over  Audio Status ~ Alarm Enables ~ ANC  Transitions  Output Selection ~ Matte ~ GPUTally ~ Remote Control  Router Control  CrosspointMap  Audio Profile Names

Trigger/Tally Type

GPITally 4

GPITally ~ VGPI

Use the Function menu to assign a transition event to a specific GPI port.
4. Use the Trigger/Tally Type menu to select a trigger and polarity for the GPI.

If the Trigger/Tally Type is set to Falling or Rising, use the Output Pulse Width menu to
specify the number of frames the pulse will be for an edge trigger.

6. If the Function is set to GPI PGM XPT, use the Crosspoint Number field to specify the
crosspoint on the MC1-UHD that will trigger the GPI.

The crosspoint number can be either a router source or a button number, as determined by the
Remote Control > Device Setup > Switch Request setting.

7. Use the Manual Override and Level options in conjunction to override a GPI. This allows a GPI
to be manually triggered from the menu and is useful for testing GPI function.

a. Select the Manual Override box for a GPI/Tally.
b. Toggle the Level button.

Tally Communication Setup

When configured as a Tally, a port becomes an output, providing a status indicator. Typically this is
used to indicate which input(s) are on-air at any given moment. Each tally output on the card can be
configured to be active when any of the six inputs are on air. They can be configured as Active High
or Active Low. Edge triggered tallies generate a pulse to the configure polarity (high or low) for a
duration of 30 frames or the duration of the event (whichever is shorter). The tally outputs defaults
to a logical high level when inactive. When the tally becomes active, for example the signal is on-air,
then the output is driven low.

X The number of available GPIO ports depends on the rear module you are using. The R3B-GATOR
(8322AR-318D) and R3A-GATOR (8322AR-319C) each provide 6 GPIO ports. The R4-GATOR
(8323AR-325) provides 4 GPIO ports.

To configure a port as a tally

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the GPI/Tally tab.

3. Use the Function menu to specify what will drive the tally output when the input is on-air.
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4. |If the Function is set to Tally PGM XPT, use the Crosspoint Number field to specify the
crosspoint on the MC1-UHD that will trigger the tally.

The crosspoint number can be either a router source or a button number, as determined by the
Remote Control > Device Setup > Switch Request setting.

5. Use the Trigger/Tally Type menu to select the polarity of the tally.

6. Ifthe Trigger/Tally Type is set to Falling or Rising, use the Output Pulse Width menu to
specify the number of frames the pulse will be for an edge trigger.

7. Use the Manual Override and Level options in conjunction to override a tally. This allows a
tally to be manually triggered from the menu and is useful for testing tally function.

a. Select the Manual Override box for a GPI/Tally.
b. Toggle the Level button.

Enabling GPI/Tally Logging

The MC1-UHD can provide a log of commands received from downstream devices via the GPI/Tally
ports. You can specify the type of events to monitor. Events are listed in a hierarchical order based
on the selected severity including internal errors and unrecognized or invalid responses from the
GPI/Tally port, failed communications between the MC1-UHD (such as time outs) and the device
connected to the GPI/Tally port. This is intended for troubleshooting incompatibilities between the
MC1-UHD and downstream devices.

To configure the GPI/Tally logging feature

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the GPI/Tally tab.
3. Use the GPI/Tally Logging Level menu to specify the type of events to log.

X By default, the logging level is set to Info which enables the MC1-UHD to provide a summary of all
commands sent to and responses via this GPI/Tally port.

Configuring a Pre-roll Time

The MC1-UHD includes an optional pre-roll time to be used in conjunction with GPIO crosspoint
tallies. The tally is asserted immediately on any TAKE or hot-punch operation. The operation is then
delayed for the specified number of frames.

X The Preroll Time will apply to all GPI/Tally connections in use on the rear module.
To configure a pre-roll time

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the GPI/Tally tab.

3. Use the Preroll Time field to specify the number of frames to pause before executing a
command on any GPI/Tally connection.

Enabling GPIs to Override Take Transitions

The MC1-UHD can be configured to prevent GPI-triggered keys from being taken off-air by a TAKE
transition. On activation, this feature disables the corresponding key on the preset bus. Note that
the key can still be taken off-air by a hot-punch.
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To enable GPIs to override Take transitions

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the Transitions tab.
3. Select the GPI Overrides TAKE box.

Using Virtual GPIs

The Virtual GPI (VGPI) functionality of the Miranda™ Presmaster Automation or RossTalk protocols
can be used to trigger squeeze on/off transitions on the MC1-UHD using a specified SqueezeBack
preset. This section outlines how to assign a VGPI to a SqueezeBack preset.

For More Information on...

* the Presmaster commands, refer to the Miranda™ Presmaster Automation Protocol
documentation.

+ the Presmaster commands the MC1-UHD supports, refer to “Using the Presmaster Protocol”.

+ the RossTalk protocol commands the MC1-UHD supports, refer to “Using RossTalk".

+ the options in the VGPI tab, refer to “VGPI Tab".

+ the location of the ATMN button on the On Air Control interface, refer to “Menu System Basics".

Assigning a SqueezeBack Preset to a VGPI

You can assign one of sixteen Virtual GPIs (VGPIs) to a specific SqueezeBack preset. Note that these
VGPIs are not associated with the physical GPIO ports on the rear module.

To assign a SqueezeBack Preset to a VGPI

1. Display the Configuration interface as outlined in “To display the Configuration interface in
DashBoard".

2. Select the GPI/Tally tab.
3. Select the VGPI sub-tab.

Video Format  Audio Status  Alarm Enables ~ ANC  Transitions  Output Selection ~ Matte ~ GPITally ~ Remote Control  Router Control  CrosspointMap  Audio Profile Names  DVE

GPITally  VGPI

4. Use the Function menu to assign a specific SqueezeBack Preset for each VGPI.
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5. Use the Armed State menu to determine if the specified SqueezeBack Preset is included in the
transition. Choose from the following:

+ Disarmed — the command excludes the specified SqueezeBack Preset in the transition (the
SQUEEZE button is unlit on the On Air Control interface). This command will be ignored when
the specified SqueezeBack Preset is on Program.

+ Armed Up — the command includes the specified SqueezeBack Preset in the transition (the
SQUEEZE button is lit on the On Air Control interface). This command will be ignored when
the specified SqueezeBack Preset is on Program.

+ Armed Down — the command excludes the specified SqueezeBack Preset in the transition
(the SQUEEZE button is unlit on the On Air Control interface). This command will be ignored
when the specified SqueezeBack Preset is on Program.

6. Ensure the ATMN button is toggled to ON to enable your automation device to control the
MC1-MK. This button is located on the On Air Control interface.
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Upgrading the Software

The MC1-UHD can be upgraded in the field via DashBoard.

* During a software upgrade, the MC1-UHD may be unresponsive and there will be interruptions to
signal flow. Ensure the MC1-UHD is bypassed in your signal path prior to performing a software
upgrade.

To upgrade the software on a card

Contact Ross Technical Support for the latest software version file.

Ensure the Ethernet cable is connected to the ETHERNET port on the openGear frame.

Ensure the network settings on the MC1-UHD are valid.

From the Tree View, expand the node for the MC1-UHD you want to access.

Double-click the Global sub-node to display the interface in the right-half of DashBoard.

Click Upload, located near the bottom of the interface, to display the Select file Upload dialog.
Navigate to the *.bin file you want to upload.

Click Open.

If you are upgrading a single card:

0 X N o U~ W=

a. Click Finish to start the upgrade.
b. Proceed to step 11.
10. If you are upgrading multiple cards:

a. Click Next > to display the Select Destination menu. This menu provides a list of the
compatible cards.

b. Specify the card(s) to upload the file to by selecting the check box(es) for the cards you want
to upload the file to.

c. Verify the card(s) you want to upload the file to. The Error/Warning fields indicate any
errors, such as incompatible software or card type mismatch.

d. Click Finish.
11. Monitor the upgrade.
+ An Upload Status dialog enables you to monitor the upgrade process.

+ Notice that each card is listed in the dialog with a button. This button is replaced with a
Reboot button once the software file is loaded to that card.

* Avoid clicking the individual Reboot buttons until all cards have successfully completed the file
upload process and the OK button, located in the bottom right corner of the dialog, is enabled.

+ Click OK to reboot all the cards listed in the Uploading to Selected Devices dialog.

+ The Reboot Confirm dialog displays, indicating the number of cards that will reboot. Click
Yes to continue the upgrade process. Note that clicking Cancel or No returns you to the
Uploading to Selected Devices dialog without rebooting the card(s).

« The card(s) are temporarily taken off-line during the reboot process. The process is complete
once the status indicators for the Card State and Connection return to their previous status.
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Notes on Rebooting the Card

The following parameters are saved and recalled when the MC1-UHD reboots:

+ All editable parameters on the Global and Configuration interfaces
+ The on-air setup should be recalled.

+ The Program and Preset bus selection

+ The External Key crosspoint selection.

+ The Transition setup including Rates, Speed, and Trans Type

+ Keyer configurations (such as source, transparency, etc.)

+ Logos are reloaded

+ The SqueezeBack effects and the Selected Effect are reloaded
The following on-air states are not recalled:

+ Keyer on-air state (Program and Preset)

+ Transition includes (BKGD, Squeeze)

+ Audio Over state

+ Fade to Black state
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DashBoard Interface Overview

This chapter summarizes the interfaces, and tabs available from DashBoard for the MC1-UHD.

X An asterisk beside a parameter indicates that it is the default value.

Global Interface

The tabs in the Global interface enable you to monitor the overall status of the MC1-UHD software
and hardware. The Global interface is displayed by double-clicking the Global sub-node in the
MC1-UHD tree. (Figure 28)

{ Sewp Network  Global Alarm Enables  Security  Configure Licenses  Logging
)

Figure 28 Example of the Global Interface in DashBoard

X |f the Global Interface does not display as shown in Figure 28, the network settings of the
MC1-UHD may be incorrectly set or invalid. Refer to “Getting Started” for details.

Signal Tab

Table 21 summarizes the read-only information displayed in the Signal tab.

Table 21 Signal Tab

Item Parameters Description
Analog Ref Status OK (Green) The detected reference format is supported
Alarm Suppressed An unsupported reference format is
(Green) detected but the Global Alarm Enables >

Reference Format option is disabled (box is
not selected)

Unlocked (Red) A reference signal is detected but the
MC1-UHD is not locked to it

Unsupported (Red) A reference signal is detected but the
format is not supported by the MC1-UHD

Incompatible (Red) A reference signal is detected but the
format is incompatible with the current
output mode
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Item
Analog Ref Format

Inputs

Input # Format

Outputs
Output # Format

Product Tab

Table 22 summarizes the read-only information displayed in the Product tab.

Item
Product

Supplier
Board Rev
Serial Number

Rear Module

Rear Module Status

Software Rev
Firmware Rev
CPLD Rev

Daughter Card
Type
Variant

Issue

Table 21 Signal Tab (Continued)

Parameters
HHH

#HH##

#HH#H#

Description
Indicates the detected reference format

Signal present and the format matches the
video output format configuration of the
card

Reports the format of the specified video
output

Table 22 Product Tab

Parameters
MC1-UHD

Ross Video Ltd.
#
#
#

OK (Green)

Alarm suppressed
(Green)

Incomp 1/0 Module (Red)

VH# H-#

#.4#

#H#

Description

Indicates the hardware version
Indicates the serial number of the card

Indicates the rear module the card is
installed in

A supported rear module is installed with
the card

An unsupported rear module is installed
but the Global Alarm Enables > Rear
Module option is disabled (box is not
selected)

Card is connected to an unsupported rear
module

Indicates the software version running on
the card

Indicates the firmware version running on
the card

Indicates the complex programmable logic
device version of the MC1-UHD

Indicates the daughter card model installed
on the main card

Indicates the hardware version of the
daughter card
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Hardware Tab

Table 23 summarizes the read-only information displayed in the Hardware tab.
Table 23 Hardware Tab

Item Parameters
Hardware Status OK (Green)

Description
The fans are operating correctly and no

Voltage (mV)
Current (mA)
Power (W)
FPGA Temp (C)

AXI Bridge

Fan Speed

CPU Usage

Uptime (System/App)

RAM Available
SD Card Status

Daughter Card
Voltage (mV)

Alarm suppressed

(Green)

Critical Temperature

(Red)

Fan Off/Stalled (Red)

#
#
#
#C

#

XXX /y.yy/zzz

D HH:MM:SS

# / #.## MB
x of #GB used

errors are detected

There are fan errors detected but the
Global Alarm Enables > Fan Speed option is
disabled (box is not selected)

An error with the fans is occurring. Verify
that the fans and airflow for the card is
valid.

Measured input voltage

Current consumption in milliamperes
Power consumption in watts
Indicates the FPGA Core temperature

where:

* A green indicator displays when the
temperature is less than 95°C.

* Ayellow indicator displays when the
temperature is greater than or equal to
95°C.

* Ared indicator displays when the

temperature is greater than or equal to
100°C.

X If the temperature is greater than
100°C, the user must manually shut off
the card.

The Advanced extensible interface bridge is
running correctly on the card. This
information is used by Ross Technical
Support for diagnostics.

Reports the speed (rpm) of the fan on the
board

Displays the CPU Load average where:

* X.XX represents in the last minute

* y.yy represents the last five minutes

* z.zz represents the last fifteen minutes

Reports the amount of time since the last
reboot, or loss of connectivity, of the card

CPU Memory Used / Total CPU Memory

Reports the amount of memory used on the
Micro SD card

Measured input voltage
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Table 23 Hardware Tab (Continued)

Item Parameters Description
Current (mA) # Current consumption in milliamperes
Power (W) # Power consumption in watts
Licensing State Tab

Table 24 summarizes the information displayed in the Licensing State tab.
Table 24 Licensing State Tab

Item Parameters Description
Base Product Type = MC1-UHD

MC1-UHD-#-LICENSE

License State Unlicensed The license key for the feature is not
installed. Navigate to the Configure License
tab to enable this feature

Licensed The license key for this feature was
correctly enabled in the Configure License
tab

Setup Tab

Table 25 summarizes the options in the Setup tab.

Table 25 Setup Tab

Item Parameters Description
Reference Source Frame 1 Assigns the source connected to the REF 1

port on the openGear frame

Frame 2 Assigns the source connected to the REF 2
port on the openGear frame

Local Assigns the external reference source
connected to REF IN port on the rear
module

Input SDI 1 Assigns the signal connected to the SDIIN 1

port on the rear module

Factory Defaults

Load Factory All editable parameters in DashBoard, except those in the Network tab

Defaults and any installed licenses, are reset to the factory default values. A
reboot of the card may be required to update the parameters.

Card Lock

Unlocked* All editable parameters in DashBoard can be modified by a user

Locked The DashBoard interface is locked. The editable parameters in

DashBoard can no longer be modified by the user.
To unlock the interface, select the box again.

Generate and Download MIBs File
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Table 25 Setup Tab (Continued)

Item Parameters Description

Download MIBs Downloads the Management Information Base (MIB) file that provides
the SNMP controls for your card

Network Tab

Table 26 summarizes the menus and read-only fields displayed in the Network tab.

Table 26 Network Tab

Item Parameters Description
Network Time
Use time from Selected Enables the MC1-UHD to use the time data
Frame Network Cleared reported by the MFC-OG3-N or MFC-OGX-N
Controller that is installed in the same openGear
frame

openGear Chassis RJ-45

Link Status OK (Green) The MC1-UHD is communicating on the
(read-only) network via the MFC-OG3-N or MFC-OGX-N
Invalid Subnet Mask The Current Subnet Mask value is set
(Yellow) incorrectly or is invalid within your network
Apply/Cancel Changes One or more setting on this tab was
(Yellow) changed but the Apply button was not
selected
Not Present (Red) A link could not be established using the
present network setting values
Link Down (Red) The link for the MFC-OG3-N or MFC-OGX-N
is invalid
Current IP Address  #.#.#.# Indicates the IP Address currently assigned
(read-only) to the MC1-UHD via the MFC-OG3-N or
MFC-OGX-N
Current Subnet #H#HM Indicates the subnet mask for the MC1-UHD
Mask (read-only)
Current Gateway HAHH Indicates the gateway for communications
(read-only) outside of the local area network (LAN)
MAC Address # Indicates the MAC Address currently
(read-only) assigned to the MC1-UHD
Mode Static The user manually supplies the network
settings for the MC1-UHD
DHCP* Automates the assignment of network
settings for the MC1-UHD
Static IP Address # The IP Address for the MC1-UHD that the
user manually assigned
Subnet Mask # The Subnet Mask for the MC1-UHD that the

user manually assigned
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Table 26 Network Tab (Continued)

Item Parameters Description

Static Gateway #HHH# The Gateway for the MC1-UHD that the
user manually assigned

Global Alarm Enables Tab

Table 27 summarizes the options displayed in the Global Alarm Enables tab.

Table 27 Global Alarm Enables Tab

Item Parameters Description
Network Time
Network time # Displays the time data transmitted by the
(read-only) Frame Controller card in the same

openGear frame.
Requires that the Global > Network > Use
time from Frame Controller box is selected.

Alarm Enable Selected The MC1-UHD reports the NTP time as
provided by the Frame Controller card

Cleared* Disables this alarm
Rear Module Alarm
Rear Module This field replicates the information displayed in the Product > Rear
(read-only) Module Status field
Alarm Enable Selected* The Global > Product > Rear Module Status

field reports when a rear module is not
compatible with the card

Cleared Disables this alarm
Fan Alarm
Fan Speed # Reports the fan speed (rpm) of the fan on
(read-only) the board
Alarm Enable Selected* The MC1-UHD reports when the fan is not

working correctly
Cleared Disables this alarm

Analog Reference Alarm

Reference Format OK (Green) Indicates the detected reference format is
(read-only) supported
Alarm Suppressed The Alarm Enable box is cleared. The status
(Green) of the reference signal will not be reported.
Unlocked (Red) A reference signal is detected, but the card

is not locked to it

Unsupported (Red) A reference signal is detected, but the
format is not supported by the MC1-UHD

Incompatible (Red) A reference signal is detected but the
format is incompatible with the current
output mode of the card
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Table 27 Global Alarm Enables Tab (Continued)

Item Parameters Description

Alarm Enable Selected* The Global > Signal > Analog Reference
Status field reports when there is a loss of
reference signal

Cleared Disables this alarm
SDI Input Alarms
Input # Status Each field duplicates the information reported in the Configuration >
(read-only) Video Format > Input Status fields
Alarm Enable Selected* MC1-UHD reports a loss of the specified

input or if the format is incompatible for the
specified input

Cleared Disables this alarm

Security Tab

Table 28 summarizes the options displayed in the Security tab.

Table 28 Security Tab
Item Parameters Description
Security Configuration

SSH Login Disable* Disables the ability to log onto the
MC1-UHD via an SSH server

Enable The MC1-UHD can be accessed via a secure
channel by an SSH server

File Transfer Protocol Configuration
Disable FTP Server ~ The MC1-UHD does not have access to any FTP server in your network

Enable FTP & FTPS The MC1-UHD uses the File Transfer Protocol (FTP) and/or FTP with
Transport Layer Security (FTPS) for connection to your network. If using
FTPS, ensure the SSL certificate is loaded and validated on the
MC1-UHD.

Enable FTPS Only The MC1-UHD uses FTP with Transport Layer Security (FTPS) for
connections. Ensure the SSL certificate is loaded and validated on the

MC1-UHD.
Enable FTP Only The MC1-UHD uses the File Transfer Protocol (FTP) for connection to
your network
SSL Status New valid SSL file Indicates the status of the *.pem file after
(read-only) received and in use the last time the Scan SSL Certificate & Key

No new valid SSL file button was clicked.

received and current SSL
file in use is still valid

No new valid SSL file
received and current SSL
file in use is no longer
valid or does not exist
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Table 28 Security Tab (Continued)

Item Parameters Description
SSL Status Current SSL filein use is  Indicates the status of the *.pem file after
(read-only) still valid the MC1-UHD was recently rebooted

Current SSL file in use is
no longer valid or does

not exist
SSL Expire Mm dd hh:mm:ss yyyy Displays the exact expiration date of the
(read-only) GMT SSL file on the MC1-UHD where:
* Mm represents the month
* dd represents the day
* hh:mm:ss represents the time
* yyyy represents the year
For example, Jan 8 18:08:55 2026 GMT
<blank> No valid SSL file is present on the MC1-UHD

Scan SSL Certificate  Click this button to verify if the uploaded and current *.pem file is valid
& Key or not. The SSL Status field updates with the result of the scan.

The current *.pem file will be validated and then be placed at the
appropriate location in the MC1-UHD for it to be used to have the
ability to use FTPS. The *.pem file will no longer be present in the
SSL_CK folder.

If there is an error or if the wrong file type is provided, the file will not
be used. You will then need to upload a new SSL Certificate as outlined
in “Enabling FTP(S)".

Configure Licenses Tab

Table 29 summarizes the read-only information displayed in the Configure Licenses tab.

Table 29 Configure Licenses Tab

Item Parameters Description
Base Product Type  MC1-UHD
Feature <license name> Specifies the license(s) available for your
card
Request Code # This character string is used to obtain a
license key
Key # Specifies the license key that was provided

to enable the licensed feature

Licensed The license key is valid and the licensed
feature is enabled

Logging Tab
Table 30 summarizes the read-only information displayed in the Logging tab.
Table 30 Logging Tab

Item Parameters Description
Logging Level Filters the events the System Log captures
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Table 30 Logging Tab (Continued)

Item Parameters Description

Remote Logging #AHH Specifies the IP Address for the external
device that is logging the communication
activity for the MC1-UHD

System Log Displays the events logged for the MC1-UHD since the last time the log
was cleared

Configuration Interface

The tabs in the Configuration interface enable you to configure the outputs, transitions, the matte
generators, the box masks, and GPI/Tally communications. (Figure 29) The Configuration interface
is displayed by double-clicking the Configuration sub-node in the MC1-UHD tree.

Video Format  Program Fail-over ~ Audio Status ~ Alarm Enables ~ ANC  Transitions  Output Selection ~ Matte  GPUTally ~ Remote Control  Router Control  CrosspointMap  Audio Profile Names  DVE  Audio Over

Figure 29 Example of the Configuration Interface in DashBoard

Video Format Tab

Table 31 summarizes the read-only information displayed in the Video Format tab.

Table 31 Video Format Tab
Item Parameters Description
Output Format

Output Format # Selects the video format for the output
signal. Note that a change in video format
takes effect immediately. The defaultis

1080p/59.94.
Clip at Black Selected* Enables the card to clip to SMPTE black on
all outputs
Cleared Super-black is not clipped (allows

super-black)
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Table 31 Video Format Tab (Continued)

Item Parameters
Clip at White Selected*
Cleared

Input Status - Input #

Status (read-only) OK (Green)

Incompatible Video
(Yellow)

Frozen Video (Yellow)

Invalid Video (Red)

No signal (Red)
Format (read-only) #

Timing (read-only) # lines (to analog ref)

Alarm Enables Selected*
Cleared
CRC Errors #
Reset
Frozen Video Selected
Threshold (Frames) Cleared*
1-600

Description

Enables the card to slip to SMPTE white on
all outputs

Super-white is not clipped (allows
super-white)

The input signal is valid and no errors are
detected

The input video format is not supported by
the reference format

The input signal has frozen on the last valid
frame of video

The input signal is detected but it is in an
unsupported format or an error is
occurring

No signal present on the specified input
Indicates the detected video format of the
specified input signal

Indicates the timing of the specified input
signal relative to the reference signal

The MC1-UHD monitors the signal on the
specified IN BNC and reports when an error
is detected on the input signal

The MC1-UHD does not report when an
error is detected on the specified input
signal

Displays the count of the CRC errors on the
video input. This counter is reset on loss of
video, or by user request. The counter is
non-latching, and the count can roll over
the counter.

Resets the CRC Errors field
The MC1-UHD monitors all the
Disables this feature

Specifies the number of frames the video
must be frozen before an alarm is reported
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Program Fail-over Tab

Table 32 summarizes the options displayed in the Program Fail-over tab.

Table 32 Program Fail-over Tab

Item Parameters Description
Status (read-only) OK (Green) Indicates the detected Program output
signal is valid
Auto Failover The Program output is now defined by the
Fail-over Mode setting
Failover - User Force The user manually set the card into Failover
mode by clicking the Override button
Override FORCE FAILOVER Forces the MC1-UHD to switch from the

current Program output signal as specified
by the Fail-over Mode

RESET FAILOVER The MC1-UHD is currently operating in
Fail-over Mode. Click this button again to
return the Program output to the signal
selected via the Program bus.

Auto return Disabled Disables this feature

Enabled The MC1-UHD automatically returns to the
output selected on the Program bus when
the automatic trigger conditions are no
longer detected

Fail-over mode Disabled Disables this feature
Switch to preset The Program output switches to the video
source assigned to the Preset output
Mute output Mutes the video source on the Program
output
SDI # The Program output switches to the

specified SDI input signal

Logo # The Program output switches to the
specified logo channel

Hold off (frames) > Video

Hold off 1-600 Specifies the number of frames the
MC1-UHD encounters video errors before a
failover is triggered. The default is 1.

Auto Return 1-600 Specifies the number of frames the
MC1-UHD encounters no video errors
before switching to a detected valid input
signal. The defaultis 1.

Hold off (frames) > Audio

Hold off 1-600 Specifies the number of frames the
MC1-UHD encounters audio errors before a
failover is triggered. The defaultiis 1.
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Table 32 Program Fail-over Tab (Continued)

Item Parameters
Auto Return 1-600

Hold off (frames) > ANC
Hold off 1-600

Auto Return 1-600

VIDEO Fail-over

Incompatible Video  Selected

Cleared
Not Timed to Selected
Reference

Cleared
No Signal Selected

Cleared
Frozen Video Selected

Cleared
Unlicensed Selected

Cleared

AUDIO Failover > Group #

Missing Selected
Cleared

Async Selected
Cleared

ANCILLARY Failover
ST.352 Upstream Selected

Cleared

Description

Specifies the number of frames the
MC1-UHD encounters no audio errors
before automatically switching to the
detected valid input signal. The defaultis 1.

Specifies the number of frames to wait
when no ANC data is detected before
triggering a failover. The defaultis 1.

Specifies the number of frames the
MC1-UHD encounters no ANC errors before
automatically switching to the detected
valid input signal. The defaultis 1.

Triggers a failover when the Program
output signal is not compatible with the
reference input signal

A failover is not triggered by this error

Triggers a failover when the Program input
is not locked to the reference signal

A failover is not triggered by this error

Triggers a failover when a valid signal is not
detected on the Program input

A failover is not triggered by this error

Triggers a failover when the Program input
signal has frozen on the last valid frame of
video

A failover is not triggered by this error

Triggers a failover when the Program input
signal requires a license key

A failover is not triggered by this error

Triggers a failover when a valid audio signal
is absent on the Program input

A failover is not triggered by this error

Triggers a failover when the audio signal is
mistimed with the video on the Program
input

A failover is not triggered by this error

Triggers a failover when SMPTE ST-352
packets are not detected on the Program
input

A failover is not triggered by this error

152 « DashBoard Interface Overview

MC1-UHD User Guide (v8-rev3)



Item
AFD

Closed Captioning
(CC-708)

Closed Captioning
(CC-608)

LTC

VITC

Compressed Audio

Metadata

SCTE-104

OP-47

Other

Table 32 Program Fail-over Tab (Continued)

Parameters
Selected

Cleared

Selected

Cleared
Selected

Cleared
Selected

Cleared
Selected

Cleared
Selected

Cleared
Selected

Cleared
Selected

Cleared
Selected

Cleared

Description

Triggers a failover when AFD data is not
embedded in the ancillary area of the
Program input

A failover is not triggered by this error

Triggers a failover when the CEA-708 data is
not detected in the Program input

A failover is not triggered by this error

Triggers a failover when the CEA-608 is not
detected in the Program input

A failover is not triggered by this error

Triggers a failover when the Linear
Timecode packet is missing from the
Program input

A failover is not triggered by this error

Triggers a failover when the Vertical Interval
Timecode packet is missing from the
Program input

A failover is not triggered by this error

Triggers a failover when the audio
metadata of the input is not synchronous to
the Program input

A failover is not triggered by this error

Triggers a failover when the SCTE-104
packet is not detected in the baseband SDI
video signal of the Program input

A failover is not triggered by this error

Triggers a failover when the embedded
OP-47 VANC packets are not detected on
the Program input

A failover is not triggered by this error

Triggers a failover when other supported
ANC data types (not listed above) are
absent in the VANC of the Program input

A failover is not triggered by this error
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Audio Status

Table 33 summarizes the read-only information displayed in the Audio Status tab for each channel.

Table 33 Audio Status Tab

Item Parameters Description
Embedded Audio # - Group #
Ch # Status PCM The channel is PCM audio
(read-only) Non-PCM The channel is non-PCM audio
Absent The audio channel is not detected or invalid

AES - AES # Input

Sample Rate Selected SRC is used on the input of the specified
Conversion AES signal
Cleared SRCis not used on the input of the specified

AES signal. Select this option when using
non-PCM audio data.

Ch # Status PCM (Green) Displays the status of the specified channel
(read-only) PCM-silent (Green) input

Non-PCM (Green)

No Input (Red)

Async? (Red)

Word Length #bit Reports the number of bits of audio
(read-only)
Sample Rate #kHz Reports the sample rate of the AES input
(read-only)
Emphasis Yes The incoming AES signal is indicating 50/15
(read-only) or CCiTT J.17 emphasis
No The incoming AES signal is indicating no
emphasis or the emphasis is not indicated
Presence Alarm Selected* The MC1-UHD reports when the specified
AES input is not detected
Cleared Disables the alarm.
Async Alarm¢ Selected The AES source is either asynchronous to
the input video, or is not a 48kHz rate
Cleared Disables the alarm. The AES input is not
monitored.

a. Ifthe Sample Rate Conversion is enabled, an Async AES signal is processed to be PCM and indicated as such.
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Alarm Enables Tab

Table 34 summarizes the options displayed in the Alarm Enables tab.

Table 34 Alarm Enables Tab

Item Parameters
SDI Input #
Video Selected*
Cleared

SDI Input # - Audio Group #

Absent Selected*
Cleared
Async Selected*
Cleared
ANC Tab

Description

An alarm is triggered when a missing or an
invalid video signal is detected on the SDI
input

The alarm is suppressed when a missing or
an invalid video signal is detected on the
SDIl input

An alarm is triggered when a missing audio
signal is detected on the SDI input

The alarm is suppressed when a missing
audio signal is detected on the SDI input

An alarm is triggered when the audio signal
is mistimed with the video on the SDI input

The alarm is suppressed when the audio
signal is mistimed with the video on the SDI
input

The ANC menus, status fields, and options are organized into three sub-tabs: ANC, Decode, and
Encode. This section summarizes the options available in each sub-tab.

ANC

Table 35 summarizes the options available in the ANC sub-tab.
Table 35 ANC — ANC Tab

Item Parameters

ANC Frame Delay #
(read-only)

ANC Pass through Selected

Description

The frame delay is always relative to the
next output frame. The output is at a fixed
rate as defined by the Output Video mode.

The MC1-UHD passes all upstream ANC
data with no modifications.

The ANC Delete/Pass, Insertion Line, and
Insertion Order settings are ignored.

The ANC > Decode tab continues to report
the incoming services as if they are being
decoded.

The ANC > Encode >Status field reports the
pass through status and copies the data
rate fields from the ANC > Decode tab.
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Item

ANC Pass through

Packet Name

Action

Field # Insertion

Line

Insertion Order

Line 21 Caption
Pass-through?

Table 35 ANC — ANC Tab (Continued)

Parameters
Cleared

Delete

Pass*

Switch Line + #

Follow upstream

#

Selected

Cleared

Description

The MC1-UHD applies the ANC Delete/Pass
and Insertion line/order settings before
passing the upstream ANC data

Card deletes the packet from the output

The card receives and re-inserts the
specified packet type into the specified line
without modifying the packet contents

Selects a line to insert the specified ANC
packet on.

Note that if more than one packet is to be
inserted in the same line, the packet with
the lowest insertion order number will be
inserted first. The default is Switch Line + 2.

Inserts the packet on the same line as the
upstream device

Defines the hierarchy of the packets
insertion

Note that the lower the number, the higher
priority the packet is given.

Specifies to pass closed-captioning data on
Line 21 unaltered. This setting should only
be used when closed-captioning, or other
data, is present on Line 21.

Disables this feature

a. This option only displays when the Configuration > Video Format > Output Format is set to 480i 59.94Hz.

Decode

Table 36 summarizes the Decode sub-tab fields available in DashBoard for each type of ANC data

for each SDI signal.

Item

Status (read-only)

Table 36 ANC — Decode > SDI # Tab

Parameters
OK

Exceeded Bandwidth

Missing

Present in Luma and

Chroma

Unexpected: Field #

Unexpected: LUMA

Unexpected: CHROMA

Line Out of Range

Description
Expected decoded ANC data is present

Captured VANC services exceeded
bandwidth

Expected decoded ANC data is not present

Decoded data was found on both LUMA
and CHROMA channels

Receiving ANC data from wrong field
Receiving ANC data from wrong channel
Receiving ANC data from wrong channel

Receiving data from wrong line
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Table 36 ANC — Decode > SDI # Tab (Continued)

Item Parameters Description
Status (read-only) Too Many Packets in There is a data overflow
Frame
Overflow Exceeded decoded bandwidth. Lost data.
CRC Error CRC error found in decoded ANC data:
some protocols only
Parse Error Decoded data does not match expected
protocol
Invalid Length The length of decoded ANC packet is
incorrect for service
Data Rate # Reports the decoding data transfer rate; the
(Bytes/Sec) number of bytes received in the last field
(read-only)
Field # #, <text> Reports the data insertion location where #

represents the specific line and <text>:
* HC represents HYANC CHROMA

* HL represents HVANC LUMA

* VC represents VANC CHROMA

* VL represents VANC LUMA

Alarm Enable Selected The MC1-UHD monitors the decoded ANC
status and updates the Status field
accordingly

Cleared* Disables this alarm

Field #

Bandwidth Used # The overall bandwidth percentile including

(Percent) (read-only) buffer overflow state, of all decoding ANC
services

Encode

Table 36 summarizes the Encode sub-tab fields available in DashBoard for the ANC data for each
SDI signal.

Table 37 ANC — Encode > SDI # Tab

Item Parameters Description
Status (read-only) OK Expected encoded ANC data is present
Exceeded Bandwidth Captured VANC services exceeded
bandwidth
Missing Expected encoded ANC data is not present
Present in Luma and Encoded data was found on both LUMA and
Chroma CHROMA channels
Unexpected: Field # Receiving ANC data from wrong field
Unexpected: LUMA Receiving ANC data from wrong channel

Unexpected: CHROMA Receiving ANC data from wrong channel
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Table 37 ANC — Encode > SDI # Tab (Continued)

Item Parameters Description
Status (read-only) Line Out of Range Receiving data from wrong line

Too Many Packets in There is a data overflow

Frame

Overflow Exceeded encoded bandwidth. Lost data.

CRC Error CRC error found in encoded ANC data:
some protocols only

Parse Error Encoded data does not match expected
protocol

Invalid Length The length of encoded ANC packet is
incorrect for service

Data Rate # Reports the encoding data transfer rate; the

(Bytes/Sec) number of bytes received in the last field

(read-only)

Alarm Enable Selected The MC1-UHD monitors the encoded ANC
status and updates the Status field
accordingly

Cleared* Disables this alarm

Field #

Bandwidth Used # The overall bandwidth percentile including

(Percent) buffer overflow state, of all decoding ANC
services

Transitions Tab

Table 38 summarizes the options displayed in the Transitions tab.

Table 38 Transitions Tab

Item Parameters Description

VANC Preroll 0-25 Specifies the number of frames to pause all
hot-punches, key punches, and TAKE
transitions after the VANC is passed
through

Post Transition Behavior

Leave Preset As Is The Preset bus remains unchanged after a transition

Swap The Program and Preset buses flip-flop after a transition
Program/Preset*
Preset Off The Preset bus is unavailable after a transition

Take During Transition Action

lgnore* Select this option to disregard any successive presses of the TAKE
button until the transition is complete

Pause Select this option to pause the transition when the TAKE button is
toggled, and resume the transition when the button is pressed again

Reverse Select this option to reverse the transition back to the start
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Item
Cut on Clean Feed

Selected
Cleared*
Reset Audio Gain
Selected

Cleared*

Table 38 Transitions Tab (Continued)

Parameters Description

A cut is performed when transitioning to a clean feed output

Disables this feature

Ramps the audio gain level to the default level as the Preview bus is
transitioned after a TAKE

Keeps the audio gain level at the current level after a TAKE transition
completes (the audio gain is not adjusted)

GPI Triggered Keys to Override TAKE Transitions

GPI Overrides TAKE

FTB Disabling
FTB Button

Selected Prevents GPI-triggered keys from being
taken off-air by a TAKE transition. On
activation, this feature disables the
corresponding key on the preset bus.

Cleared* Disables this feature

FTB Enabled Selecting the FTB button performs a fade to
black where the: program bus is faded to
black at the FTB rate, the audio fades to
silence, and closed captioning information
is not passed

FTB Disabled The FTB button is grayed out on the
interface, and selecting it has no effect

Output Selection Tab

Table 39 summarizes the options displayed in the Output Selection tab.

Item
Output #

Table 39 Outhut Selection Tab

Voice Over Enable - Output #

Audio Over

Parameters Description

Black Specified output displays black

Program Specified output displays the Program
output

Preview Specified output displays the Preview
output

Clean # Specified output displays the selected clean
feed output

Logo # Assigns the specified logo channel to the
output

Selected Enables voice over on the selected output

Cleared Disables voice over on this output
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Table 39 Output Selection Tab (Continued)

Item Parameters Description
EAS Selected Enables EAS voice over on the selected
output
Cleared Disables EAS voice over on this output
Matte Tab

Table 40 summarizes the options displayed in the Matte tab for each matte generator.

Table 40 Matte Tab

Item Parameters Description
Matte #

Luma # Adjusts the luma component
Cr # Adjusts the blue-difference values of the
matte generator channel where:

* Increasing the value causes the display
color to become increasingly saturated
with blue

* Decreasing the value de-saturates the
blue color from the display color

Cb # Adjusts the red-difference values of the
matte generator channel where:

* Increasing the value causes the display
color to become increasingly saturated
with red

* Decreasing the value de-saturates the red
color from the display color

GPI/Tally Tab
The GPI/Tally tab is divided into two sub-tabs: GPI/Tally and VGPI.

GPI/Tally Tab
Table 41 summarizes the options displayed in the GPI/Tally sub-tab.

Table 41 GPI/Tally > GPI/Tally Tab

Item Parameters Description
GPI/Tally #
Function None* The specified GPIO port is not configured

and the GPI has no effect. The Trigger/Tally
Type setting is ignored.

Tally Video Input # Configures the GPIO port as an output and
reflects the on-air status of the specified SDI
IN signal
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Table 41 GPI/Tally > GPI/Tally Tab (Continued)

Item Parameters Description
Function Tally Key # Configures the GPIO port as an output and

reflects the on-air status of the specified
Key

Tally Any Key Configures the GPIO port as an output; the
Tally is active when any of the Keys are
on-air

Tally PGM XPT Configures the GPIO port as an output and

reflects the on-air status of the crosspoint
specified in the Crosspoint Number field

GPI Auto Key # Configures the GPIO port as an output; the
tally is active when an Audio Over channel is
on-air

GPI Cut Key A cut transition is performed on the

specified Key when a trigger is received by
that GPI input

GPI On Air Configures the GPIO port as an input and
reflects the on-air status of the source

GPI Take A Take transition is performed when a
trigger is received by that GPI input

GPI FTB A fade to black is performed when a trigger
is received that the specified GPI input

GPI PGM XPT Configures the GPIO port as an output and

reflects the on-air status of the crosspoint
specified in the Crosspoint Number field

GPI Voice Over Configures the GPIO port communicate
with a device to receive an audio voice over
when this GPI is triggered

GPI EAS Audio Over Configures the GPIO port to communicate
with an EAS device to receive an EAS audio
voice over when this GPI is triggered

Trigger/Tally Type Falling* If configured for Falling Edge, the selected
function is executed when the GPI input
signal transitions from High to Low

Rising If configured for Rising Edge, the selected
function is executed when the GPI input
signal transitions from Low to High

High If configured for Active High, the selected
function is executed when the GPI input
signal is driven High

Low If configured for Active Low, the selected
function is executed when the GPI input
signal is driven Low

Current State High Reports the tally status

(read-only) Low
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Table 41 GPI/Tally > GPI/Tally Tab (Continued)

Item Parameters Description

Crosspoint Number  # Only applicable when the Function is set to
Tally PGM XPT or GPI PGM XPT.

Specifies the crosspoint on the MC1-UHD
that will trigger the tally. The crosspoint
number can be either a router source or a
button number, as determined by the
Remote Control > Device Setup > Switch
Request setting.

Output Pulse Width  # Specifies the number of frames between
(frames) the rising and falling edges of the output

Manual Override

Enable Selected The user will trigger a switch in states
Cleared The port will trigger a switch in states
Level High The output toggles from the base low level

to the high level. The output signal remains
at this level until reset.

Low The output level toggles from the base high
level to the low level. The output signal
remains at this level until reset.

Pre-roll
Pre-roll Time # Specifies the number of frames to pre-roll
(frames) delay all hot-punches, key punches, and

TAKE transitions after asserting a tally

GPI/Tally Logging Level

Emergency Events are listed in a hierarchical order based on the selected severity
Alert |n.clud|ng: . | .
= * internal errors and unrecognized or invalid responses from the
Critical GPI/Tally port
Error « failed communications between the MC1-UHD (such as time outs) and
. the device connected to the GPI/Tally port
Warning L L I
. This is intended for troubleshooting incompatibilities between the
Notice MC1-UHD and downstream devices.
Info* The MC1-UHD provides a summary of commands sent to and
responses via this GPI/Tally port
VGPI Tab

The VGPI tab provides configuration options for Virtual GPIs (VGPIs) when using the Miranda™
Presmaster or RossTalk protocols. Table 42 provides a summary of the VGPI tab.

For More Information on...
+ the Presmaster protocol, refer to “Using the Presmaster Protocol”.
+ the RossTalk protocol, refer to “Using RossTalk".
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Table 42 GPI/Tally > VGPI Tab

Item Parameters

VGPI #

Function SqueezeBack

Effect 12

SqueezeBack
Effect 2°

SqueezeBack
Effect 3¢

SqueezeBack
Effect 49

None*

State (read-only) Up

Down

Armed State Disarmed*

Description

« An ARM command (0x0130) will
enable/disable SqueezeBack Preset 1 on the
Preset bus

A STATE command (0x0140) will
enable/disable SqueezeBack Preset 1 on the
Program bus

* An ARM command (0x0130) will
enable/disable SqueezeBack Preset 2 on the
Preset bus

« A STATE command (0x0140) will
enable/disable SqueezeBack Preset 2 on the
Program bus

« An ARM command (0x0130) will
enable/disable SqueezeBack Preset 3 on the
Preset bus

A STATE command (0x0140) will
enable/disable SqueezeBack Preset 3 on the
Program bus

* An ARM command (0x0130) will
enable/disable SqueezeBack Preset 4 on the
Preset bus

* A STATE command (0x0140) will
enable/disable SqueezeBack Preset 4 on the
Program bus

The specified VGPI is disabled.

When no SqueezeBack Preset is on Program
and this command is in the Up state, the
command selects the effect type of VGPI and
transitions the selected effect on Program

When a SqueezeBack Preset is on Program and
this command is in the Down state, the VGPI
which has the same effect as the current one
will be handled and the current effect will be off
air or on Preview

In this state, the command excludes the
specified SqueezeBack Preset in the transition
(the SQUEEZE button is unlit on the On Air
Control interface).

This command will be ignored when the
specified SqueezeBack Preset is on Program.
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Table 42 GPI/Tally > VGPI Tab (Continued)
Item Parameters Description

Armed State Armed Up In this state, the command includes the
specified SqueezeBack Preset in the transition
(the SQUEEZE button is lit on the On Air
Control interface).

This command will be ignored when the
specified SqueezeBack Preset is on Program.

Armed Down In this state, the command excludes the
specified SqueezeBack Preset in the transition
(the SQUEEZE button is unlit on the On Air
Control interface).

This command will be ignored when the
specified SqueezeBack Preset is on Program.

a. The default value for VGPI 0.
b. The default value for VGPI 1.
c. The default value for VGPI 2.
d. The default value for VGPI 3.

Remote Control Tab
This section summarizes the options displayed in the Remote Control tab.

Video Format Program Fail-over  Audio Status Alarm Enables ANC Transitions. Output Selection Matte GPITally Remote Control Router Control Crosspoint Map Audio Profile Names
Remote Control IP Address im 0.0.0.0
Rosstalk @ oK

mesms on Chassis RJ45

Ultrix Router (GVG Series 7000)

IP/Port: on Chassis RJ45

Presmaster Control

on Chassis RJ45

APC Control

on Chassis RJ45

SAGE EAS Char Gen

_ e
Net rov
Nefwork Satun

Figure 30 Example of the Remote Control Tab

RossTalk

Table 43 summarizes the RossTalk options displayed in the Remote Control tab.
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Item
Status (read-only)

Connection

Table 43 Remote Control — RossTalk

Parameters
Connected (Green)

Inactive (Green)

Listening (Green)

Reconnecting (Yellow)

Connecting (Yellow)

Port in use (Red)

Cannot connect (Red)

Selected

Cleared*

Network Server*

Network Client

Description
« Enabled box is selected for this protocol
+ Connection is set to Network Client

* Specified IP address and Port number are
valid

* MC1-UHD has successfully established
connection to the given IP address and
port

Enabled box is not selected for RossTalk

* Enabled box is selected for RossTalk
« Connection is set to Network Server
* Specified Port number is valid

« MC1-UHD is ready to accept connections
on the specified port

Enabled box is selected for the protocol
Connection is set to Network Client

MC1-UHD attempts to connect
periodically to the specified IP address
and Port number. The interval between
connection attempts start at 10 seconds,
increases by 10 seconds, to a maximum of
60 seconds.

Enabled box is selected for RossTalk
Connection is set to Network Client

MC1-UHD is attempting to connect to the
specified IP address and Port Number

Enabled box is selected for RossTalk
Connection is set to Network Server

Port Number specified in the Port field is
invalid or in use by another service

Enabled box is selected for RossTalk
Connection is set to Network Client

Specified IP address and Port Number are
invalid or in use by another device

Enables the protocol on the rear module
Ethernet port

Disables the protocol on the Ethernet port.
When the check box is cleared, any
incoming data from the external device is
discarded by the MC1-UHD.

The MC1-UHD functions as a host, or socket
listener, on the network

The MC1-UHD functions as a service
requester that initiates communications
with a server
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Table 43 Remote Control — RossTalk (Continued)

Item Parameters Description

Protocol TCP* Select this option if your external device is
connected to the MC1-UHD through a
network and uses the Transmission Control
Protocol (TCP/IP)

ubDP Select this option if your device is
connected to the MC1-UHD through a
network and uses the User Datagram
Protocol (UDP/IP).

Port # When Connection is set to Network
Server:

* specifies the TCP or UDP port numbers
where the MC1-UHD will listen on.

* TCP ports 0, 21, 80, 5253, and 6667 are
unavailable for Ethernet communications

When Connection is set to Network
Client, this menu specifies the remote port
number to which the MC1-UHD will try to
connect

IP Address #AHH * Only applicable when Connection is set to
Network Client

* Specifies the IP address of the external
device. The default is 0.0.0.0 and this must
be changed to the actual IP address of the
external device.

Ultrix Router (GVG Series 7000)
Table 44 summarizes the Ultrix Router (GVG Series 7000) options in the Remote Control tab.

Table 44 Remote Control — Ultrix Router GVG Series 7000

Item Parameters Description
Status (read-only) Connected (Green) + Enabled box is selected for this protocol
« Connection is set to Network Client

* Specified IP address and Port number are
valid

* MC1-UHD has successfully established
connection to the given IP address and

port
Inactive (Green) Enabled box is not selected for GVG Series
7000
Listening (Green) « Enabled box is selected for GVG Series
7000

« Connection is set to Network Server
* Specified Port number is valid

* MC1-UHD is ready to accept connections
on the specified port
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Table 44 Remote Control — Ultrix Router GVG Series 7000 (Continued)

Item Parameters Description
Status (read-only) Reconnecting (Yellow) « Enabled box is selected for the protocol
« Connection is set to Network Client

+ MC1-UHD attempts to connect
periodically to the specified IP address
and Port number. The interval between
connection attempts start at 10 seconds,
increases by 10 seconds, to a maximum of
60 seconds.

Enabled box is selected for GVG Series
7000

Connection is set to Network Client
MC1-UHD is attempting to connect to the
specified IP address and Port Number
Enabled box is selected for GVG Series
7000

Connection is set to Network Server
Port Number specified in the Port field is
invalid or in use by another service
Enabled box is selected for GVG Series
7000

Connection is set to Network Client

Specified IP address and Port Number are
invalid or in use by another device

Connecting (Yellow)

Port in use (Red)

Cannot connect (Red)

Enabled Selected Enables the protocol on the rear module
Ethernet port

Cleared* Disables the protocol on the Ethernet port.
When the check box is cleared, any
incoming data from the external device is
discarded by the MC1-UHD.

Role Server The MC1-UHD functions as a host, or socket
listener, on the network

Client The MC1-UHD functions as a service
requester that initiates communications
with a server

Protocol TCP* Select this option if your external device is
connected to the MC1-UHD through a
network and uses the Transmission Control
Protocol (TCP/IP)

ubDP Select this option if your device is
connected to the MC1-UHD through a
network and uses the User Datagram
Protocol (UDP/IP).
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Table 44 Remote Control — Ultrix Router GVG Series 7000 (Continued)

Item Parameters Description

Port # When Connection is set to Network
Server:

* specifies the TCP or UDP port numbers
where the MC1-UHD will listen on.

* TCP ports 0, 21, 80, 5253, and 6667 are
unavailable for Ethernet communications

When Connection is set to Network
Client, this menu specifies the remote port
number to which the MC1-UHD will try to
connect

IP Address #AHH * Only applicable when Connection is set to
Network Client

* Specifies the IP address of the external
device. The default is 0.0.0.0 and this must
be changed to the actual IP address of the
external device.

Device Setup

Level Index # Specifies the level that the router will
perform crosspoint switches on. The
defaultis 1.

Take All Levels Selected* Specifies that all transitions take effect on

all router levels

Cleared Disables this feature. Only the level
specified in the Level Index field will be
affected during a transition.

Send Optional Tabs  Selected Includes the optional tab character
between the last command parameter and
the checksum. Refer to the documentation
for your external device to determine if this
character is required.

Cleared* Disables this feature

Log in Hexadecimal  Selected The SEND and RECV log messages are
displayed in hexadecimal (enabled via the
Enable Log Messages area)

Cleared* Disables this feature

Disable Queries Selected The MC1-UHD does not send query
commands to the external device. Select
this option when connecting to a Grass
Valley NV9000

Cleared* Disables this feature
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Table 44 Remote Control — Ultrix Router GVG Series 7000 (Continued)

Item Parameters Description
Log Level INFO The MC1-UHD provides a summary of
commands sent to and responses from the
router
SEND The MC1-UHD provides a detailed report of

commands sent to the router. By default,
the box is unselected (cleared).

RECV The MC1-UHD provides a detailed report of
router responses. By default, the box is
unselected (cleared).

WARN Indicates failed communications between
the MC1-UHD and the router (such as
command time outs and checksum errors).
By default, the box is selected.

ERR Reports internal errors and unrecognized
or invalid responses from the router. This is
intended for troubleshooting
incompatibilities between the MC1-UHD
and a third-party router. By default, the box
is selected.

Presmaster Control

Table 45 summarizes the Presmaster options displayed in the Remote Control tab.

Table 45 Remote Control — Presmaster

Item Parameters Description
Status (read-only) OK (Green) « Enabled box is selected for this protocol
« Connection is set to Network Client

* Specified IP address and Port number are
valid

* MC1-UHD has successfully established
connection to the given IP address and

port
Inactive (Green) Enabled box is not selected for Presmaster
Listening (Green) * Enabled box is selected for Presmaster

« Connection is set to Network Server
* Specified Port number is valid

« MC1-UHD is ready to accept connections
on the specified port

Reconnecting (Yellow) « Enabled box is selected for the protocol
+ Connection is set to Network Client

+ MC1-UHD attempts to connect
periodically to the specified IP address
and Port number. The interval between
connection attempts start at 10 seconds,
increases by 10 seconds, to a maximum of
60 seconds.
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Table 45 Remote Control — Presmaster (Continued)

Item Parameters Description
Status (read-only) Connecting (Yellow) « Enabled box is selected for Presmaster
« Connection is set to Network Client

* MC1-UHD is attempting to connect to the
specified IP address and Port Number

Port in use (Red) « Enabled box is selected for Presmaster
« Connection is set to Network Server

« Port Number specified in the Port field is
invalid or in use by another service

Cannot connect (Red) « Enabled box is selected for Presmaster
« Connection is set to Network Client

* Specified IP address and Port Number are
invalid or in use by another device

Enabled Selected Enables the protocol on the rear module
Ethernet port

Cleared* Disables the protocol on the Ethernet port.
When the check box is cleared, any
incoming data from the external device is
discarded by the MC1-UHD.

Connection Serial Port Enables the MC1-UHD to communicate with
a third-party device via the Presmaster
serial protocol

Network Server The MC1-UHD functions as a host, or socket
listener, on the network

Network Client The MC1-UHD functions as a service
requester that initiates communications
with a server

Network Setup

Packet Type TCP* Select this option if your external device is
connected to the MC1-UHD through a
network and uses the Transmission Control
Protocol (TCP/IP)

ubDP Select this option if your device is
connected to the MC1-UHD through a
network and uses the User Datagram
Protocol (UDP/IP).

Port # When Connection is set to Network
Server:

* specifies the TCP or UDP port numbers
where the MC1-UHD will listen on.

* TCP ports 0, 21, 80, 5253, and 6667 are
unavailable for Ethernet communications

When Connection is set to Network
Client, this menu specifies the remote port
number to which the MC1-UHD will try to
connect
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Table 45 Remote Control — Presmaster (Continued)

Item Parameters Description

Remote IP Address  #.#.#.# * Only applicable when Connection is set to
Network Client
* Specifies the IP address of the external
device. The default is 0.0.0.0 and this must
be changed to the actual IP address of the
external device.

Device Setup

Switch Request Router Crosspoint* The received value refers to a physical or
virtual router crosspoint.

Button Number The received value refers to a specific
MC1-UHD crosspoint button on the
DashBoard control panel.

Log Level Specifies the type of Presmaster events the MC1-UHD log will capture
Automation Status  Selected Enables the periodic sending of the
Tally Enable automation status tally (0842) every #

seconds (set by the Rate field). This tally
reports the state of the ATMN button to the
automation systems

Cleared* Disables this feature

Rate (s) # Specifies the frequency (in number of
seconds) the MC1-UHD will send the
automation status tally number command.
The defaultis 10.

APC Control

Table 46 summarizes the APC options displayed in the Remote Control tab.

Table 46 Remote Control — APC

Item Parameters Description
Status (read-only) OK (Green) + Enabled box is selected for this protocol
« Connection is set to Network Client

* Specified IP address and Port number are
valid

* MC1-UHD has successfully established
connection to the given IP address and

port
Inactive (Green) Enabled box is not selected for APC
Listening (Green) « Enabled box is selected for APC

« Connection is set to Network Server
* Specified Port number is valid

* MC1-UHD is ready to accept connections
on the specified port
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Table 46 Remote Control — APC (Continued)

Item Parameters Description

Status (read-only) Reconnecting (Yellow) « Enabled box is selected for the protocol

« Connection is set to Network Client

+ MC1-UHD attempts to connect
periodically to the specified IP address
and Port number. The interval between
connection attempts start at 10 seconds,
increases by 10 seconds, to a maximum of
60 seconds.
Enabled box is selected for APC
Connection is set to Network Client
MC1-UHD is attempting to connect to the
specified IP address and Port Number
Enabled box is selected for APC
Connection is set to Network Server
Port Number specified in the Port field is
invalid or in use by another service
Enabled box is selected for APC
Connection is set to Network Client

Specified IP address and Port Number are
invalid or in use by another device

Connecting (Yellow)

Port in use (Red)

Cannot connect (Red)

Enabled Selected Enables the protocol on the rear module
Ethernet port

Cleared* Disables the protocol on the Ethernet port.
When the check box is cleared, any
incoming data from the external device is
discarded by the MC1-UHD.

Connection Serial Port Enables the MC1-UHD to communicate with
a third-party device via the APC serial
protocol

Network Server The MC1-UHD functions as a host, or socket

listener, on the network

Network Client The MC1-UHD functions as a service
requester that initiates communications
with a server

Protocol TCP* Select this option if your external device is
connected to the MC1-UHD through a
network and uses the Transmission Control
Protocol (TCP/IP)

ubDP Select this option if your device is
connected to the MC1-UHD through a
network and uses the User Datagram
Protocol (UDP/IP).
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Table 46 Remote Control — APC (Continued)

Item Parameters Description

Port # When Connection is set to Network
Server:

* specifies the TCP or UDP port numbers
where the MC1-UHD will listen on.

* TCP ports 0, 21, 80, 5253, and 6667 are
unavailable for Ethernet communications

When Connection is set to Network
Client, this menu specifies the remote port
number to which the MC1-UHD will try to
connect

IP Address #AHH * Only applicable when Connection is set to
Network Client

* Specifies the IP address of the external
device. The default is 0.0.0.0 and this must
be changed to the actual IP address of the
external device.

Device Setup

Switch Request Router Crosspoint* The received value refers to a physical or
virtual router crosspoint.

Button Number The received value refers to a specific
MC1-UHD crosspoint button on the
DashBoard control panel.

Log Level Specifies the type of events the MC1-UHD log will capture

Tally Protocol Control

Table 47 summarizes the Tally Protocol options displayed in the Remote Control tab.

Table 47 Remote Control — Tally Protocol

Item Parameters Description
Status (read-only) OK (Green) + Enabled box is selected for a TSL protocol
« Connection is set to Network Client

* Specified IP address and Port number are
valid

* MC1-UHD has successfully established
connection to the given IP address and

port
Inactive (Green) Enabled box is not selected for a TSL
protocol
Listening (Green) « Enabled box is selected for a TSL protocol

« Connection is set to Network Server
* Specified Port number is valid

* MC1-UHD is ready to accept connections
on the specified port
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Table 47 Remote Control — Tally Protocol (Continued)

Item Parameters Description
Status (read-only) Reconnecting (Yellow) « Enabled box is selected for a TSL protocol
« Connection is set to Network Client

+ MC1-UHD attempts to connect
periodically to the specified IP address
and Port number. The interval between
connection attempts start at 10 seconds,
increases by 10 seconds, to a maximum of
60 seconds.

Connecting (Yellow) Enabled box is selected for a TSL protocol
Connection is set to Network Client

MC1-UHD is attempting to connect to the
specified IP address and Port Number

Port in use (Red) Enabled box is selected for a TSL protocol
Connection is set to Network Server

Port Number specified in the Port field is
invalid or in use by another service

Cannot connect (Red) Enabled box is selected for a TSL protocol
Connection is set to Network Client

Specified IP address and Port Number are
invalid or in use by another device

Enabled Selected Enables communication via a TSL protocol
on the rear module Ethernet port

Cleared* Disables the protocol on the Ethernet port.
When the check box is cleared, any
incoming data from the external device is
discarded by the MC1-UHD.

Connection Serial Port Enables the MC1-UHD to communicate with
a third-party device via a TSL protocol serial
protocol

Network Server The MC1-UHD functions as a host, or socket

listener, on the network

Network Client The MC1-UHD functions as a service
requester that initiates communications
with a server

Network Setup

Packet Type TCP* Select this option if your external device is
connected to the MC1-UHD through a
network and uses the Transmission Control
Protocol (TCP/IP)

ubDP Select this option if your device is
connected to the MC1-UHD through a
network and uses the User Datagram
Protocol (UDP/IP).
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Table 47 Remote Control — Tally Protocol (Continued)

Item Parameters Description

Port # When Connection is set to Network
Server:
* specifies the TCP or UDP port numbers
where the MC1-UHD will listen on.

* TCP ports 0, 21, 80, 5253, and 6667 are
unavailable for Ethernet communications

When Connection is set to Network
Client, this menu specifies the remote port
number to which the MC1-UHD will try to
connect

Remote IP #H#HH * Only applicable when Connection is set to
Network Client

* Specifies the IP address of the external
device. The default is 0.0.0.0 and this must
be changed to the actual IP address of the
external device.

SAGE EAS Char Gen
Table 48 summarizes the SAGE EAS protocol options displayed in the Remote Control tab.

Table 48 Remote Control — SAGE EAS Protocol

Item Parameters Description

Status (read-only) OK (Green) * Enabled box is selected for the SAGE EAS
Generic Character Generator protocol

« Connection is set to Network Client

* Specified IP address and Port number are
valid

* MC1-UHD has successfully established
connection to the given IP address and

port
Inactive (Green) Enabled box is not selected for the SAGE
EAS protocol
Listening (Green) « Enabled box is selected for the SAGE EAS
protocol

« Connection is set to Network Server
* Specified Port number is valid

* MC1-UHD is ready to accept connections
on the specified port
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Table 48 Remote Control — SAGE EAS Protocol (Continued)

Item Parameters Description

Status (read-only) Reconnecting (Yellow) « Enabled box is selected for the SAGE EAS

protocol

« Connection is set to Network Client

* MC1-UHD attempts to connect
periodically to the specified IP address
and Port number. The interval between
connection attempts start at 10 seconds,
increases by 10 seconds, to a maximum of
60 seconds.

Connecting (Yellow) « Enabled box is selected for the SAGE EAS
protocol

Connection is set to Network Client
MC1-UHD is attempting to connect to the
specified IP address and Port Number
Enabled box is selected for the SAGE EAS
protocol

Connection is set to Network Server
Port Number specified in the Port field is
invalid or in use by another service
Enabled box is selected for the SAGE EAS
protocol

Connection is set to Network Client

Specified IP address and Port Number are
invalid or in use by another device

Port in use (Red)

Cannot connect (Red)

Enabled Selected Enables communication via the SAGE EAS
protocol on the rear module Ethernet port

Cleared* Disables the protocol on the Ethernet port.
When the check box is cleared, any
incoming data from the external device is
discarded by the MC1-UHD.

Connection Serial Port Enables the MC1-UHD to communicate with
a third-party device via the SAGE EAS
protocol serial protocol

Network Server The MC1-UHD functions as a host, or socket
listener, on the network

Network Client The MC1-UHD functions as a service
requester that initiates communications
with a server

Network Setup

Packet Type TCP* Select this option if your external device is
connected to the MC1-UHD through a
network and uses the Transmission Control
Protocol (TCP/IP)
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Table 48 Remote Control — SAGE EAS Protocol (Continued)

Item Parameters Description

Packet Type uDP Select this option if your device is
connected to the MC1-UHD through a
network and uses the User Datagram
Protocol (UDP/IP).

Port # When Connection is set to Network
Server:

* specifies the TCP or UDP port numbers
where the MC1-UHD will listen on.

* TCP ports 0, 21, 80, 5253, and 6667 are
unavailable for Ethernet communications

When Connection is set to Network
Client, this menu specifies the remote port
number to which the MC1-UHD will try to
connect

Remote IP #AHH * Only applicable when Connection is set to
Network Client

* Specifies the IP address of the external
device. The default is 0.0.0.0 and this must
be changed to the actual IP address of the
external device.

Text Crawl Setup - High, Medium, Low?

Preview Off* Disables the setup mode; removes test
message from the Preview output

Preview Low Priority Displays the corresponding text crawl on
the Preview output, permitting the user to
configure the text crawl settings while in
High Priority view.
Refer to the FCC EAS regulations at 47 C.F.R.
Part 11 for more information on message
categories.

% From Top 0-100 Adjusts the vertical position of the EAS text
overlay where 0 sets the top of the overlay
at the top of the active video, 50 is centered
horizontally, and 100 sets the bottom of the
overlay on the bottom of the active video.
The defaultis 10.

Medium Priority

Text Size 1-10 Specifies the text size where 1 is smallest
and 10 is largest. The actual text size
depends on the video format. The default is
5.

Text Color Specifies the foreground color of the text. The default is White.
Background Color Specifies the background color behind the text. Each message category
has a unique default value as follows:
* High Priority — Red
* Medium Priority — Yellow
* Low Priority — Green
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Table 48 Remote Control — SAGE EAS Protocol (Continued)

Item
Drop Shadow

Pan Speed

Play Count

Duration (seconds)
Until Plays

Completed

Until Duration
Completed

While Voice Over
Active

Parameters
Selected

Cleared
-5to -1

1t0 10

#

Selected

Cleared
Selected

Cleared
Selected

Cleared

Audio Setup - Voice Over Audio Setup

Duck Level (dB)

Gain (dB)

Source Setup

Embedded SDI
Source

#

SDI #

Description

Applies a visual effect that makes the text
appear three-dimensional. This is the
default.

Disables this feature

Determines how fast the EAS message
scrolls across the screen (from left to right)
where: 5 is the fastest speed and 1 is the
slowest

Specifies the number of times to display the
entire text crawl before taking it off air. The
default is 2.

Determines how long the EAS message
scrolls on the screen before taking it off air

Enables the EAS text crawl to continue to
play until the number of plays equals the
value specified in the Play Count menu

Disables this feature

Enables the EAS text crawl to continue to
play until the value in the Duration menu is
reached

Disables this feature

Enables the EAS text crawl to continue to
play only while the EAS Voice Over source is

playing
Disables this feature

Specifies the amount (dB) to reduce the
audio level on the Program bus during an
EAS alert

Adjusts the overall EAS audio gain on the
Program bus while an EAS alert is active
(applies to the input audio and the EAS
input audio)

Assigns the specified SDI as the source for
the EAS voice over
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Table 48 Remote Control — SAGE EAS Protocol (Continued)

Item Parameters Description
Voice Over Ch # None No channels are assigned for the EAS voice
Source over
Clear All Assigns all channels (1-16) to None
Clear Group Assigns the four sources in the same group
to None
Clear Pair Assigns the two sources in the same pair to
None
AES Assigns all 16 sources to consecutive AES
sources
AES #>Ch # Assigns the specified AES channel in the
selected EAS channel
Embedded Assigns all 16 sources to the corresponding
SDI inputs

Embedded > SDI G#C# Embeds the specified embedded audio
group and channel pair in the selected EAS

channel

Test Tone Sets the group (4 sources) to all consecutive
test tones

Test Tone > # Sets the selected test tone to the specified
EAS channel

a. The Text Crawl Setup dialog enables you to customize the EAS text overlay received by your SAGE EAS device.
The text overlay is automatically assigned to Logo channel 4 in Key 4, therefore do not use Logo 4 and Keyer 4
for any other purpose when EAS is enabled.

Router Control Tab

Table 49 summarizes the options displayed in the Router Control tab.

Table 49 Router Control Tab

Item Parameters Description
Status (read-only) Reports the most serious router control error currently detected
Park Source # When an internal source, such as internal

logo, black, SDI input or Key Video/Alpha is
selected, the MC1-UHD routes this router
source to the corresponding destination

SDI #

Status (read-only) OK (Green) All router sources are available to the
crosspoints

Parked (Green) The specified output is parked because a
crosspoint was selected that was not a
router source or the SDI Input is not used
on-air
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Item
Destination

Last Requested
(read-only)

Last Known
(read-only)

Selected On
(read-only)

Minimum Delay

(frames)

Retry Interval
(frames)

Max Retries

Min Delay
(read-only)

Max Delay
(read-only)

Average Delay
(read-only)

Total Switches
(read-only)

Total Retries
(read-only)

Table 49 Router Control Tab (Continued)

Parameters
Unassigned

Dest #

<text>

<text>

PGM

PST

ExtKey#A or ExtKey#V
Unused

#

Description

The MC1-UHD will not attempt any router
switches

Specifies the router output source
connected to the specified MC1-UHD input
BNC

Indicates the last switch request sent for
this destination

Displays what the router is reporting as the
active Source on this destination

Indicates where the SDI input is used in the
on-air

Specifies the length of time, in frames, that
the MC1-UHD will wait after sending a
command to the router before it assumes
the router output is switched. This could be
extended up to the Retry Interval value
before either the switch is re-tried or
abandoned. The default is 3.

* Specifies the number of frames the
MC1-UHD will wait before re-sending a
command to the router

s Itis recommended that this value is at
least 3 frames more than the Minimum
Delay value

* The defaultis 6

Specifies the maximum number of
attempts the MC1-UHD will re-send a
command to the router. Once the
maximum is reached, the MC1-UHD
abandons the switch (pushes back to the
original crosspoint number). The default is
3.

Reports the measured Minimum Delay time
since the counters were reset

Reports the measured Maximum Delay
time since the counters were reset

Reports the average delay based on the
Min. Delay and the Max. Delay values

Reports the total number of crosspoint
switch commands the MC1-UHD has sent to
the router

Reports the total number of times the same
crosspoint switch command was sent by
the MC1-UHD to the router
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Table 49 Router Control Tab (Continued)

Item Parameters Description
Failed Retries # Reports the total number of times the same
(read-only) crosspoint switch command failed to be

sent by the MC1-UHD to the router

Counters Reset Clears the Min. Delay, Max. Delay, Average
Delay, Total Switches, and Total Retries
fields to zero (0)

Load Labels from Load The MC1-UHD automatically retrieves the
Router virtual labels from the router. The label is
Unload . .

applied when the user selects the source in

the crosspoint menu. Use this option if the
router supports automatic label retrieval.

Limit Label Lists - Sources, Destinations

Start Index # Specifies the first source label to report
End Index # Specifies the last source label to report
Number Received # Indicates the total number of router labels
(read-only) reported to the MC1-UHD

Number Shown # Indicates the total number of router labels
(read-only) displayed to the MC1-UHD

Crosspoint Map Tab

Table 50 summarizes the options displayed in the Crosspoint Map tab.

Table 50 Crosspoint Map Tab

Item Parameters Description
Button #
Source Type Matte Specifies the function of the selected
crosspoint. This determines the available
Black ; . . .
options listed in the Selection menu.
SDI Input
Logo
Router
Label <text> Assigns new text as the button label.
This field is automatically populated by
labels provided by the connected router for
the Router crosspoints.
TSL Address 0-126 Specifies the identification enumeration
Source Type > Matte
Selection White Assigns white as the source for the
crosspoint
Matte# Assigns the specified Matte generator as

the source for the crosspoint

Source Type > SDI Input
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Item
Selection

Alpha

Table 50 Crosspoint Map Tab (Continued)

Parameters

SDI #

SDI #

None

Source Type > Router

Selection

Alpha

Source Type > Logo

Selection

Load Labels from
Router

Overwrite Label
with Default Router
Label

Update Router Extra
labels

Number of Buttons

Router Extra

Src #

Src #

None

Logo #

Load

Unload

Selected

Cleared
#

Description

Assigns the specified SDI input as the
source for the crosspoint.

This list is populated with the router source
labels if they are supported by the router.

Assigns the specified SDI input as the alpha
channel for the crosspoint.

This list is populated with the router source
labels if they are supported by the router.

Assigns White as the alpha channel for the
crosspoint

Allows automation to request router
sources that do not appear in the
Crosspoint list

Assigns the specified router source as the
input for the crosspoint

Assigns the specified router source as the
alpha channel for the crosspoint

Assigns White as the alpha channel for the
crosspoint

Assigns the specified logo channel as the
source for the crosspoint

Updates the Router crosspoint button
labels provided by the connected router

Returns the crosspoint button labels to the
default text

Replaces the user-defined labels with the
labels imported from the connected router

When the Source Type is set to Router
Extra, the button label on the On Air Control
interface reports the last used router
source.

When automation requests a router source
not listed in the crosspoints, and instead
uses a Router Extra crosspoint, the label is
updated to show the router source that was
requested.

Disables this feature

Specifies the number of crosspoint buttons
to display on each bus of the On Air Control
interface
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Table 50 Crosspoint Map Tab (Continued)

Item Parameters Description
Number of Channel # Specifies the number of Channel Select
Select Buttons buttons, to a maximum of 10, that display in
the top row of the On Air Control interface
IP Address of Frame #.#.#.# Specifies the IP address of the router the

MC1-UHD is communicating with

Audio Profile Names Tab

Table 51 summarizes the options displayed in the Audio Profile tab.

Table 51 Audio Profile Tab

Item Parameters Description
Profile #
Save to Profile <text> Saves the current audio shuffle and

processing settings to the selected profile

Set Profile Name <text> Enables you to assign a unique identifier to
the selected audio profile

DVE Tab
Table 52 summarizes the options displayed in the DVE tab.

Table 52 DVE Tab

Item Parameters Description
Included in Background Only* Only the background is included in the
SqueezeBack SqueezeBack effect
After Key 12 Key 1 isincluded in the squeeze effect. Keys
2 to 4 are excluded.
After Key 2 Keys 1 and 2 are included in the squeeze
effect. Keys 3 to 4 are excluded.
After Key 3 Keys 1 to 3 are included in the squeeze
effect. Key 4 is excluded.
After Key 4 All keys are included from the squeeze
effect
Background in Fade Background Selects between letting the reveal source

background pass through or fade to
complete black during a V-fade type
transition inside an already squeezed image
on the PGM bus.

Black

a. Refer to “SqueezeBack Effects” for more information.
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Audio Over Tab

Table 53 summarizes the options displayed in the Audio Over tab.

Table 53 Audio Over Tab

Item Parameters Description
SDI Source
SDI # Selected Assigns the specified SDI as the source for
the voice over
Cleared This SDI is not assigned as the voice over
source
Ch #
Source None No source is assigned to the specified voice
over channel
Clear All Assigns all channels (1-16) to None
Clear Group Assigns the four sources in the same group
to None
Clear Pair Assigns the two sources in the same pair to
None
AES Assigns all 16 sources to consecutive AES
sources
AES #>Ch # Assigns the specified AES channel to the
voice over
Embedded Assigns all 16 sources to the corresponding
SDI inputs
Embedded > SDI G#C#  Assigns the embedded group and channel
pair to the voice over
Test Tone Sets the group (4 sources) to all consecutive
test tones
Test Tone > # Assigns the selected test tone to the voice
over
Duck Option All channels All audio channels on the Program shall be

Assigned channels only

adjusted by the Duck Level value specified
on the On Air Control > Voice Over interface

Only the audio channels specified in the
Audio Over > Ch # Source menu (see above)
shall be adjusted by the Duck Level value
specified on the On Air Control > Voice Over
interface

On Air Control Interfaces
The On Air Control interface enables you to setup and perform transitions. There are two distinct
panels:

+ Setup — This panel is the top half of the interface and includes the Home, Keyers, and Logo tabs.

+ Control — This panel is the lower half of the On Air Control interface and includes the Program
and Preset buses, Keyers area, Transition area, and TAKE button.
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GPIO Control d
»

Effect 1

Figure 31 Example of the On Air Control Interface

Home Tab

The Home tab is the first tab that displays in the Setup panel. Table 54 summarizes the options
displayed in the Home tab.

Table 54 Home Tab

Item Parameters Description
Transition Rates (frames)
Slow Rate 2 to 9992 Defines the Slow Rate in frames
Med Rate 2 to 999P Defines the Medium Rate in frames
Fast Rate 2 to 999¢ Defines the Fast Rate in frames
FTB Rate 2 to 9999 Defines the Bade to Black Rate in frames
EAS STATUS ON <text> Indicates that an installed EAS is providing

content to the MC1-UHD text overlay; the
text is displayed in this area, and is
color-coded, when the EAS is active

OFF Indicates that the MC1-UHD text overlay
does not include EAS content

a. The default value is 60 frames.
b. The default value is 30 frames.
¢. The default value is 15 frames.
d. The default value is 30 frames.

Keyers Tabs

The Keyers tab is the second tab that displays in the Setup panel. Each keyer has a sub-tab that
enables you to select video sources, key types, and adjust transparency, clip, and gain. The
MC1-UHD supports Auto Select and Self keys. Table 55 summarizes the options displayed in each
Key sub-tab.
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Item
Key #

Transparency

Clip

Gain

Key Type

Key Alpha Type

Key Invert

Default

Keyer Source
Black
Matte #

Table 55 Keyers Tabs

Parameters

0* to 100

0to 100

Auto Select*

Self

Unshaped*

Shaped

On

Off*

Make Linear

Description

Adjusts the transparency level of the key:

+ 0 — The key is completely opaque; there
is no difference between the original key
and the key with the transparency effect
applied to it.

+ 100 — The key is completely transparent;
the key is not visible on the screen.

Adjusts the clip values; default is 960 (the
maximum luminance range not including
Super White).

Adjusts the gain values; default is 50.

A Key which uses two video signals (Alpha
and Fill); the Key Alpha Type is automatically
set to Shaped.

If you configure an internal Logo channel as
Auto Select, the associated alpha signal is
used.

A Key that uses the luminance values of the
KEY VIDEO source for the alpha; the Key
Alpha Type is automatically set to
Unshaped.

If you configure an internal Logo channel as
Self, the luminance value of the associated
alpha is used.

The card performs a multiplicative key. The
Key Alpha luminance value mixes linearly
the Key Video with the Background. Shades
of gray, in the Key Alpha, are translated into
transparency levels, giving the key a soft
edge.

The card performs an additive key. The Key
Alpha cuts a hole in the BKGD and the Key
Video is added to the BKGD. Shaped Key
alphas are sometimes used with Character
Generators to cut very precise holes for the
Key Video fill.

Reverses the polarity of the Key Alpha. A
Key Invert can be applied to any key type.

The Key Alpha is not inverted

Resets the clip and gain values to the
default settings

Assigns Black as the keyer output.

Assigns the specified Matte generator as the keyer output.
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Item
External #

Logo #
EAS Text

Table 55 Keyers Tabs (Continued)

Parameters Description

Assigns the external key source as the keyer output. You will also need
to configure the settings in the External Sources tab

Assigns the specified Logo channel as the keyer output.

Assigns the active EAS Text Crawl as the keyer output.

SqueezeBack Effects Tabs

Table 56 summarizes the SqueezeBack Effects tab options available in DashBoard.

Item
Effect #

Hide Effect

X Position
Y Position
X Size
Y Size

Lock Aspect Ratio

Constrain to Screen

Reveal Source

Reset to Defaults

Table 56 SqueezeBack Effects Tabs

Parameters Description
Selected Enables the effect to be selected for a transition
using the EFFECT SELECT button
Cleared* Disables the effect
#a Adjusts the horizontal position of the image on

the screen (in number of pixels)

#2 Adjusts the vertical position of the image on the
screen (number of lines)

0- #P Squeezes the image horizontally (to the
specified in number of pixels)

0- #b Squeezes the image vertically (to the specified
in number of lines)

Selected* Locks the aspect ratio given the current X and Y
size parameters. Changing one parameter will
cause the other parameter to automatically
change to maintain this ratio.

Cleared X and Y parameters are adjusted independently

Selected* Applies “snap-back” on the X, Y position controls
to ensure the squeezed image remains entirely
on screen

Cleared The squeezed image can be clipped off screen

External Specifies that a router source will be the video

source to be revealed by the squeeze effect.
You must also specify the router source using
the options in the External Sources tab.

Logo #C Specifies the logo channel as the video source
to be revealed by the squeeze effect

Returns all parameters on the SqueezeBack Effects tab to the
factory default values

a. The range is from -# to +#. The default value is 0% which positions the image at the center point of the

visible area.

b. The default is 100%.

c. The default Reveal Sourc
1; Effect 4 to Logo 2.

e is as follows: Effect 1 defaults to External 1; Effect 2 to External 2; Effect 3 to Logo
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Logo Tabs

Each logo channel has a sub-tab that enables you to select files, position the on-screen image, and
specify animation play-out settings. Table 57 summarizes the options displayed in each Logo tab.

Table 57 Logo Tabs

Item Parameters
Logo #

File (read-only) XXX_##.yyy

Status (read-only)

Animation loaded (#)

Single image loaded (#)

Idle

Queued
Selected on #
(read-only) None

On Air (read-only) #

Directory [RAM CACHE]
[ROOT]
Filename XXX.YYY

XXX_#H####.yyy

[NONE]

Loading frame X of Y

Description

Indicates the full path of the currently
loaded file where ## represents the
duration of the file if it is an animation

+ Displays information about the channel in
both the number of frames (integer), and
in the number of seconds (fractional)

* Any errors during loading are also
displayed

« When the file(s) have loaded, this field
displays the dimensions of the image (e.g.
1920x1080)

Indicates that one logo channel is loading
and a second channel was selected to load
at the same time. Once the first channel is
loaded, the second channel will begin
loading.

Indicates all the key(s), or backgrounds, that
currently have the media file selected

Indicates the on-air key(s), or backgrounds,
that have this media file selected

The field displays the directory the currently
selected media file is located in

Lists the directories on the Micro SD Card

Displays the name of the selected media
file.

Animation filenames include an underscore
followed by three or more digits. The
number of frames, and duration in seconds,
is displayed in brackets after the filename.

Updated when a new Directory is selected
in the Directory menu.

Provides a list of all the media files in the
currently selected directory. Note that
animations appear as a single entry.

Selecting this option clears the logo
channel.

This item is automatically selected, without
clearing the channel, when the user
switches to a new directory.

188 * DashBoard Interface Overview

MC1-UHD User Guide (v8-rev3)



Table 57 Logo Tabs (Continued)

Item Parameters

File List Rescan

[RAM CACHE] Clear

SD Card Status x of #GB used

(read-only)

Mediastore Memory #/#/# MB
(read-only)

Image Properties

X Position ## to ##

Y Position ## to ##2

Animation Properties

Description

Selecting this button updates the Directory
menu options, and the Filename menu
options

Removes all the items in the RAM cache
directory that are not used (on air) by any
one of the logo channels.

Items in the RAM cache directory that are in
use by any logo channel are still present in
the list to prevent any on air disruption.

Reports the amount of memory used on the
Micro SD card

Reports the amount of memory used by the
Mediastore

* Adjusts the position of the image along
the X-axis in number of pixels

* The range varies depending on the output
video format

* Adjusts the position of the image along
the Y-axis in number of pixels

* The range varies depending on the output
video format

The animation starts to play when a
transition occurs

The animation starts playing as soon as the
animation is loaded to the bus

The animation starts over when it reaches
the last frame of the animation

The animation stops when it reaches the
last frame of the animation

The entire frame of the image is displayed

Field 1 and Field 2 of the image are
swapped when they are displayed.

The animation plays but before looping
back (if looping is enabled), it pauses on the
last frame, for the specified number of
frames.

Auto Play? Selected

Cleared*
Loopingc Selected

Cleared*
Play Moded Normal*

Swap Fields
Hold Time® #
a. The default value is 0 which represents the top-left corner of the active picture area.
b. This option is only applicable when an animation file is selected.
c. This option is only applicable when an animation file is selected.
d

formats.
e. The default value is 0.

. The Play Mode feature only applies to interlaced video formats and has no effect when using progressive video
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External Keys Tab

Table 58 summarizes the External Keys tab options available in DashBoard.
Table 58 External Keys Tab
Item Parameters Description
External Key #

# Selecting a button sets that video source as the External source.
The default External Source for the External Key is Black.

Audio Processing Tab

Table 59 summarizes the options displayed in each Audio Processing sub-tab.

Table 59 Audio Processing Tab — Audio #-#

Item Parameters Description
On Preset: # Indicates the crosspoint currently selected
(read-only) on the Preset Bus
Load Profile # Applies the audio settings of the selected

profile to the currently selected Preset
crosspoint on the next transition

Ch 1-8, Ch 9-16

Reset Resets all Audio Output settings for the applicable audio group to the
factory default values

Mute Selected Mutes the input source for the specified
channel that is inserted into the embedded
group (if present)

Cleared The input source for the specified channel
is not muted
Gain (dB) # Adjusts the gain of the specified channel of
audio

Select 0 when using non-PCM audio

Invert Selected Inverts the audio signal of the specified
group
Cleared + Audio signal of the specified group is not
inverted

+ Use for non-PCM audio data

Sum Selected Both channels will carry the average of the
two input channels ((A+B)/2)

Cleared Disables this feature

Audio Shuffle Tab

Table 60 summarizes the options displayed in each Audio Shuffle tab.
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Table 60 Audio Shuffle Tab

Item Parameters Description
On Preset: # Indicates the crosspoint currently selected
(read-only) on the Preset Bus
Load Profile # Applies the audio settings of the selected

profile to the currently selected Preset
crosspoint on the next transition

Channel #

Source Group # Ch # Specifies the input for the specified channel
that is inserted into the embedded group (if
present)

#kHz Tone Embeds the selected test tone

Pass Resets the specified group settings to pass the default input channels
to the output channels. The mute, gain, sum, and invert settings for the
specific group are reset to the default values.

Pass All Resets all group settings to pass the default input channels to the

output channels. The mute, gain, sum, and invert settings for all groups
are reset to the default values.

Save Audio Profile Tab

Table 61 summarizes the options on the Save Audio Profile tab.

Table 61 Save Audio Profile Tab

Item Parameters Description
On Preset: # Indicates the crosspoint currently selected
(read-only) on the Preset Bus
Save Profile <text> Saves the current audio shuffle and

processing settings to the selected profile.

Voice Over Tab

Table 62 summarizes the Voice Over tab options available in DashBoard.

Table 62 Voice Over Tab

Item Parameters Description
Duck Level (dB) #a This ducks the Voice Over source and the input
audio. The AUDIO OVER button is lit.
Gain (dB) #b This applies a gain to the Voice Over source and

the input audio. The AUDIO OVER button is lit.

a. The default is -10dB.
b. The default is 0dB.

GPIO Control Tab

Table 63 summarizes the Voice Over tab options available in DashBoard.
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Table 63 GPIO Control Tab

Item Parameters Description
GPI/Tally #
Function (read-only) Reports the transition event assigned to a specific GPI port
Current State Reports the port status
(read-only)
Set Level? High The output toggles from the base low level to

the high level. The output signal remains at this
level until reset.

Low The output level toggles from the base high
level to the low level. The output signal remains
at this level until reset.

a. The Manual Override option must be enabled on the Configuration > GPI/Tally > GPI/Tally tab for the Set
Level button to take effect.

Control Panel

This area is used to select the video sources for each bus. Each crosspoint button will display the
name of its source on the button face.

Program Bus 9 s
o RESET
ey 2 AUDIO
GAIN

EXTERNAL EXTERNAL

Figure 32 Example of the Control Panel

1. Program Bus

The Program Bus is used to select the video source that will display as the Background on the
Program output.

2. Preset Bus
The Preset Bus is used to select the video source that displays on the Preview output.
3. Keyers Area

The Keyer Area enables you to add, or remove, keyers in transitions. This area includes the
following controls:

The top row of buttons, labeled Key 1-4 and lit in red, are used to perform cuts on the specified
keyer directly on the Program Bus, without affecting their inclusion in the next transition. A lit
button indicates that the specified keyer is currently on-air.

The bottom row of buttons, labeled Key 1-4 and lit in blue, are used to add, or remove, the
specified keyer to the next transition. Selecting the button toggles the keyer on/off and
selects/removes the keyer to the Preset Bus respectively. Once the transition is executed, and
depending on the Configuration > Transitions > Transition Behavior setting, the button(s) are no
longer lit in this row but are lit red in the top row.
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4. Transition Type Buttons

The following Transition Type buttons are available (from left to right):
> | (Cut) — Select this button to perform a cut transition from one source to the next.

> @ (V-Fade) — Select this button to perform a V-Fade transition from the Program source to

Black to the Preset source. The MC1-UHD fades down from one source to black and then
transitions to the next source. During a hot-punch transition, the video performs a CUT while
the audio performs a V-Fade.

> @ (Cut-Fade) — Select this button to perform a cut to black, then fade up to the next source.

> @ (Cross Fade) — Select this button to perform a gradual fade from one source to the next.
The MC1-UHD performs a cross fade between sources. Note that this button is selected after
performing a factory default reset.

> @ (Fade-Cut) — Select this button to fade from one source to black and then cut to the next
source.

’ (SqueezeBack) — Select this button to perform a SqueezeBack effect by reducing the size
of the video over time to the dimensions set in the SqueezeBack Effects tab. Unlike the above
types, you may not change your background on-air with this transition type, but you can
change keys on-air. The corresponding buttons are grayed out. This button displays only when
the MC1-UHD-DVE-1CH-LICENSE license key is installed.

5. Transition Speed Buttons

These buttons apply the rate (slow, medium, fast) to the next transition. The transition rates are
specified in the Home tab.

* The Slow button is selected after performing a factory default reset.

X If you are controlling the MC1-UHD via Automation, and these buttons are not lit, the transition
rate applied is set by the Automation command. If you wish to apply one of these rates,
remember to select the required transition speed button before performing a transition (e.g.
selecting TAKE).

6. Transition Include Buttons

> BKGD — This button is used to add/remove the Preset source to/from the next transition.
Toggling this button will immediately affect the video that is visible on the Preset output.

» SQUEEZE — This button is used to add/remove the SqueezeBack effect to/from the next
transition. Toggling this button will immediately affect the video that is visible on the Preset
output. This button displays only when the MC1-UHD-DVE-1CH-LICENSE license key is installed.

7. TAKE Button

Selecting the TAKE button performs the transition between the sources and effects selected in
the Program and Preset buses, using the specified Transition Type and Transition Speed.

8. EFFECT SELECT

This area includes the Effect # status field and an EFFECT SELECT button. The status field reports
the last applied effect and whether it is on or off air, or currently on the Preset Bus.

* The MC1-UHD-DVE-1CH-LICENSE is required.
While the squeeze effect is on air:

» the EFFECT SELECT button is locked. Even though you can still adjust the options in the
SqueezeBack Effects tabs, we suggest not doing so since all effect changes are immediately
applied.
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» you are unable to change the background or keys with a transition. However, you can still
hot-punch a source or key on the Program bus. However, hot-punching a source on the
Program bus will take the squeeze effect off air. Hot-punching keys on/off will not take the
squeeze effect off air.

» you can perform any hot-punch or TAKE transition inside of the squeeze effect.
9. FTB Button

Use this button to fade the Program bus to black. The Fade to Black (FTB) rate is specified in the
Home tab. After performing a factory default reset, this button is toggled off (unlit). This button
can be disabled via the FTB Disabling option on the Transitions tab (refer to Table 38).

10.ATMN Button

Toggling this button on (button will be lit) allows an Automation System to control the MC1-UHD.
After performing a factory default reset, this button is toggled off (unlit).

11.AUDIO OVER Buttons

An AUDIO OVER button is included on each bus. Selecting the button in the Preview bus includes
the voice over channel in the next transition. You can also hot-punch the AUDIO OVER button in
the Program bus.

12.Program Audio Area

This area includes an audio fader that enables you to control the Program audio gain. The slider
is set by default to 0 and has a range of -72 to +20dB. Use the Reset Audio Gain button to reset
the audio gain.
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Technical Specifications

This chapter provides technical information for MC1-UHD.

X Specifications are subject to change without notice.

Supported Video Formats

Table 64 Technical Specifications — Supported Video Formats

Resolution (lines) Frame Rate (Hz)
480i 59.94

576i 50
720p 50
59.94
1080i 50
59.94
1080p 50
59.94
1080pSF 23.98
24
2160p?@ 23.98
24
25
29.97
30
50
59.94

a.Requires the MC1-UHD-12G-LICENSE.

SDI Inputs Specifications

Table 65 Technical Specifications — SDI Inputs

Item Specifications
Number of Inputs 6
Standards Accommodated 270Mbps, 525/625 Component, SMPTE 259M

1.485Gbps Component, SMPTE 292M
2.97Gbps Component, SMPTE 424M
5.94Gbps Component, SMPTE ST-2081
11.88Gbps Component, SMPTE 2082

Impedance 750hm

MC1-UHD User Guide (v8-rev3) Technical Specifications ¢ 195



Table 65 Technical Specifications — SDI Inputs (Continued)

Item Specifications
Return Loss >15dB to 1.485Gbps

>10dB to 2.97Gbps

>7dB to 5.94Gbps

>4dB to 11.88Gbps
Equalization (Belden 1694A >220m (722ft) @ 1.485Gbps

cable) >140m (459ft) @ 2.97Gbps
>50m (190ft) @ 11.88Gbps
Connection HD-BNC

SDI Outputs Specifications

Table 66 Technical Specifications — SDI Outputs

Item Specifications
Number of Outputs 6
Impedance 750hm
Return Loss >15dB to 1.485Gbps

>10dB to 2.97Gbps
>7dB to 5.94Gbps
>4dB to 11.88Gbps
Signal Level 800mV £10%
DC Offset 0V £50mV
1.485Gbps: <270ps, <100ps difference
Rise and Fall Time (20-80%) 2.97Gbps: <135ps, <50ps difference
11.88Gbps: <45ps, <18ps difference

Jitter 1.485Gbps: <1.0Ul jitter measured 10Hz-100kHz, <0.2Ul above
100kHz

2.97Gbps: <1.0Ul jitter measured 10Hz-100kHz, <0.3Ul above
100kHz

11.88Gbps: <2.0UlI jitter measured 10Hz-100kHz, <0.3Ul above
100kHz, band limit @1188MHz

Overshoot <10% (11.88Gpbs: <15%)
Connection HD-BNC
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AES Specifications

MC1-UHD-A

Table 67 AES Specifications — MC1-UHD-A

Item

AES Standards
Accommodated

Connector Type
Inputs
Impedance
Minimum Input

Maximum Input

Minimum Audio Delay

Maximum Audio Delay

Sampling Rate

Equalization

Outputs
Impedance
Output Level
Sampling Rate

MC1-UHD-B

Specifications
AES-3id-2001, AES3

HD-BNC

750hm

50mV p-p

2.5V p-p @ 48kHz
1.5V p-p @ 96kHz
SRC ON: 2ms
SRC OFF: Tms
1365 ms

48kHz compliant with AES-3id or any
rate from 32kHz to 96kHz with SRC on

up to 800m (2,400ft) @ 48kHz
up to 500m (1,500ft) @ 96kHz

750hm

1V p-p
48kHz

Table 68 AES Specifications — MC1-UHD-B

Item

AES Standards
Accommodated

Connector Type
Impedance

Minimum Input
Maximum Input

Minimum Audio Delay

Maximum Audio Delay

Sampling Rate

Specifications
AES-3id-2001, AES3

WECO
1100hm
100mV p-p
10V p-p

SRC ON: 2ms
SRC OFF: Tms
1365 ms

48kHz compliant with AES-3id or any
rate from 32kHz to 96kHz with SRC on
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Table 68 AES Specifications — MC1-UHD-B (Continued)

Item Specifications
Equalization >450m of Belden 1492 cable
Return Loss >26dB 100KHz to 6MHz
Output Amplitude 4Vp-p
Rise and Fall Times 30ns
Jitter 4.5mUl

Serial Port Specifications

X This section applies only to the R3B-GATOR (8322AR-318D) or R3A-GATOR (8322AR-391C). The
R4-GATOR (8323AR-325) does not include a SERIAL port.

Table 69 Technical Specifications — Serial Port

Item Specifications
Maximum Cable Lengths
RS-232 Serial Interface 10m (33ft)
RS-422 Serial Interface 300m (984ft)

Refer to Table 70 and Figure 33 for pin-outs for the SERIAL port on the MC1-UHD rear modules.

To Rear Module

(male cable end)

Figure 33 Serial Port Pinouts

Table 70 Serial Pinouts on the MC1-UHD
RJ45 Pin RS-232 RS-422

1 n/c Tx+
2 Rx Tx-
3 Tx Rx+
4 n/c n/c
5 n/c n/c
6 n/c Rx-
7 GND GND
8 GND GND
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GPIO

Table 71 Technical Specifications — GPIO

Item Specifications
Absolute Maximum Voltage at 1.0V to +6.0V to prevent damage
Connector Pins
GPI
Input + 4.7K ohm resistor pull-up to 5V for High
« GND contact closure (or external logic) for Low
* High Inis >= 2.5V
* Low Inis <= 0.5V
Tally
Output + Pulled to 5V with 4k7 ohm resistor for High
+ Driven to ground or Low through 30ohms
* Maximum sink current 50mA to drive an external
relay
* To drive a logic gate input, sink current needs to
be below 10mA (0.3V at pin)
Environment
Table 72 Technical Specifications — Environment
Item Specifications
Maximum Ambient 40°C (104°F)
Temperature
Power

Table 73 Technical Specifications — Power

Item Specifications

Maximum Power

Consumption 40W-80W (application dependent)
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Service Information

Routine maintenance to this openGear product is not required. In the event of problems with your
card, the following basic troubleshooting checklist may help identify the source of the problem. If
the frame still does not appear to be working properly after checking all possible causes, please
contact your openGear products distributor, or the Technical Support department at the numbers
listed under the “Contacting Technical Support”.

1. Visual Review — Performing a quick visual check may reveal many problems, such as
connectors not properly seated or loose cables. Check the card, the frame, and any associated
peripheral equipment for signs of trouble.

2. Power Check — Inspect the power indicator LED on the distribution frame front panel for the
presence of power. If the power LED is not illuminated, verify that the power cable is connected
to a power source and that power is available at the power main. Confirm that the power
supplies are fully seated in their slots. If the power LED is still not illuminated, replace the power
supply with one that is verified to work.

3. Input Signal Status — Verify that source equipment is operating correctly and that a valid
signal is being supplied.

4. Output Signal Path — Verify that destination equipment is operating correctly and receiving a
valid signal.

5. Unit Exchange — Exchanging a suspect unit with a unit that is known to be working correctly is
an efficient method for localizing problems to individual units.

Reloading the Software on the Card

In the unlikely event of a complete card failure, you may be instructed by a Ross Technical Support
specialist to perform a complete software reload on the card.

To reload the software on the card

1. Eject the card from the frame.

2. Press and hold the Bootload button, while re-inserting the card into the frame.
3. Release the button.

+ The OK/ERROR LED flashes green while the card is waiting for a new software load.

+ If a new software load is not sent to the card within 60 seconds, the card will attempt to
re-start with its last operational software load.

+ Software loads can be sent to the card via the connection on the rear of the frame.

Loading the Factory Defaults

If required, the card menu parameters can be reset to the factory default values using the option
available in the Setup tab. All parameters are reset except those listed in Table 16.

To reset the card to the factory default settings in DashBoard

1. Navigate to the Global interface as outlined in “To display the Global interface in
DashBoard".

2. Select the Setup tab.
Click Load Factory Defaults to display the Confirm dialog.

4. Click Yes to load the factory default values for all menu parameters, or No to cancel the load
and close the dialog.
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X To ensure that the DashBoard fields display the updated settings, it is recommended to click the
Refresh button, located at the bottom of the DashBoard window, after the factory defaults are
fully loaded.

Warranty and Repair Policy

The MC1-UHD is warranted to be free of any defect with respect to performance, quality, reliability,
and workmanship for a period of FIVE (5) years from the date of shipment from our factory. In the
event that your card proves to be defective in any way during this warranty period, Ross Video
Limited reserves the right to repair or replace this piece of equipment with a unit of equal or
superior performance characteristics.

Should you find that this card has failed after your warranty period has expired, we will repair your
defective product should suitable replacement components be available. You, the owner, will bear
any labor and/or part costs incurred in the repair or refurbishment of said equipment beyond the
FIVE (5) year warranty period.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or
consequential damages (including loss of profits) incurred by the use of this product. Implied
warranties are expressly limited to the duration of this warranty.

This User Manual provides all pertinent information for the safe installation and operation of your
openGear product. Ross Video policy dictates that all repairs to the card are to be conducted only
by an authorized Ross Video Limited factory representative. Therefore, any unauthorized attempt
to repair this product, by anyone other than an authorized Ross Video Limited factory
representative, will automatically void the warranty. Please contact Ross Video Technical Support
for more information.

In Case of Problems

Should any problem arise with your card, please contact the Ross Video Technical Support
Department. (Contact information is supplied at the end of this publication.)

A Return Material Authorization number (RMA) will be issued to you, as well as specific shipping
instructions, should you wish our factory to repair your card. If required, a temporary replacement
frame will be made available at a nominal charge. Any shipping costs incurred will be the
responsibility of you, the customer. All products shipped to you from Ross Video Limited will be
shipped collect.

The Ross Video Technical Support Department will continue to provide advice on any product
manufactured by Ross Video Limited, beyond the warranty period without charge, for the life of the
equipment.
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Software Licenses

This chapter provides third-party software license information for your MC1-UHD. This product
includes multiple software components which are individually licensed under one or more of the
following licenses included in this chapter.

BSD

Copyright (¢) 1991,1993, The Regents of the University of California. All rights reserved.

This code is derived from software contributed to Berkeley by Kenneth Almquist.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

3. <BSD Adbvertising Clause omitted per the July 22, 1999 licensing change ftp:/ftp.cs.berkeley.edu/pub/4bsd/README.Impt.License.Change> California, Berke-
ley and its contributors.

4. Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ""AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CON-
SEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABIL-
ITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Dual GPL

Portions of this software are copyright (C) 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

This project is also covered under the GPL v2.

GPL

GNU GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Pub-
lic License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free
Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply
it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distrib-
ute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces
of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if
you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must
make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission
to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL
requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is funda-
mentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for indi-
viduals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If
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such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the
freedom of users.

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose
computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the
GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.
TERMS AND CONDITIONS
0. Definitions.
"This License" refers to version 3 of the GNU General Public License.
"Copyright" also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.

"The Program" refers to any copyrightable work licensed under this License. Each licensee is addressed as "you". "Licensees" and "recipients" may be individuals or
organizations.

To "modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The
resulting work is called a "modified version" of the earlier work or a work "based on" the earlier work.

A "covered work" means either the unmodified Program or a work based on the Program.

To "propagate" a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable copy-
right law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making available
to the public, and in some countries other activities as well.

To "convey" a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer network,
with no transfer of a copy, is not conveying.

An interactive user interface displays "Appropriate Legal Notices" to the extent that it includes a convenient and prominently visible feature that (1) displays an
appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may convey
the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in
the list meets this criterion.

1. Source Code.
The "source code" for a work means the preferred form of the work for making modifications to it. "Object code" means any non-source form of a work.

A "Standard Interface" means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a partic-
ular programming language, one that is widely used among developers working in that language.

The "System Libraries" of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Compo-
nent, but which is not part of that Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface
for which an implementation is available to the public in source code form. A "Major Component", in this context, means a major essential component (kernel, win-
dow system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code inter-
preter used to run it.

The "Corresponding Source" for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code
and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally
available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes
interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is spe-
cifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This License
explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output,
given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey
covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided
that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for
you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material out-
side their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright
treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by
exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of

enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.

4. Conveying Verbatim Copies.
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You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each
copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to the code;
keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.
5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided
that you also meet all of these conditions:

a.  The work must carry prominent notices stating that you modified it, and giving a relevant date.

b.  The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies
the requirement in section 4 to "keep intact all notices".

c¢.  You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along
with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no
permission to license the work in any other way, but it does not invalidate such permission if you have separately received it.

d.  If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not
display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not com-
bined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an "aggregate" if the compilation and its resulting
copyright are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit. Inclusion of a covered work in an aggre-
gate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source
under the terms of this License, in one of these ways:

a.  Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source
fixed on a durable physical medium customarily used for software interchange.

b. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at
least three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code
either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily
used for software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the
Corresponding Source from a network server at no charge.

c¢. c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only
occasionally and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.

d. d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in
the same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code.
If the place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that
supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding Source.
Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these
requirements.

e. e)Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work
are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the
object code work.

A "User Product" is either (1) a "consumer product", which means any tangible personal property which is normally used for personal, family, or household purposes,
or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in favor
of coverage. For a particular product received by a particular user, "normally used" refers to a typical or common use of that class of product, regardless of the status
of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product regardless
of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the product.

"Installation Information" for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified ver-
sions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued func-
tioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which
the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized),
the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor
any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has
been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modifica-
tion itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an
implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.

"Additional permissions" are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that
are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional
permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License
without regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permis-
sions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a
covered work, for which you have or can give appropriate copyright permission.
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Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supple-
ment the terms of this License with terms:

a.  Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or

b. Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works
containing it; or

c.  Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different
from the original version; or

d.  Limiting the use for publicity purposes of names of licensors or authors of the material; or
e.  Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or

f.  Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual
assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered "further restrictions" within the meaning of section 10. If the Program as you received it, or any part of it,
contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a
further restriction but permits relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license document,
provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those files,
or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply either
way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and will
automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright
holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior
to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means,
this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after
your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights
have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.

9. Acceptance Not Required for Having Copies.

You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a conse-
quence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you permission to
propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work,
you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to
this License. You are not responsible for enforcing compliance by third parties with this License.

An "entity transaction" is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organiza-
tions. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives whatever
licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the
work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee, roy-
alty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging
that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.

A "contributor" is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called
the contributor's "contributor version".

A contributor's "essential patent claims" are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be
infringed by some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a
consequence of further modification of the contributor version. For purposes of this definition, "control" includes the right to grant patent sublicenses in a manner
consistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent claims, to make, use, sell, offer for sale,
import and otherwise run, modify and propagate the contents of its contributor version.

In the following three paragraphs, a "patent license" is any express agreement or commitment, however denominated, not to enforce a patent (such as an express per-
mission to practice a patent or covenant not to sue for patent infringement). To "grant" such a patent license to a party means to make such an agreement or commit-
ment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge
and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding
Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the
requirements of this License, to extend the patent license to downstream recipients. "Knowingly relying" means you have actual knowledge that, but for the patent
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license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more identifiable patents in that
country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent
license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent
license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is "discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or
more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is
in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which
the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered
work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered
work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under
applicable patent law.

12. No Surrender of Others' Freedom.

If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the con-
ditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations,
then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom
you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU
Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the
covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combi-
nation as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License "or any later ver-
sion" applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software
Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software
Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of
a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result
of your choosing to follow a later version.

15. Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PAR-
TICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN'NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY
WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT
NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE
OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POS-
SIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.
If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local

law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies
a copy of the Program in return for a fee.
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LGPL

GNU LESSER GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the
additional permissions listed below.

0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public
License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application” is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class
defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined
Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the
Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs
needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than

as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a. under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility
still operates, and performs whatever part of its purpose remains meaningful, or

b. under the GNU GPL, with none of the additional permissions of this License applicable to that copy.
3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your
choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and
templates (ten or fewer lines in length), you do both of the following:

a.  Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.
b.  Accompany the object code with a copy of the GNU GPL and this license document.
4. Combined Works.
You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in
the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:
a.  Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.
b.  Accompany the Combined Work with a copy of the GNU GPL and this license document.

c.  Fora Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a
reference directing the user to the copies of the GNU GPL and this license document.

d. Do one of the following:

1) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under
terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work,
in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

2) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library
already present on the user's computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the
Linked Version.

e.  Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to
the extent that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the
Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal
Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified
by section 6 of the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and
are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:
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a.  Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the
terms of this License.

b.  Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying
uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be sim-
ilar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public

License "or any later version" applies to it, you have the option of following the terms and conditions either of that published version or of any later version published
by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any
version of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public
statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

MIT

Copyright 1987, 1988 by MIT Student Information Processing Board.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose is hereby granted, provided that the names of M.L.T. and the
M.LT. S.I.P.B. not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. M.I.T. and the M.I.T.
S.I.P.B. make no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

zlib
Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this soft-
ware.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the follow-
ing restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product,
an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.Jean-loup Gailly Mark Adler jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format),
rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
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Glossary

The following terms are used throughout this guide:

Active image — the portion of the video picture area (production aperture) that is being utilized for
output content. Active image excludes letterbox bars and pillar-box bars.

Auto Select Key — a key in which two video signals are required to insert the key. The Key Alpha is
used to cut the hole in the video, and the Key Video is used to fill that hole.

Card — openGear terminal devices within openGear frames, including all components and
switches.

DashBoard — the DashBoard Control System.

DTVCC captions — CEA-708 captions.

DVE — Digital Video Effects.

Frame — the openGear frame that houses the MC1-UHD unless otherwise noted.
HTTP — Direct Hypertext Transfer Protocol.

LTC — Linear Timecode.

MIB — management information base.

Network Controller Card — refers to the MFC-OG3-N and the MFC-OGX-N and any available
options.

NTSC captions — the CEA-608-D: Line 21 Data Services captions.
openGear frame — refers to the OG3-FR series and OGX-FR series frames unless otherwise noted.
PAL — PAL-B and PAL-G unless otherwise noted.

Production aperture — the image lattice that represents the maximum possible image extentin a
given standard (e.g. the full size of all active pixels and active lines). For example, the 1080i
production aperture would be 1920x1080.

Self Key — a key in which the luminance, or brightness, values of the key source is used as the
alpha for the key.

System— the mix of interconnected production and terminal equipment in your environment.
TCP — Transmission Control Protocol.

TTL — Time To Live.

UDP — User Datagram Protocol.

User — the person who uses the MC1-UHD.

VGPI — Virtual GPI feature of the Miranda™ Presmaster Automation and RossTalk protocols.
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